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55"?& Qﬂj%"’fﬂ% UNITED STATES DEPARTMENT OF COMMERCE
227 . | National Oceanic and Atmospheric Administration
NATIONAL OCEAN SERVICE
Office of Coast Survey
Silver Spring, Maryland 20910-3282

(to be dated when signed)

MEMORANDUM FOR: |  Jeff Ferguson
Chief, Hydrographic Surveys Division or

_— Comment [J1]: This memo is to be submitted as
a digitally signed PDF document. Email a copy of
this memo to OCS.HSRR@noaa.gov

-

Howard Danley
Chief, Navigation Services Division

FROM: LCDR Joseph Hydrohead, NOAA
Commanding Officer, NOAA Ship SWATH

SUBJECT: NOAA Ship SWATH Hydrographic Systems Status Summary

The hydrographic systems of NOAA Ship SWATH were reviewed in accordance with the Office of
Coast Survey Field Procedures Manual (FPM) Hydrographic Systems Readiness Review procedures
on January 28, 2010. The review process took place at NOAA’s Marine Operations Center in
Norfolk, Virginia, and was conducted by a Hydrographic Systems Review Team comprised of the
following people:

Lieutenant Jane Doe, HSTP Field Support Liaison

Lieutenant Ida Know, Field Operations Officer, NOAA Ship SWATH

Mzr. Thomas Smith, Physical Scientist, AHB

The Review Team’s findings are summarized in this memorandum and reflect the condition of the
SWATH field unit’s hydrographic systems on the review date. These findings have been divided
into three categories of deficiencies:

CATEGORY 1 — These deficiencies indicate the failure or absence of vital equipment or
preparations of systems essential to acquisition and/ot processing of hydrogtaphic data. The vessel
will be required to cease or limit hydrographic survey operations due to the following deficiencies:

1. The hull of launch number 2901 has structurally cracked and the vessel has been removed
from service until repairs are made. This vessel should not be used for hydrographic survey
operations until the crack has been repaired.

2. The ship’s multibeam echosounder (MBES) was replaced during the current dockside repair
petiod. A calibration (patch test) has not yet been conducted for this system due to ongoing
ship repairs. The ship’s MBES system can not be used to acquite data for NOAA
hydrographic surveys until a successful system calibration has been performed.

3. Side scan sonar (SSS) towfish S/N 8675309 failed to detect the 1 m” test object nine out of
ten times during calibration. No evidence of damage was noted on the towfish. After three
unsuccessful attempts to complete the SSS calibration, EED was contacted and the towfish




returned to the manufacturer for evaluation and any necessary repairs. Towfish repairs had
not been completed at the time of this review.

CATEGORY 2 — These deficiencies indicate noncompliance with established policies, directives,
instructions, or accepted hydrographic practice not addressed under Category 1. The following
deficiencies shall be cortected in as timely a manner as funding, time, and/or professional assistance
permit:

1. The field unit’s Diver Least Depth Gauge (DLDG) is overdue for calibration. This system
must be calibrated by the manufacturer annually.

2. The side scan cable counter on Launch 2902 is broken, and the cable has been manually
marked. These markings are deteriorating and no longer considered accurate. An accurate
method of measuring cable out is required for side scan operations.

3. To analyze a horizontal control reference station, a second portable DGPS reference station
is needed for comparison. SWATH is not equipped to set up a second portable DGPS
reference station due to loss of equipment during the 2004 field season.

4. The field unit is currently performing GIS functions using Maplnfo version 6.5. While this
software version will perform locally without problems, OCS has upgraded to version 8.0.
Project files and workspaces created using Maplnfo version 8.0 may not be compatible with
version 6.5.

CATEGORY 3 — These deficiencies are associated with observations during the course of the
review which merit consideration for corrective actions. These observations are included for review
and dialogue related to potential problem areas and hydrographic operational efficiency. It is
important to assure that resources (funds, skills, and time) are available at the operating level in
order to meet the needs identified in this report and to sustain the efficient operation, upkeep, and
repair of the field unit’s hydrographic systems.

1. Offset measurement and dynamic draft measurements for SWATH have not been
completed for 2006. The ship intends to operate for the 2006 field season using historical
values determined when the ship’s Elac 1050D MBES was installed. Based in the inherent
inaccuracy of the Elac system and the more relaxed requirements of IHO S-44 Otrder 2
surveying for which it is employed, the field unit considers historical offset and dynamic
draft values to be adequate.

2. Launch 2901 is equipped with a POS/MYV version 3 system. The review team recommends

that this system be upgraded to a version 4 system so that Precise Timing methods can be
implemented with the launch’s Reson 8125 MBES system.

DATA STORAGE AVAILABILITY

Platform Free Space (TB) Used Space (TB)







Coordinate Systems for Common OCS Equipment & Software
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POS/MV Calibration Report

Field Unit:

SYSTEM INFORMATION

Vessel:

Date: Dn:

Personnel:

PCS Serial # 786

IP Address: 129.100.1.231

POS controller Version (Use Menu Help > About) 2.10d

POS Version (Use Menu View > Statistics) MV320 Ver3
GPS Receivers

Primary Receiver SGN 99330009
Secondary Receiver SGN 98370085

CALIBRATION AREA

Location: Ketchikan, AK D M S
Approximate Position: Lat 55 19 46

Lon 131 37 27
DGPS Beacon Station: Annette Island, AK
Frequency: 323 kHz
Satellite Constellation (Use View> GPS Data)
Primary GPS (Port Antenna) N
HDOP: 0.873
VDOP: 1.033

© ©
Sattelites in Use: 9
©

1,4,11,13,16,20,23,25,30

PDOP 1.352 (Use View> GAMS Solution)

Note: Secondary GPS satellite constellation and number of satellites were exactly the same as the Primary GPS




POS/MV CONFIGURATION

Settings
Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)
User Entries, Pre-Calibration Baseline Vector
1.834 Two Antenna Separation (m) 0 X Component (m)
0.30 Heading Calibration Threshold 0 YComponent (m)
0 Heading Correction 0 Z Component (m)

Configuration Notes: GAMS needed re-calibration because the leverarm for IMU to Port Antenna was incorrect

POS/MV CALIBRATION

Calibration Procedure: (Refer to POS MV V3 Installation and Operation Guide, 4-25)
Start time: 10:18 UTC

End time: 10:20 UTC

Heading accuracy achieved for calibration: 0.099

Calibration Results:

Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)
POS/MV Post-Calibration Values Baseline Vector
1.831 Two Antenna Separation (m) -0.002 X Component (m)
0.300 Heading Calibration Threshold 1.831 YComponent (m)
0 Heading Correction 0.021 Z Component (m)
GAMS Status Online? X
Save Settings? X

Calibration Notes: Took over an hour to get fixed OTF solution and GAMS Ready Offline

Save POS Settings on PC (Use File > Store POS Settings on PC)
File Name: POSMV_09012004.nvm




GENERAL GUIDANCE

The POS/MV uses a Right-Hand Orthogonal Reference System
The right-hand orthogonal system defines the following:
» The x-axis is in the fore-aft direction in the appropriate reference frame.
* The y-axis is perpendicular to the x-axis and points towards the
right (starboard) side in the appropriate reference frame.
» The z-axis points downwards in the appropriate reference frame.

The POS/MV uses a Tate-Bryant Rotation Sequence
Apply the rotation in the following order to bring the two frames of reference

into complete alignment:

a) Heading rotation - apply a right-hand screw rotation 8z about the
z-axis to align one frame with the other.

b) Pitch rotation - apply a right-hand screw rotation 8y about the
once-rotated y-axis to align one frame with the other.

c¢) Roll rotation - apply a right-hand screw rotation 8x about the
twice-rotated x-axis to align one frame with the other.

SETTINGS (insert screen grabs)

Input/Output Ports (Use Settings > Input/Output Ports)

x|

COMI | comz2 | COME | Analog |
Message Select
¥ Enahle CORI L1 §IMNWTG - Track made good and &
L1 §INGST - Pseudorange measure
Baud Rate Update Rate FINGGA - Global position syste
2600 R EIGE ~| | |®$INHDT - Heading
[ $PASHR - Attitude, Tate-Bryant
_ _ _ [ $PASHR - Attitude, TSS =l
Parity— Data Bits Stop Bits Bialll Easiin Semnse
&+ Mone 7 Bits & 1 Bit & Part Up " Starboard Up
" Ewven Pitch Positive Sense
~ Odd & 8 Bits || ¢ 2 Bits = Bow Up £ Stem Up
Heave Positive Sense
& Heave Lp " Heave Dawn
Ok | Close I Apply |
COMI COM2 | com3 | Analog|
¥ Enable CORMZ2 Diagnostics => |
Baud Rate Update Rate Message Select
19200 R ELE =] | TS5 (Format 1) |
Parity—— Data Bits Stop Bits E)elll Easiie Senees
& MNaone 7 Bits & 1 Bit & Port Up " Starboard Up
" Ewen Pitch Positive Sense
~ Odd = 8 Bits 2 Bits = Bow Up " Stern Lp
Heave Positive Sense
% Heave Up " Heave Down
Ok | [ Close Apply |

NOTE: COM3 and Analog are not used.

Message Select

$PROID - Attitude, Tate-Bryant #
FPRDID - Attitude, TSS
FIMNZDA - Date and time
FINGGH - Position fix, EHT
v SUTC - Date and time




Heave Filter (Use Settings > Heave)

Heave Filter |

i 7 Altitude
—i* Hegve Filter

Damping Ratio

Heave Bandwidth (sec) IEEI.IIIEIEI

|III.?EI?

Close | Apply

Time Sync (Use Settings > Time Sync)

Time Synchronization

User Time Conversion {units/sec) |1

Close | Anply

Events (Use Settings > Events)

—Event 1

¢ Positive Edge Trigger

= MNegative Edge Trigger

Guard Time (m=ec) |0

—Event 2

~ Positive Edge Trigger

= Megative Edge Trigger

Guard Time (m=ec) |0

Close |

Apply |

Installation (Use Settings > Installation)

Lever Arms & Mounting Angles

Xl

—Ref to IMLU Lever Arm
X [pooo
vim) oo
Z(mp [pooo

Lever Arms & Mounting Angles | Sensor Mounting | Tags, Multipath & AutoStart |

—Irdll Frame wert. Ref Frame

X (dedg) ID.DDD
¥ (deg) ID.DDD
L (deg) ID.DDD

—Ref to Primary GPS Lever Arm-
2 oo
vmy [0
Z(m) |-3.169

—Fef. to Heave Lever Arm

% {m) [0574
vy [001s

Zm  [0315

—Ref to “essel Lever Arm

X (m)  [0.000
¥ (m)  [0.000
Z(m) |o.000

Motes:

1. Ref = Reference

2 wert. = With Respect To

3. Reference Frame and “essel
Frame are co-aligned.

=R i Dk Close Apply




Tags, Multipath and Auto Start (Use Settings > Installation > Tags, Multipath and Auto Start)

x
Lever Arms & Mounting Angles | Sensor Maounting  Tags, Multipath & AutoStart I
—Time Tag 1 —ultipath
" POS Time & Low
i GPS Time = Medium
& UTC Tirme " High
—Time Tag 2
& POS Time
i GPS Time
 UTC Time
= User Time
—Autostart
" Disabled
&+ Enabled
= Close | Apply |

Sensor Mounting (Use Settings > Installation > Sensor Mounting)

Lever Arms & Mounting Angles |

Lever Arms & Mounting Angles  Sensor Mounting |Tag5, Multipath & AutoStart |

—Ref to Aux. 1 Gps Lever Armm—— ~Ref to Aux, 2 GPS Lever Arm—————
¥gm) [ooo ¥gm)  fjpooo
v foooo ¥gw)  fpooo
Z(m) ID.IZIIZID Zim) IIZI.DIZIIZI

—Ref to Sensor 1 Lever Arm —Sensor 1 Frame w.rt. Ref. Frame

Xen)  fjpooo X(deg) [oooo

vy fuooio ¥ (deg) [oooo

Zirm) ID.IZIIZIEI Z (deg) IEI.DIZIIZI

—Ref to Sensor 2 Lewer Arm —Sensar 2 Frame w.rt. Ref. Frame

¥gm) [ooo X(deg) |oooo

vgm) oo ¥ (deg) [oooo

Z(m) ID.IZIIZID 7 (deq) IIZI.DIZIIZI

Close | Apply |




x|

~RMS Accuracy
Attitude (deg)  |0.0500
Heading {deg) ||:|_|:|5|:u:|
Pasition (m) |2_IZIDDD
Welocity (m/s) |IZI_EDIZIEI
Close | Apply

User Parameter Accuracy (Use Settings > Installation > User Accuracy)

—Frame Control

Frame Control (Use Tools > Config)

Mavigator Configuration

x|

@ Llser Frame

 IMU Frame

& MNormal

—Primary GPS Measurement—— ~Auxiliary GPS Position

" Use regardless of status

" Do not use

& MNormal
" Use regardless of status

" Do not use

FGAMS

Vv Use GAMS Solution

Close | Apply |

GPS Receiver Configuration (Use Settings> Installation> GPS Receiver Configuration)

Primary GPS Receiver

|
Frimary GPS Receivar | Secondary GPS Heceiverl
~Primary GPS ~Diff Port
—Cantral
GPS Receiver Baud Hate  Accept RTCH
Nowatel OEM2-3151F 7] | | |9800 B || & 2eesn Gortms
i Accept RTCA,
i Accept CMR
i Accept RTCH-18-19
—Auto Configuration Farity Data Bits Stop Bits—
o =l @ iz C 7Bits | | & 1Bit
" Ewen
Close | Apply
Secondary GPS Receiver
x|

—Secondary GPS

PSS Heceiver

Primary GPS Receiver Secondary GPS Receiver |

—Diff Port

Baud Rate

MNovatel OEM2-3151Fz)

9600 =l

—Control
= Accept RTCH

i Accept Commands
i Accept RTCA
i Accept CMR
 Accept RTCKM-18-19

—Auto Configuration Farity Data Bits Stop Bits—
& Enabled % None C 7Bits | & 1Bi
= Ewven
 Disahled " Odd i+ 8 Bits = 2 Bits
Close Apply




DIRECTIONS FOR CREATING

TRADITIONAL LEAD LINES AND SOUNDING POLES
(excerpted from the NO.AA Hydrographic Manual, July 1976, with modifications)

Traditional Lead Line Construction
I. Material

Standard lead line material is mahogany-colored tiller rope with a phosphor-bronze wire
center. The center consists of six strands of seven 33-B (S-gage) wires each. The wire core is
flexible and should not break after continual use and coiling. The rope is size 8 (about 0.24
in. in diameter), and is made of waterproofed, solid braided, long-staple cotton. The braid
should be tight enough so that broken wire strands will not protrude through the covering
and injure a leadsman's hands. Material for lead lines may either be requisitioned from the
Marine Centers or be purchased from a well-equipped marine supply dealer.

II. Fabrication and Marking
Depending on the depths in which they will be used and on the size of the vessel, lead lines

should be 30 to 60 meters long. Each lead line is identified by a consecutive number
stamped on a metal disk attached at the inboard end of the line. Identification is made when
a line is initially graduated. This number is to be retained throughout the life of the lead line
or until re-marking is necessary. The braided covering of an unseasoned lead line tends to
shrink when wet causing the wire core to buckle and the strands to break. Broken strands are
likely to protrude through the covering and cause hand injuries. To prevent rupturing the
core with repeated use, pre-season each lead line as follows:

1. Prepare the lead line by soaking it in salt water for 24 hours. Then, while the line is still
wet, work the cotton covering along the wire by hand until the wire protrudes from the
covering. The wite should protrude about 1/3 meter for each 20 meters of line. This is a
tedious procedure requiring the cooperative efforts of several people. The covering can be
pushed back and slackened only a few inches at a time; this length of slack must be pushed
nearly the full length of the line before the next small section can be started. The excess
protruding wire is cut off. The covering must not be worked back too far, or it will form
bulges along the wire. Lead lines so prepared will maintain an almost constant length for
future use.

2. Next, the line is dried under tension (about 50 Ib) and then soaked again for 24 hr. Never
boil a lead line as this destroys the waterproofing of the cover.

3. After attaching a lead to the line, the line should be wetted down again and placed under a
tension equal to the weight of the lead; this tension is maintained while the line is being
graduated. Temporary marks made at this time can be used for later permanent marking.
Graduation marks on a new lead line may be laid off with a steel tape. The best method,
however, is to mark the distances permanently on a suitable surface such as on the deck of a
ship or on a wharf if the survey party is shore based. Permanent markings are convenient
when verifying the graduations in the future. Lead lines for NOAA hydrographic surveys
should be graduated in meters, with intermediate marks to permit readings to the nearest
decimeter. Fach meter should be marked by a seizing of black thread, with a leather strip
clearly indicating the numerical value for even meter intervals. Each even decimeter (0.2,



0.4, 0.6, and 0.8) is marked by a seizing of white thread. Odd tenth readings are estimated.
Woaxed linen thread should be used to secure marks to the lead line in such a manner that
there can be no possibility of slippage. Do not insert the thread through the braided
covering of the line.

III. Verification
When checks of traditional lead lines are made, the lead lines must be wet and under a
tension equal to the weight of the attached lead in water. The testing standard should be a
good recently calibrated steel tape or pre-measured graduation marks on deck or ashore.
Replace or re-mark lead lines if the errors exceed 0.1 meter.

IV. Sounding I.eads

Each survey unit should have one or more leads. Leads come in standard weights of 5, 7, 9,
14, and 25 Ib are requisitioned from the Marine Centers. Various methods may be used to
attach the lead to the lead line. The preferred method is to have a galvanized thimble at the
lower end of the lead line to which the lead can be attached by a shackle.

Traditional Sounding Pole Construction

I. Material
A sounding pole is made from a 5 meter length of 1.5 inch (3.81 cm) round lumber capped
with a weighted metal shoe at each end to hasten sinking. Shorter poles may be used
depending on the depth conditions.

II. Fabrication and Marking

Any convenient system of marking that is symmetrical toward both ends and will minimize
reading errors may be used. The following marking system is recommended:

Mark each meter and even decimeter graduation (0.2, 0.4, 0.6, and 0.8) permanently by
cutting a small notch in the pole. Paint the entire pole white; then paint odd decimeter
graduation marks black.

III.  Verification
Sounding poles must be verified against a known standard, such as a survey quality metal
tape, to ensure that depth markings are unambiguous and accurate.



Lead Line & Sounding Pole Calibration Report

Field unit:

Lead Line / Sounding Pole Identification Number:
(Unique Identifier, with equipment type, date made, etc. )

Date of Calibration:

Method of Calibration:
Other

Location:

Chief of Party:

Lead Line / Sounding Pole Unit of Measure: Meters (This should always be meters!)

Measured by: Recorded by: Checked by:

Graduated Marking Calibration Measurement Lead Line Corrector
(@) (b) (c=b-a)




Sounding Systems Comparison

Field Unit:
Date Location Sounding System Models & Serial [ Raw Depth AT System
; Depth Comments
& Time (Lat, Lon) Numbers (m) 0 Operator
Non-traditional lead line: FA-LL1 60.0 60.0 ST GF Annual Systems Certification comparison.
Reson 8101 (Launch 1): 58.5 59.7 ST JA Sea conditions calm, 1 ft swell.
1/15/2005 DLDG MODIII: 59.2 60.1 CST LM  |No corrections necessary.

Page 1 of 1




Multibeam Echosounder Calibration

Field Unit:
Date of Test:
Calibrating Hydrographer(s):

MULTIBEAM SYSTEM INFORMATION

Multibeam Echosounder System:
System Location:

Sonar Serial Number:
Processing Unit Serial Number:

Date of Most Recent EED / Factory Checkout:

VESSEL INFORMATION

Sonar Mounting Configuration: pole-mount on port side of vessel
Date of Current Vessel Offset Measurement / Verification:
Description of Positioning System: POS/MV version 4 w/ Precise Timing

Date of Most Recent Positioning System Calibration:

TEST INFORMATION

Test Date(s) / DN(s):

System Operator(s):

Wind / Seas / Sky:

Locality: Chesapeake Bay
Sub-Locality: Tail of the Horseshoe
Bottom Type: sandy

Approximate Average Water Depth: 20 meters

DATA ACQUISITION INFORMATION

Line Number Heading

Speed

Page 1 of 2




TEST RESULTS

Navigation Timing Error:

Pitch Timing Error:

Roll Timing Error:

Pitch Bias:

Roll Bias:

Heading Bias:

Resulting CARIS HIPS HVF File Name:

NARRATIVE

Briefly and succinctly summarize the MBES Certification Test, focusing on those aspects of the test.
Particular attention shall be paid to interpretation of test results, with discussion on residual biases in roll,
pitch, heading, and navigation timing error. Any changes to configuration made based on these results
shall be described.

Page 2 of 2



Side Scan Sonar Calibration

Field Unit:
Date of Test:
Calibrating Hydrographer(s):

SIDE SCAN SYSTEM INFORMATION

Side Scan System: Klein System 3000

System Location: Launch 1005

TPU Serial Number:

Towfish Serial Number:

Cable Type: stainless steel armored w/ grease termination
Date of Most Recent EED / Factory Checkout:

Date of Most Recent Pressure Sensor Verification (if applicable):

VESSEL INFORMATION

Sonar Configuration: towed
Cable Measurement System (if applicable): Dynapar cable counter
Date of Current Vessel Offset Measurement / Verification:

Date of Current Cable Measurement / Verification (if applicable):

TEST INFORMATION

Test Date(s) / DN(s):

System Operator(s):

Wind / Seas / Sky:

Locality:

Sub-Locality:

Description of Bathymetry: steep

Bottom Type: rocky

Approximate Water Depth:

Description of Target: ping pong ball target

Approximate Target Size: (should be approximately Im L x Im W x 1m H)

Page 1 of 2




TEST INFORMATION (continued)

Target Position:

Description of Positioning Method:
Estimated Target Position Error:
Approximate Survey Speed:
Approximate Towfish Altitude:

DATA ACQUISITION INFORMATION

Line Number Heading Speed

TEST RESULTS

Number of Passes on Target:

Succesful Target Detections:

Mean Detected Position:

Distance from Mean Position to True Position:

Approximate 95% Confidence Radius:

NARRATIVE

Briefly and succinctly summarize the SSS Certification Test. Particular attention should be paid to
interpretation of test results, with discussion of any correlation between target detection or positioning
error and side scan pass direction, range, or channel. Any changes to configuration made based on
these results shall be described.

Page 2 of 2
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Basic Water Level Station Equipment Checklist

Critical Information

determine local magnetic variation at site:

determine exact UTC time:

Gauge - Separate ltems
gauge
tarp
nitrogen Tank
2 batteries
GOES antenna
tripod
GOES cable
solar Panel
solar Cable
computer with RS232 connector

Gauge - Bag
swagelock fittings
nitrogen regulator
snoop
compass
inclinometer
parachute cord
crescent wrench
9/16, 5/8, 11/16, & 1 1/8 wrench
lag shields (1/2"; 3/4" hole)
eyebolts (1/2" ; 3/4" hole)
orifice cutter
plastic zip ties

Staff - Separate Iltems
graduated staff
extra support lumber
electric wood drill and bits

Staff - Bag
wood saw
hand drill and bit
lag bolts - various lengths
lag shields (1/2"; 3/4" hole)
machine bolts - various lengths
spacers
washer and nuts
angle irons
hammer
wire snips (dykes)

Leveling - Separate ltems
level
rods
tripod

Leveling - Bag
lumber crayon
IPAQ w/ Newwiz 2.0
extra battery for IPAQ
pencils, pens & calculator
steel tape
level bubbles
turtle

Orifice - Separate Items

Orifice Tubing w/ Orifice
Orifice Plate
chain

Orifice - Bag

separate Orifice

Hose clamps

Plastic zip ties

wire snips (dykes)
crescent wrenches

box wrench

flat screw driver

hammer

orifice cutter

lagbolts - various lengths
lag shields (1/2"; 3/4" hole)
eyebolts (1/2" ; 3/4" hole)

Diver - Separate ltems

first aid

oxygen

Back Board
Save a Dive Kit
Dive Bag

Diver - Pneumo Bag

pneumatic drill
pneumatic drill bits
pneumatic hose

Diver - Toolbag

Hose clamps
Plastic zip ties
wire snips (dykes)
crescent wrenches
box wrench

flat screw driver
hammer

Benchmark - Separate Items

2 Bosch drills

extra Bosch batteries
Bosch charger

fresh water

cement

Benchmark - Bag

benchmarks

hammer/ mallet

stamping kit

plastic bags

measuring tape

camera (w/ extra batteries)
handheld GPS
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NOAA FIELD UNITS HYPACK / HYSWEEP DEVICE SETUP SOP & 1
HYPACK 2009a — Updated Nov 2009

EI RO
= LILIELS]

The following instructions are the standard setup for HYPACK and HYSWEEP devices. There
are two sets of device setups that need to be configured when using Hysweep. One is in Hypack
Hardware, which includes navigation, motion, gyro and AIS, and one is in Hysweep Hardware
which includes navigation, motion and bathy (See Diagram 1). It is also important to setup the
POS Ethernet Realtime to be compatible with this setup.

1.0 POSM/V
* Items in this controller should only be changed by experienced users with the unit. If you
are new to POS you should only verify that the items addressed below are correct and then
you may start logging.
** Reminder: If you want to change anything in the logging control windows you must be
connected first.

1.1

Ethernet Realtime Logging

ONLY the following message groups should be selected: 3, 7, 20, 102 and 111. When
you save and exit, the program will give you a warning about not selecting 'Group10'.
Override this warning. We do NOT want group 10 to be sent real time.

2.0 HYPACK

1.1 PROJECT MANAGER

1.2

S0 kA3 E- U

1.3

1.4

1.1.1 In the Administer Window: Select File > Project Manager
1.1.2  Select New Project — Name accordingly

Geodetic Parameters (UTM Zone)
When making a new project it is very important to select the correct UTM Zone.
Ellipsoid is WGS-84

0 2-gpr 5 & 4 € 13

HYPACK HARDWARE CONFIGURATION
Devices are very important. Without them we will not get the correct information
that we need in order to survey.

ADD DEVICES/ SET UP

Click on the Add Device button. Add the following three devices.
1. Applanix POS M/V Network (posmv.dll)

2. Hysweep Interface (HY SWEEP.dII)

3. AIS (ais.dll)

Now that you have added your devices, we need to configure your devices and make sure
your settings are correct.

1. Applanix POS M/V Newtork (posmv.dll) — (mimic Image 1)

a. Be sure that Position, Heading, Speed and Heave are all check off
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b. Connect — Network Port
e Protocol — UDP
e Role — Client
e Host— IP address of POS (129.100.1.231)
e Port— 5206 — always the same for the POS M/V
=5 HYPACK Hardware - C:HYPACK' Projects’, Grays Harbor' survey3Z.ini = | Dlll
File Edit Options Help
Add Devics Add Mobile | Devies |
% Hypack Configuration Functions
E.. Boat Puosition (L=
i 3 Heading Starboard ID.DD 0 Yaw ID.DD dea.
Speed
ETide Forward  |0.00 m Foll |0.00 deq.
H
e Werlical ID.DD m Fitch ID.DD deq.
Wertical Postive Downward
ikl Latency ID.DDD SEC
Connect INetwork Part j
—MNetwark Parameter
Setup... | Test |
Protocol — |UDP - Role IEIient VI
Mobile Azsignment——————————————————
Jnsta"e o | | Host [128.1001.231
Part  |5602 Wwiite Part |U
Dirivver
|posmv.dll
Image 1. Applanix POS M V Newtork
c. Click on the setup button - (Image 2. POS MV Setup Window will pop up)
e The “Use PPS signal for timing” X
should be unchecked
e ITIS VERY IMPORTANT TO SeialPot [ <] Cancel |
HAVE “Use POS M/V time-tags
even when not synchronizing" TO
BE CHECKED ¥ Use POS MAY time-tags even when not spnchionizing (be carsful 1l
Y Select ' Record mulibeam frame data [group 102)
. " Record vessel frame data [group 1] - Ne.mow e
— record multibeam frame data - Wide Lane RTK
- Float RTE
(group 102) " Get heave from group 102 __~ DGPS

— Get heave from group 102

— Get solution

status from group

20 (POS M/V version 4)

" Get heave from group 111

[not recommended]

" Get solution status from group 3 [POS MAY version 3
% Get solution status from group 20 (POS MAY version 4]

Image 2. POS M/V Setup
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2. HYSWEEP INTERFACE (HYSWEEP.dII) — no setup or connection required
a. Be sure that ‘depth’ function and ‘Use for matrix update’ are checked off (see image 3)

= HYPACK Hardware - C:\HYPACK'Projects'Grays Harborsurvey32.ini ] B [l 5]
Flle Edt oOptions Help
#dd Devics ‘ pddMcbin | 0%z |
= Hupack Configuration Functioris ;
El-d Boat Depih o
-5 Applanix POS M W Netwark [ Heading Starboard |0.00 Yaw (000 deg

m

H "YSWAEEP INTERFAL! ] Heave

g s " Fowsrd  [0.00 o ol [o00 45
Vatical  [0.00 m Fich [000  deg

Vertical Postive Downward

Options Latency  |0.000 SEC

Use for matrix update

Caonnect INone VI

Setup.. | Test |

Installed on [Boat 7

"Mobile Azsignment———————————

Driver
[HYSWEEP.dI

Image 3. HYSWEEP INTERFACE

3. AIS (ais.dll) — Ifyou are equipped with an AIS
a. Connect — Serial Port COM#, 9600, 8, 1, None, None

After all of the Hypack devices are setup, setup your Hypack Configuration and Boat
Configuration.

Hypack Configuration — see window below - *IN THIS SET UP IT IS VERY IMPORTANT
TO BE SURE THAT THE DEVICE TO SYNC CLOCK WITH IS “Applanix Pos MV

2
NetWOI‘k * =5 HYPACK Hardware - C:\HYPACK 2009%projects\Test_Alaska\survey3Z.ini
File Edt Options Help

Add Device sddMoblle | 9¥5tEm | ComTest|
Hypack Configuration S R A e Ak b Forie Sale
- Boat
&) Applanis POS M ¥ Network Device to Synch clock, with
(& HYSWEER INTERFACE [pplari PO M Y Network El
& s

Additional Settings
I ShowXYZ in SURVEY/DREDGEPACK
I Show Rt files in SURVEY
I Automaticaly Start Logging upon startup
I Autonatically Save on Exit Hardware

I Individual Tide Per Mobile

Printer Settings

Prirt Connection  [None -

Query Parts

Image 4. Hypack Configuration
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Boat Configuration — See window below — Check that the correct device (source) shows up
next to each information type. It is on this screen that you can change the tracking point of the
boat, ie, you want the real time swath to be originating from the transducer and not the center of

the boat.

5 HYPACK Hardware - ChYHYPACK Projects’Grays Harbor' survey32.ini = |EI|£|

Fle Edit Options | Help

‘ Add Device sddMcbie | Mobie | Vessel Shape |
% I:Iypack Configuration Function Im
o
iotal) Applanic POS M W Netwark
il HYSWEEP INTERFACE Information Source
efall AlS Paosition 05 M
Heading Applanix POS M
Speed Applanix POS M % Network,
Depth HYSWEEP INTERFACE
Heave Applanix POS M % Network,
Pitch Applani POS M % Network
Foll Applaniz POS M % Network
Coordinates of Tracking Painl
Starboard |0.00
Forward  |0.00

Image 5. Boat Configuration

1.5 TESTING DEVICES

J Testing of deyices should be conducted every _[ol x|
time H}fpack is opeged. ' T Wi
e #1 Device to check is the Applanix POS M/V — -
Network (posmv.dll) =131

1. Click on the Test button. The screen to Lat 557500991 N
the right will pop u Lon L3206, 913 W
g pop up. , Height 211 m
2. Ensure that all of the categories are IIN Made RTCM
populated, changing and seem to be Satellites 11
Hdg 282.89

correct. a
peed n.01
a. IIN Mode — RTCM (this is what you want Pitch .00
to see) Rall -0.55
C/A (Course Acquisition) — ok, some Heave 0.10
laces in Alaska might not have a Ticke HJé
p . g Swnc err MIA
strong signal. Tirme: source Groun 7
N/A __ - not good, might have the wrong Undulation 0.00

beacon chosen or the beacon is down.

b. Time source — Group 7 — ensures that
you have your Hypack Configuration
Device to sync set correctly.

Image 6. Hypack Navigation Window

Congratulations! You have now setup the Hypack Hardware Portion of this configuration.
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3.0 HYSWEEP HARWARE CONFIGURATION

Hysweep > Hysweep Hardware
Like Hypack devices, Hysweep devices are very important. This setup is taken into

EVPAGEE

ek

consideration when converting your data. There are three devices that must be setup in
Hysweep Hardware.

*Must have windows firewall disable

3.1

SETUP / CONNECT
Under the Manufacture / Model tab click on the following device then click the Add
button. The device will be installed and shown by populating in the screen on the

right side of the window under Installed.

1.

Hypack Navigation

2. Applanix POS/MV Network
3. The appropriate Sonar Device - Reson Seabat 7125, 8101or 81xx(Network), etc.

E;. Hysweep Hardware Setup

File:

el

Manufacturer / Model

| Connectl COM Testl fosetsl

FWH Gyrotrac

M arine Sonic: Sea Scan
MWMEA-0183 Gyro

Odom Dual ES3

Odom Echoscan |l

Odom ES3

Odom Miniscan

Rezan Dual 7125

Rezon Dual 3101 [MY)
Rezon Seabat 7101

Reszon Seabat 7125
Reszon Seabat 8101

Feson Seabat 81w [Netwark)
Rezon Seabat 81 [Sernial]
Rezon Seabat 3001

Reszon Seabat 3003

;I Add > |
<-- Remove |

I

Sefup... |

=101]

Installed

Hypack, M avigation
Applaniz POS /MY M etwork,
Fieson Seabat 81w [Metwark)

RIEGL L5 Sefies x| Name |H5'|:-ack Mavigation
Specific Sonar |dentification
Reszon Seabat 8111 j
Close | Help... | About... | Hupack Navigation j

Image 7. Hysweep Hardware Setup

1. Hypack Navigation — does not need a setup or any settings changed under the connect tab.

Applanix POS/MV Network — does not need any changes in setup.

Does need some settings changed in the connect tab. (see Image 8 below)
a.

Select the Connect tab
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b. Make sure that Applanix POS/MV Network is populated at the bottom right hand of the
window.
c. Enabled box gets checked
. Port—5602
e. Internet Address —129.100.1.231

%;: Hysweep Hardware Setup - Applanix POS/MY¥ Network _ o =]
File

Manufacturer / Model  Connect | COkd Testl fosetsl

v Enabled [ lgnore Checksum Timeaout Interval [Seconds] [15 0
[~ Record raw meszage
~Metwork Connection
Part 15502
Internet Address !1 23.100.1.231
Claze i Help... | Abaout... i j

Image 8. Hysweep Hardware Setup - Applanix POS M/V Connect tab

3. Sonar (RESON 81XX) — needs changes in the setup and Connect tab.
a. Select the Correct Model
b. Specify the correct identification (located at the bottom left hand side of the screen)
c. highlight the sonar listed under Installed

e Setup
a. click on the ‘Setup...” button (Image 9 will pop up)
b. Select ‘Side Scan Option’
c. Select ‘Use Snippets’ if the project calls for it.
d. Network Driver, COM Port for Time Sync (9600 Baud) — set to NONE

e Connect Tab (Image 10)
a. Select ‘Enable’ and ‘Ignore Checksum’ boxes.
b. Under Network Connection - enter the port and IP address of your sonar.

Refer to the ship and launch wire diagrams for sonar specific connections.
*Make sure you have the IP address of the sonar and not of the computer NIC Card.
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i xi

V3
[~ Log Seabat Datagramns

[~ Use Snippets

8101 Driver

Rumberof Beams 109
iefwark Faort |1 02e

—Metwork Driver

COk Port far Time Sync [3600 Baud)

Mone j

—Dwal 7125 Driver
Elave [P addiess I

0K I Cancel |

Image 9. Sonar Setup (Reson)

il
Eile
Manufacturer / Model  Connect I COM Testl fosetsl
E : ¥ Ignore Checksum Timeout Interval [Seconds] [15.0
[ Record raw message
i~ Metwork. Connection
Part I1 uzs
Internet Address |1D.'I.D.BD
Cloze | Help... | About. | IHeson Seabat 81#x [Metwork) j

Image 10. Sonar Connect Tab (Reson)

Congratulations! You are now ready to survey! ©
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|

Serial

L

LIV EAEHS

Acquisition Computar

Ethernaet X-Over
Groups 3, 7. 20, 102
Maw, Mation, Heading

UTC Timing

Serial Commands
From B1XX Server

|

Ethemet X-Over
Bathymetry Data

Y

| Mavigation data to

Y

Hysweep via
Shared Memary
from Hypack

A J

Shared Memaory

Bathymetry data to
Hypack via Shared |:

Surface 3V

Memory from
Hysweep

Usad for Matrs fil |’

DIAGRAM 1. General Box Wiring Diagram of the Hypack/Hysweep Setup



DIVER LEAST DEPTH GAUGE MODEL Il

GENERAL

The MOD 11 Diver Least Depth Gauge (DLDG) consists of a Micro Gauge Corporation
precision absolute pressure sensor and a PTC Electronics Incorporated Model D2000
pressure readout assembly, with rechargeable batteries, housed in a specially constructed
rectangular water-tight enclosure. The following are used in conjunction with the
operation and care of the instrument: battery charger, underwater plug, special processing
software, Sea-Bird Electronics SEACAT CTD Profiler, and barograph. Neither the
profiler nor the barograph is provided with the instrument; rather they must be
resident on the ship.

PHYSICAL FEATURES

Figure 1 is a picture of the front of the enclosure of the MOD 111 DLDG. The face plate
on the enclosure is clear to allow the LED display to be read (in this case, 14.51 psia).

Figure 1

Front View of a Diver Least Depth Gange Model ITT

Figure 2 also shows the front of a MOD IIl DLDG. Shown to its left is an InSitu
MiniTroll instrument, a handheld absolute pressure gauge.



Figure 2

The rear face of the MOD 111 enclosure contains the bulkhead electrical connector and the
pressure port. There is a 7 cm vertical offset distance between the position of the
pressure port and the bottom of the instrument case. Note that this offset is applied as a
correction by program VELOCWIN in the computation of the least depth. Therefore, in
order to obtain a correct value for the least depth, the MOD I11 gauge should be placed on
top of the diver-determined least depth point and held level so that the LED readout is
upright (as shown in Figures 1 and 2).

THE GAUGE IS TO BE CONNECTED TO THE BATTERY CHARGER WHEN
NOT BEING USED ON A DIVE OPERATION. This is to increase the reliability and
availability of the unit. A fully charged battery should give the gauge approximately 10
hours operating time. For the instrument to be returned from low voltage to its fully
operational condition, the battery must be on charge for 18 hours.

For the InSitu MiniTroll, the pressure port is 2.9 cm from the bottom tip of the probe.
The bottom tip is the end opposite the watertight screw cap covering the data port. The
2.9 cm offset is applied as a correction by program VELOCWIN in the computation of



the least depth. Therefore, for accurate results, the MiniTroll should be held upright with
the bottom tip of the wand placed on the user-determined least depth point.

SOFTWARE

The Diver submenu of program VELOCWIN provides two options to use in conjunction

with the Diver Least Depth Gauge:

(1) Least Depth Report
(2) Daily DQA - Diver Gauge.

The Least Depth Report option prompts the user for several inputs including the pressure

on-deck and at the user-determined
calibration data for the DLDG, and

least depth point. Using these two values, the
the data from a Sea-Bird SEACAT CTD cast taken in

the vicinity, VELOCWIN computes the least depth of the submerged object. The results
of this option are shown in Figure 3 which may be printed out to obtain a hard copy
record of the dive and the least depth result.

Figure 3

. COMPLETE REMAINING ITEMS FOR LEAST DEFTH REPORT.

Version 4.2 [l=] E3

Froject |DPR-220004RU aurvey  [H000
HNOAS Uit IFILIDE ear |133?
Suwoiz # INDNE Fis# [NOME Contact # {MOME
— Cast Data
Day UTC of Cast IE?E Tirne UTC aof I:ast|-|5:-||:|
Cast Table # |-| 3 Cast Instrurnent ISE,.-}.'D-E.'T 5 /M1 251
— Dive D ata
Gauge & |goos Day UTC of |2?5 Time UTC of LD |1?;15
I Dive Meazurement
Latitude: 142,/04/18.25 N Longitude —70,33/48.30 W
of Dive of Dive
Predive Gauge |-| 409 Gauge Pressure |3g.g|:|
Prezsure, psia at Depth, pzia
— FResults & 3ve b Fil
Computed Least Depth , m |1 717 Sve o T
Tide Caomrectar, m I._2|:| Save and Print
Comected Least Depth, m |1 £.497 Cancel

Comments and
Recommendations

=l




The Daily DQA option is a data quality assurance procedure for the DLDG. It prompts
the user for the on-deck DLDG pressure in psia and the barograph reading in mbars.
Using these values and the gauge’s calibration data, VELOCWIN determines if the
instrument is operating within acceptable bounds. The results are a running log file
(DIVERDAILYDQA.DAT) and a graphical display of the relationship between the
ship’s barograph and the DLDG. Figure 4 is an example of the graphical display.

Figure 4

. DAILY DQA - DIVER LEAST DEPTH GAUGE  VYersion 4.2

DALy DO&, DIVER LEAST DEPTH GAUGE 68336 Version 4.2
1100 =
- f_/'
B T
% Joe0 o
R | . r
0 ’ _. ) . -
M .," .-__f -
E 1020 | e
T Copn
H EED i J./ e a/.f". _/
M C T DK
: R
o B PO Frint
o o .
SI:II:I T T T T T T T T T T T T T T
13 134 138 142 146 15 15.4 15.8
CORRECTED OMW-DECK. PRESSURE - PSIA * t4ost recent point

The calibration file for the gauge has filename, SN.CAL, where SN is the serial number
of the gauge (example: 68332.CAL). The default location for this file is C:\VELOCITY,
the directory of program VELOCWIN. If it is stored elsewhere, VELOCWIN will
prompt the user for the location.

DATA QUALITY ASSURANCE

The DAILY DQA option requires that the on-deck DLDG pressure be entered in psia to
two decimal places and the barograph reading be entered to the nearest millibar.




The LED readout is absolute pressure in units of pounds per square inch. This on-deck
reading should be in the region of 14.70 psia. The reading will rise and fall with the local
atmospheric pressure, along with variations in the distance below the water surface. The
nominal depth equivalent of a 0.01 psia change in pressure is 0.5 cm. If the gauge is
subjected to horizontal acceleration in a line between the pressure port and the LED
readout, there may be a small change in the pressure reading.

The DAILYDQA option should be run each day. It should also be run before and after
each day’s dive operation to provide a pre- and post-dive record. At the end of each field
season and any other time that the gauge is returned to a Marine Center, the running log
file, “\VELOCITY\DIVERDAILYDQA.DAT”, must be returned with the gauge.

The gauge uses a built-in, approximate calibration curve to derive the pressure values
shown on the LED readout. The more accurate calibration curve, by gauge serial
number, is employed by the VELOCWIN program to achieve high accuracy results. The
data quality assurance test might not indicate an exact one-to-one relationship with the
ship’s barograph, but the relationship should be reasonable and regular and fall within the
acceptance bounds shown in the DAILY DQA graphical display.

DIVE OPERATION

As shown in Figures 1 and 2, the handle is attached to the gauge such that the unit must
be held in the diver’s right hand in order for the numerals in the LED readout to be
upright. The unit should be placed on top of the diver-determined least depth point and
held close to level. Below the water’s surface, a depth error, in centimeters, of
approximately 15*SIN(tilt angle) will result from non-level operation. When the unit is
at depth and fixed on the least depth point, the pressure readout will vary as a result of
any overhead surface waves. The peak to peak variation due to these waves may occur
over a period from 1 to 8 seconds. Therefore, it is necessary for the diver to observe the
LED readout for 10 seconds or more to improve the diver’s estimate of the mean
pressure.

On days when dive operations are to be conducted, the gauge will be disconnected from
the battery charger. The exposed electrical connector on the instrument must be capped
with the underwater connector which is provided. It is not necessary to disconnect the
battery charger from the ship’s A/C supply. There are three pins on the electrical
connector, one of which is larger than the others. The underwater plug has a flat spot
over the large pin. Care should be taken when inserting the charger cable plug or the
underwater blanking plug onto the instrument to be sure that the connector is correctly
orientated relative to the pins of the electrical connector on the rear of the enclosure.

Previous to each dive, the pressure reading on the instrument must be observed with the
unit out of the water and appropriately recorded. A diver will carry the unit on the dive
to locate and measure the least depth on a designated object. The accurate least depth is
determined via head pressure at the diver-designated least depth point, in conjunction



with the knowledge of the local vertical density profile. The head pressure is the
difference between the on-deck (pre-dive) pressure reading and the pressure observed by
the diver at depth. The density of the water column is obtained from the Sea-Bird
SEACAT CTD cast taken in the vicinity. Running the Least Depth Report option of
VELOCWIN computes the head pressure and converts it to the reported least depth.

Upon completion of a day’s dive operations, the Diver Least Depth Gauge must be
washed with fresh water and wiped dry. The underwater plug must be removed from the
rear of the gauge and stored in a safe place. Finally, the battery charger should be
connected to the gauge being careful of the connector orientation.

SUPPORTING DATA

The local density profile must be independently measured in the vicinity of the dive site
with a SEABIRD SBE-19 or SBE-19Plus SEACAT Profiler and processed via the
VELOCWIN program. The cast should be taken in accordance with the specific
SEACAT instructions, which are documented separately. However, IT IS VERY
IMPORTANT THAT THE SEACAT SHOULD BE POWERED-ON AND HELD
ON-DECK FOR AT LEAST THREE MINUTES PREVIOUS TO LOWERING
THE SEACAT INTO THE WATER.

Complete instructions for taking a SEACAT cast are available from the VELOCWIN
Help submenu under Precast Setup

CALIBRATION

Each Diver Least Depth Gauge will require an annual calibration before deployment for
the field season. At the end of the field season, a post-deployment verification must also
be performed. Post-deployment verification and pre-deployment calibration may be
performed simultaneously. The gauge must be returned to the Marine Center for
forwarding to the manufacturer for calibration. Once calibration is accomplished, a
hardcopy calibration report will be provided for each gauge. A copy of the report must
be provided to HSTP/CSDL in order for an extended calibration curve to be generated (to
accommodate deep dives). HSTP provides the extended calibration curve as a digital file
named SN.CAL where SN is the DLDG serial number. The file is disseminated to all
field units.

CALIBRATION GUIDELINES

The gauge contains a 100 psia pressure transducer. Calibration between approximately
13 and 50 psia is critical for accurate least depth measurements. A data set of fourteen
points, with the first point being below ambient pressure, the next point at ambient
pressure, the next seven points at 1 psia increments above ambient pressure, and the
remaining points at 5 psia increments will insure sufficient accuracy. Replacing



exhausted batteries will not effect calibration; however, any circuit repairs will require
complete gauge calibration.

Calibration is performed by:
PTC Electronics Inc.

45 Whitney Road, Suite B9
Mahwah, NJ 07430

Attn: John C. Kicks

PROBLEMS

If the results of the DAILYDQA test fall outside the acceptance bounds, this fact should
be noted to the Marine Center and arrangements made for the gauge to be replaced and/or
repaired. In addition, inform the Marine Center if any other irregular performance of the
DLDG arouses suspicion.
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USER’S GUIDE FOR GPS OBSERVATIONS

1.0 Introduction

This User’s Guide for Global Positioning System (GPS) Observations for the tidal and water
level station bench marks is prepared to support the Center for Operational Oceanographic
Products and Services (CO-OPS) GPS Implementation Plan. The field observation procedures
are developed in collaboration with the National Ocean Service (NOS), National Geodetic
Survey (NGS), and consist of slight modifications of NOAA Technical Memorandum NOS
NGS-58, Version 4.3, as described below, to obtain relative accuracy in connecting water level
stations to the International Terrestrial Reference Frame (ITRF) and the North American Datum
of 1983 (NAD 83) coordinate systems. Modifications made to NOAA Technical Memorandum
NOS NGS-58 guidelines and requirements involve the length of the GPS observations required,
in this document. This Guide must be used in conjunction with NGS-58 for collecting the GPS
data at water level stations.

It is assumed that the field personnel are familiar with the basic operating principles of the GPS
equipment, the cable connections and the antenna/tripod setup procedures. A detailed discussion
of GPS processing software and processing procedures is outside the scope of this Guide. GPS
data collected by CO-OPS or CO-OPS’ contractors for the National Water Level Observation
Network (NWLON), for hydrographic and photogrammetric surveys either by NOS Office of
Coast Survey (OCS) and NGS field parties will be submitted to NGS for data processing —
“blue-booking” is a term used to describe this processing according to the Input Formats and
Specifications of the National Geodetic Survey Database, Appendix L — Guidelines for
Submitting GPS Relative Positioning Data.

All GPS data must be collected as per NGS specifications and as described later in this document
and processed first using NGS Online Positioning User Service (OPUS). All GPS data and
documentation shall be submitted to CO-OPS, which will then be forwarded to NGS, as per the
contracts, project instructions, statement of work, or as appropriate.

1.1. Reference Documents

The following reference documents are referred in various sections of this document.

(1) “CO-OPS GPS Observations Implementation Plan, January 2003”.

(2) “NOAA Technical Memorandum “NOS NGS-58, Guidelines for Establishing GPS-Derived
Ellipsoid Heights (Standards 2 cm and 5 cm), Version 4.3,

(3) “User’s Guide for the Installation of Bench Marks and Leveling Requirements for Water
Level Stations, October 1987”.

(4) “Standards and Specifications for Geodetic Control Networks”, Federal Geodetic Control
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Committee, September 1984.
(5) “Attachment R, Requirements for Digital Photographs of Survey Control, NGS, July 2005”
2.0. Equipment and Setup

High accuracy static differential GPS surveys require a geodetic quality, dual frequency, full-
wavelength GPS receiver with a minimum of 10 channels for tracking GPS satellites. A choke
ring antenna is preferred; however, any geodetic quality ground plane antenna may be used.
More important than antenna type, i.e. choke ring or ground plane, is that the same antennas or
identical antennas models should be used during the entire observing sessions. If not, a
correction for the difference in antenna phase patterns (modeled phase patterns) must be applied.
This is extremely critical for obtaining precise vertical results. The antenna cable length between
the antenna and receiver should be kept to a minimum when possible; 10 meters is the typical
antenna cable length. If a longer antenna cable is required, the cable must be fabricated from
low loss coaxial cable (RG233 for up to 30 meters and RG214 over 30 meters).

A fixed height precise GPS antenna tripod is required for this type of a survey. This is a fixed
height, 2 meter pole with three adjustable legs, a bulls-eye bubble to plumb the antenna, and a
magnetic compass to align the antenna to North. These fixed height tripods reduce the chance of
introducing a Height of Instrument (HI) “blunder” during the post-processing of the data. There
are situations where it may be necessary to use the adjustable precise GPS antenna tripod, such
as when a bench mark is elevated above ground level or when using air transportation. The
center pole is adjustable on this tripod; therefore, if not fully extended to the 2 meter position,
the antenna height is measured with a steel tape (several times) and entered into the receiver and
onto the GPS Observation Log Sheet. In fact, even in the 2 meter position, it is recommended
that the adjustable tripod be measured to verify the length. There is a screw-on point at the
bottom of the center pole of both - the fixed and adjustable tripods - that must be inspected each
time the tripod is setup to ensure that the point is tight and not bent. The tripod must be stable
during observations; therefore, the tripod legs must be secured, preferably with sand bags.

Antenna set-up is critical to the success of the project. Plumbing bubbles on the antenna pole of
the fixed-height tripod must be shaded when plumbness is determined. Plumbing bubbles must
be shaded for at least 3 minutes before checking and/or re-plumbing.

The manufacturer, model, and complete serial numbers of all receivers and antennas must be
included for each occupation on each station/bench mark observation log sheet as shown in
Figure 3.

User’s Guide for GPS Observations, Updated March 2007 Page 2



3.0  Geodetic connections and datums relationship

Water level datums are local vertical datums which may change considerably within a
geographical area. A geodetic datum is a reference surface relative to which heights are
determined. The North American Vertical Datum of 1988 (NAVD 88) is the accepted vertical
datum of the National Spatial Reference System (NSRS) for the conterminous United States and
Alaska and is officially supported by NGS. The relationship of tidal datums to NAVD 88 has
many hydrographic, coastal mapping and engineering applications including monitoring sea
level change and the deployment of GPS electronic chart display and information systems, etc.

Existing geodetic marks in the vicinity of a subordinate tidal station shall be searched for and
recovered. A search routine is available at http://www.ngs.noaa.gov. An orthometric level
connection and ellipsoidal GPS tie is required at a subordinate tide station which has at least one
geodetic bench mark located nearby as stated below for Sections “NAVD 88 Level Tie” and
“NAD 83 GPS Tie” requirements. NAVD 88 heights for published bench marks are given in
Helmert orthometric height units by NGS. The GPS ellipsoid network height accuracies are
classified as conforming to 2 cm or 5 cm standards accuracies (Refer to NOAA Technical
Memorandum NOS NGS-58). At the present time, GPS ellipsoid heights conforming to the 2
cm accuracy standards are required for all GPS survey projects.

A connection to the geodetic datums at a water level station enhances the value of the tidal data,
allowing comparison with other data sets. The geodetic network essentially serves as a global
reference datum to which all tidal datums can be referenced.

The connection to geodetic datums involves the following three ties:

(1) NAVDS88 Level Tie
(2) NAD 83 GPS Tie
(3) NAVD88 GPS Tie

3.1. Level Connections
3.1.1. NAVDS8S8 Level Tie

At all water level stations, a valid level tie to at least two Geodetic Bench Marks (GBM) is
required on each set of levels, where appropriate marks are available within 1.6 KM (1 mi)
leveling distance of the station location. A GBM is defined as a bench mark that exists, is
useable, is available in the NGS database, has a Permanent ID (PID), and has a NAVD 88
elevation published on the datasheet. At many NWLON stations, the Primary Bench Mark
(PBM) is a GBM. At the majority of NWLON stations, there are two or more tidal bench marks
that are also GBM, thus increasing the chance that the geodetic level tie will be valid.
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Make a Second-Order, Class | tie for all NWLON stations in the conterminous United States and
Caribbean Islands. A Third-Order tie is used for all NWLON stations in Alaska, Hawaii, and
Pacific Island areas.

At stations supporting hydro or other special projects, the tie shall be consistent with the
accuracy of the levels required for the project.

Information on performing a valid level tie is provided in the Federal Geodetic Control
Committee (FGCC) Standards and Specifications for Geodetic Control Networks, listed at the
following website:

http://www.ngs.noaa.gov/FGCS/tech pub/1984-stds-specs-geodetic-control-networks.htm#3.5

Also, Section 3.4 of “User’s Guide for the Installation of Bench Marks and Leveling
Requirements for Water Level Stations, October 1987 provides information regarding how to
perform a valid level tie.

The Second-Order, Class I tie is a requirement for digital levels to be accepted into the NGS
database. Short level runs to the sensor, PBM, and two marks are excluded from this
requirement since they are usually meant to verify sensor stability only. Since a level connection
to GBMs with dynamic heights defines the International Great Lakes Datum of 1985 (IGLD 85)
datum offset at each station in the Great Lakes, a valid connection to at least two GBMs is
required at each site.

A note shall be made in the remarks of the leveling section of the Site Report that a valid tie was
achieved or not achieved. If a valid tie is not achieved, an explanation shall be provided and/or
recommendations made for making a valid tie in the future.

If the NWLON water level station does not have two or more GBMs within 1.6 km (1 mi)
leveling distance of the station location, then the level tie requirement is waived.

3.1.2. Leveling at Continuously Operating Reference Stations (CORS)
For any NGS CORS reference bench mark that is located within 1.6 km (1 mi) leveling distance
of a water level station Data Collection Platform (DCP), a leveling connection shall be made to

the tidal bench marks in the water level station network every two years.

Information about NGS CORS can be obtained at http://www.ngs.noaa.qgov/CORS/.

As of 2007, there are a limited number of water level stations in this category, but NGS and CO-
OPS are attempting to secure funding to establish additional co-located sites to support long-
term sea level trends monitoring.
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3.2.  GPS Connections
3.2.1. References

Static GPS observations shall be performed at water level stations in accordance with “NOAA
Technical Memorandum “NOS NGS-58, Guidelines for Establishing GPS-Derived Ellipsoid
Heights (Standards 2 cm and 5 cm), Version 4.3, These guidelines are written for establishing
GPS derived ellipsoid height accuracy standards of 2 cm for all NWLON, PORTS®,
hydrographic/Photogrammetry survey projects, COASTAL projects, and special project
applications.

3.2.2. GPS Observations - Goals and Planning

Precise positioning of NWLON stations in a global geocentric reference framework is needed to
support NOS marine safe navigation and height modernization projects, in addition to
monitoring vertical crustal motions for absolute sea level and global climate change studies.

CO-OPS shall initiate a program of making periodic GPS observations at water level stations, as
resources permit. CO-OPS activities shall be coordinated with NGS activities for best use of
available resources.

GPS technology and procedures shall be implemented in the operational plan:

(1) To support the development of a seamless, geocentric reference system for the acquisition,
management, and archiving of NOS water level data. This will provide a national and global
digital database, which will comply with the minimum geo-spatial metadata standards of the
National Spatial Data Infrastructure (NSDI) and connect the NOS water level datums to the NGS
NSRS;

(2) To establish transformation functions between NOS chart datum Mean Lower Low Water
(MLLW) or Low Water Datum (LWD) in the Great Lakes, and the geocentric reference system
to support NOS 3-dimensional hydrographic surveys, the implementation of Electronic Chart
Display and Information Systems (ECDIS), and the NOS Vertical Datum transformation
(VDatum tool) and tidal datum models. Integration of GPS procedures will support the
development of tidally-controlled Digital Elevation Maps and Models for use in programs such
as marsh restoration.

(3) To support water level datum transfers by using GPS derived orthometric heights.

(4) To monitor crustal motions (horizontal and vertical) to support global climate change
investigations.
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The GPS surveys should be scheduled during routine annual maintenance trips to NWLON or
PORTS® stations and during the installation of secondary and tertiary water level stations to
support the survey projects, U.S. Army Corps of Engineers (USACE) projects, COASTAL
project stations, tsunami stations, and special purpose surveys. CO-OPS shall continue to
coordinate the GPS occupation of water level network bench marks with NGS, USACE, and the
National Geospatial-Intelligence Agency (NGA), as appropriate.

GPS-derived orthometric heights can be accurately determined and used for water level datum
transfers according to the following criteria: (a) use the established guidelines for 3-D precise
relative positioning to measure ellipsoid heights; (b) properly connect to several NAVD 88
bench marks; and (c) use the latest high-resolution modeled geoid heights for the area of interest.
In many remote locations, the use of GPS-derived orthometric heights for datum transfer will be
more efficient (timely) and more cost-effective than the use of conventional differential
surveying techniques and may, under certain circumstances, preclude the installation of
additional water level stations to establish a datum.

As specified in the Annual Project Instructions, Annual Station Specific Requirements, or in the
contract documents, installer shall be required to perform GPS observations at each water level

station at specified intervals over time, depending on the rate of sea level rise in that water area

of the coast.

As of March 2007, 20 NWLON stations have been identified where annual GPS observations are
required because of the sea level rise in those areas. These 20 NWLON stations — 8 in Alaska
and 12 in the Gulf of Mexico — will be identified in the annual Project Instructions. The rest of
the NWLON stations require GPS observations every five years. These guidelines will be
updated as GPS technology improves and the policy or regulations change in the future.

3.2.3. Static Surveys

Static GPS surveys shall be conducted on a minimum of one bench mark at each water level
station, according to the priority levels below. Generally, one mark at each station is designated
as the GPS mark and observations shall be made to that mark (as per the required GPS
observation frequency) unless otherwise specified in the Station Specific Requirements.

1. National Water Level Observation Network (NWLON), PORTS®, and tsunami stations.
2. Long term operating secondary water level stations.

3. New tertiary survey, COASTAL stations, and special project stations.

4. Historical subordinate water level stations with an accepted MLLW value on the current
official tidal datum epoch

Static GPS surveys shall be conducted at water level stations periodically over time to establish a
history of relationship between the tidal or water level datums, and the ellipsoid.
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3.2.4. Criteria for Bench Mark Selection for GPS Observations

The GPS Water Level Station Bench Mark (GPSBM) shall be selected based on the following
criteria: (a) permanence or stability; (b) historic GPS use; (c) satellite visibility; and (d) safety
and convenience.

(a) Permanence or Stability of Bench Marks

NGS has defined the following monumentation quality codes, also called the stability codes, for
various bench mark settings.

Stability code A — monuments of the most reliable nature which may be expected to hold their
elevations very well; e.g. Class A rod marks, or marks installed on large boulders/rock outcrop.

Stability code B — monuments which probably hold their elevations well; e.g. Class B rod marks,
or marks installed on large concrete footings/foundations.

Stability code C — monuments which may hold their elevations but which are commonly subject
to surface ground movements; e.g. pavement or concrete monuments.

Stability code D — movements of questionable or unknown reliability.

The station bench mark selected for GPS observations shall be of stability code A or B. GPS
observations on the PBM are preferred if the PBM is either stability code A or B, and is suitable
for satellite observations. Stability code C and D bench marks shall not be used for GPS
observations, unless NGS has previously made GPS observations on those marks.

(b) Historic GPS Use

In many states, CO-OPS has provided NGS with lists of selected marks suitable for GPS
observations at water level stations, and NGS has completed observations on these marks. Some
tidal marks designated as Federal Base Network (FBN) or Cooperative Base Network (CBN)
marks may be of stability code C. Generally once a mark is selected for GPS observations,
future GPS observations shall be done on the same mark. If leveling reveals instability of the
mark over time, select another mark.

Priority shall be given to a GBM for GPS observations because the GBM already has a NSRS
height (NAVD 88). The GBM considered here is one of the 10 tidal or water level bench marks
at a NWLON water level station, or one of the 5 bench marks for survey or special projects.
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(c) Satellite Visibility

The most desirable bench mark for GPS observations should have 360 degrees clearance around
the mark at 10 degrees and greater above the horizon. Newly established marks shall be set in
locations that have these clearances, if at all possible. If a station does not have any marks
suitable for GPS observations, and it has been selected as needing GPS observations, a new 3-D
rod mark shall be established. This new mark shall be connected to the station bench mark
network through conventional geodetic leveling, and then GPS observations shall be made.

All existing station bench marks at operating stations shall be assessed for feasibility of GPS
observations, as time and resources permit. A note shall be made, either in the APP field of the
electronic leveling HA file or on a copy of the published bench mark sheet, stating the suitability
of GPS observations for each mark. The GPS visibility obstruction diagram as shown in Figure
5 under Section 6 GPS Project Documentation shall also be completed for each mark observed.

(d) Safety and Convenience

The location of the GPS bench mark should be safe, secure, and convenient. Bench mark
locations which allow unattended GPS data collection are desirable as the field crew can multi-
task at the same time as collecting the GPS data. The safety of the GPS equipment (vandalism
proof) should be considered in the mark selection process.

The bench mark selected for GPS observations should be located on public property rather than
on private property, as permissions from private owners may be required in the future to access
the bench mark and for collecting the GPS data. The distance from the station DCP should also
be convenient.

3.2.5. Planning, Position, and Photograph of the GPS Bench Mark

Regarding suitability of a mark for GPS observations, a review should be made first of the
historical bench mark information in the station files and level records, if access to that
information via database is available, or if the information is available. Stable marks from the
level records are identified and copies of the descriptions and sketches are made. Descriptions
and sketches are examined and marks are eliminated that have obvious obstructions, such as
vertical marks, marks set several meters from medium to large structures, etc. Do not eliminate
marks that are near poles, fences or about 20 meters from small structures at this time during the
preliminary planning. If no other mark is available or found suitable, and time does not permit
the installation of a new (GPS) mark, it may be necessary to use one of these marks. In selecting
a GPS mark, priority should be given to the NWLON PBM or an NGS, NSRS, mark with a First
or Second-Order NAVD 88 height on a NGS datasheet.
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If time permits, conduct a site reconnaissance survey prior to starting the GPS sessions, to select
the proper mark(s) to occupy with GPS. A site survey consists of preparing an obstruction
diagram for each useable mark using an inclinometer and placing a GPS unit (hand-held or
better) over the bench mark to determine how many satellites can be tracked at that location.
Determine the location of a suitable weather proof location, if any, for the GPS receiver.
Measure the distance from the mark to this location to determine the antenna cable length
required. Ideal marks should have approximately 360 degree unobstructed visibility above the
10 degree elevation mask. However, satellite geometry changes with time, so for 4-hour
tracking sessions some obstructions, particularly those to the north of the mark, may not degrade
the precision or accuracy of the final solution.

GPS (horizontal) positions (latitude and longitude) of each bench mark installed or recovered
shall be listed on the HA files for laser levels, if used, or on the bench mark descriptions sheet
for optical leveling, as applicable, at each subordinate water level station occupied for all
projects.

Digital photographs shall be taken of all station bench mark disks in accordance with Reference
5 - Attachment R, Requirements for Digital Photographs of Survey Control, NGS, July 2005”. A
minimum of three photos shall be taken: close-up of the disk face; waist or chest level view of
disk and setting; and horizontal view of location and direction of view. All digital station photo
files should be named such that the name of the file will indicate the station number and the type
of photo taken. For example, the bench mark A face photo for San Francisco water level station
shall be named as 94142901 BM A face photo .jpg.

A digital photo of the stamping of the bench mark occupied must be made as shown in Figure 7.
If a digital photo is not available, then a rubbing of the bench mark must be done as shown in
Figure 6. A digital photo of the stamping is preferred over rubbing of the mark.

3.2.6. Data Collection and setup

Set the epoch update or recording interval (REC INT) for 15-seconds, which should agree with
the recording interval of the reference stations (IGS or CORS) used to post-process the data. For
GPS sessions greater than 30 minutes, collect data at 15-second epoch intervals, starting at an
even minute. The elevation mask (ELEV MASK) is typically set for 10 degrees for static
surveys; low angle satellites can degrade the final solution. Set the minimum number of
satellites to four. For static surveying, setting the minimum number of satellites (MIN SV) is not
as critical as for kinematic surveying. However, if the number of satellites tracked drops below
four, it could be an indication of other problems, such as an antenna or antenna cable connection
problem, RF interference, or an obstruction from traffic (vehicle or vessel). The GPS signal
from the satellite is not very strong when entering the receiver, so anything that produces further
attenuation of the signal can cause the receiver to stop tracking satellites.
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Always collect a little bit of extra data if time and schedule permit, so that blunders or invalid
data, if any, can be removed during processing still leaving required minimum number of hours
of valid data for one GPS session.

It is recommended that after each session is complete, two independent downloads be done from
the GPS receiver to the laptop computer, so that if one downloaded file gets corrupted, the other
file may have good data. Since two downloads of the GPS observation file is a requirement, do
not make copy of the downloaded file twice to the laptop instead, as both the files will have the
same problem, if there exists a problem. Send both copies of digital GPS data so that one copy
of the data can be forwarded to NGS and other copy will be kept for record in CO-OPS’
Requirements and Development Division’s Operational Engineering Team (RDD/OET).

Data should be compressed and copied to a CD-ROM, diskette, and/or zip disk, as appropriate,
at the end of each GPS day for transporting data from the field to the office, or hotel as the case
may be, for processing. If data are logged to a PCMCIA card (flash card) in the receiver, consult
the receiver User Reference Guide about re-formatting the card prior to beginning observations.

Data should be collected during periods when the Vertical Dilution of Precision (VDOP) is less
than 6 for at least 90% of each 30-minute or longer GPS observations, if VDOP maps or data are
available for the site.

3.2.7. North American Datum 1983 (NAD83) GPS Tie

At each NWLON station, GPS observations shall be performed as listed in the Annual Project
Instructions, Annual Station Specific Requirements, and contract documents. The frequency of
repeated observations on the GPSSBM shall be determined based upon the rate of sea level rise
and general stability of bench marks in the local leveling network.

The NGS OPUS is now used extensively for quick and convenient processing of the GPS raw
data for a variety of applications. The position solution provided by OPUS is considered
preliminary data and is not retained by NGS. Further information on using OPUS is provided
later in this document.

The expected ellipsoid height accuracy for a 4 hour OPUS solution is 1.8 cm, (at the 67%
confidence level), and that is desirable, practical, and achievable with the requirements as
specified in reference #2, NOAA Technical Memorandum “NOS NGS-58, Guidelines for
Establishing GPS-Derived Ellipsoid Heights (Standards 2 cm and 5 cm), Version 4.3.

The length of GPS observation sessions depends upon the length of time the field crew has
available for GPS observations, security of the equipment, number of satellites available at a site,
number of GPS receivers available for GPS observations, etc.
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For all water level stations, collect a minimum of 4 hours of GPS data on the GPSBM. Extra
care shall be taken to ensure that the antenna height is precisely recorded, and that the antenna
setup is stable. A continuous long session (at least 4 hours long but less than 24 hours) repeated
annually is preferred to two or more shorter sessions (of less than 4 hours each) repeated on the
same visit, providing better data for OPUS and more independent observations.

After the data collection session is complete, two independent downloads are required from the
GPS receiver to the laptop computer. If one downloaded file gets corrupted, the other file may
have good data. Do not make a copy of the downloaded file, as both the files will have the same
problem, if there is a problem. Follow the NGS guidelines for naming these files. Submit both
copies of the digital GPS data along with the necessary documentation as specified below.

3.2.8. GPS Data Processing Using OPUS

Field parties shall use OPUS for processing the raw GPS observations. OPUS provides an easily
accessible, rapid method for submitting GPS data and receiving an almost instantaneous solution
response from NGS via email.

The NGS OPUS web page can be obtained at http://www.ngs.noaa.gov/OPUS/.
The following information is found on the OPUS web page but is also presented here for
convenience of the reader.

OPUS allows users to submit their GPS data files to NGS, where the data will be processed to
determine a position using NGS computers and software. Each data file that is submitted will
be processed with respect to three CORS sites. The sites selected may not be the nearest to your
site but are selected by distance, number of observations, site stability, etc. The position for your
data will be reported back to you via email in both - ITRF and NAD 83 coordinates as well as
Universal Transverse Mercator (UTM), U. S. National Grid (USNG) and State Plane
Coordinates (SPC) northing and easting.

OPUS is completely automatic and requires only a minimal amount of information from the user,
such as:
(@) The email address where you want the results sent
(b) The data file that you want to process (which you may select using the browse
feature; raw or RINEX accepted)
(c) The antenna type used to collect this data file (selected from a list of calibrated GPS
antennas)
(d) The height of the Antenna Reference Point (ARP) above the monument or mark that
you are positioning.

Once this information is complete, you then click the Upload button to send your data to NGS.
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Your results will be emailed to you, usually within a few minutes. You may upload multiple
data files in a zip archive if you wish. However, be careful, the options that you choose will be
applied to all of the data files in that archive (i.e. the same antenna type, ARP height will be used
for all of the files in the zip file).

The following are some simple guidelines for analyzing the OPUS solutions.

(a) Make sure the antenna type and the ARP height are correct.

(b) Review the solution statistics:
(I) A good quality OPUS run should typically use 90% or more of your observations.
(1) OPUS should have fixed at least 80% of the ambiguities
(111) The overall RMS should seldom exceed 3 cm.
(IV) The maximum peak to peak errors should be less than 2 cm for horizontal and 4 cm
for vertical (This depends, of course, on the accuracy you are trying to achieve.)

NGS needs to receive orbit data from IGS in order to obtain a solution. If the data is submitted
too quickly (before NGS gets the orbit data from 1GS), the submitter may need to re-submit the
data at a later time. For best results, submit the GPS data to OPUS at least 17 hours after the
first midnight (in Greenwich Mean Time) following the time when the observations were
recorded. Compare the resultant solution to the last previous solution made at the station, if
available, to ensure that you do not have a blunder in the antenna setup. This will be revealed by
a noticeable discrepancy in the ellipsoid height. Include a copy of the solution in the station
inspection documentation package submitted to RDD/OET, as well as to NGS GPS data sets.

3.2.9. OPUS DB Preliminary information

Pending NGS support, OPUS DB will be released by NGS in the near future. This advanced
version of OPUS will submit solutions directly to the NGS database for publication as part of
NSRS if all required documentation is provided by the submitter. Further guidance will be
provided once OPUS DB is released and this document will be updated as appropriate. Any data
sets submitted to OPUS will be subsequently re-submitted by RDD/OET to OPUS DB to ensure
the data is published by NGS, provided all the proper and required GPS data and documentation
(as listed below under data submission section) has been submitted to CO-OPS.

Height modernization guidelines are listed at the following url:
http://www.ngs.noaa.gov/heightmod/quidelines.shtml

The Opus DB datasheet concept is fully listed at the following NGS web site:
http://www.ngs.noaa.gov/PROJECTS/draft/OPUS/OPUS-DB-concept.htm
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The following tables identify the required data elements and optional data elements for OPUS
DB respectively.

REQUIRED DATA ELEMENTS (15 each):

ELEMENT RATIONALE

. For identification &
e-mail

correspondence.

Filename Necessary to compute position.
Antenna Necessary to compute position.
antenna height Necessary to compute position.
name of submitting agency Identifies the observer.
permanent identifier (PID) Identifies the station.
Designation Identifies the station.
descriptive text Aids in station recovery.
Rod/pipe depth & units Describes monumentation quality.
sleeve depth & units Describes monumentation quality.
fs)t(ttlng code & specific setting Describes monumentation quality.
photograph (of marker) Aids in station recovery.

OPTIONAL DATA ELEMENTS (11 each):

ELEMENT RATIONALE

photographs Equipment photos describe antenna height and equipment used. Horizon
(of equipment,  photos aid in station recovery and could explain visibility or multipath
horizon) problems.

vertical stability Useful for stability assessment.

code

magnetic Aids in station recovery.

property code

antenna s/n Useful in identifying equipment-specific problems.
receiver Useful in identifying equipment-specific problems.
receiver s/n Useful in identifying equipment-specific problems.
receiver firmware Useful in identifying firmware-specific problems.
stamping Aids in station identification.

condition code  Useful for stability assessment.

spec_lal . Identifies the station type (tidal station, Public Land Survey corner, etc.)
application codes

remarks Allows user to record observation comments.
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This information regarding the Required Data Elements and Optional Data Elements is for
reference only and not required at the present time. These requirements will be active once
OPUS DB is designated operational by NGS. Out of the 15 Required Data Elements, 13 are
applicable to all the marks and the remaining two - rod/pipe depth & units and sleeve depth &
units — are applicable only to rod marks.

3.2.10. NAVD 88 GPS Tie

The NAVD 88 GPS Tie involves simultaneous GPS observations at the GPSBM and one or
more GBMs located up to 10 KM (6.26 mi) from the GPSBM. This “Height Mod” tie is
deferred until such time as NGS enables user-friendly blue-booking of campaign data (OPUS
projects).

4.0  GPS Project Documentation and Data Submission

The following information in addition to the results obtained from OPUS shall be submitted to
CO-OPS at the end of the project (see the time frames for submission of GPS data later in
Section 4.1) so that proper information can be forwarded to NGS for blue-booking purposes.

This documentation is important because most of the information is used to submit the GPS data
to NGS. In addition to the log, data must comply with the “Data Submission to NGS Section” of
NGS-58 (Reference 2) and the “Input Formats and Specifications of the National Geodetic
Survey (NGS) Data Base” (Reference 4) to become part of the NSRS.

GPS data collected by contractors or NOAA Ships for hydrographic survey support, or special
projects shall be processed by the parties, and final data product - Receiver Independent
Exchange Format (RINEX) data and appropriate forms - shall be submitted to CO-OPS which
will be forwarded to NGS, as per the contracts, project instructions, statement of work, or as
appropriate.

GPS forms in PDF format can be found at the following NGS Federal Base Network (FBN) web
site:

http://www.ngs.noaa.gov/PROJECTS/FBN/index.htm

Refer to Figures 1 through 7 for GPS projects submission checklist and sample package contents.
(@) Project report (Refer to Figure 1):
One project report per GPS project is required.

(b) Station (bench mark) description or recovery notes (Refer to Figure 2)
One per bench mark, for which GPS observations are submitted, is required.

(c) Observation log sheets (Refer to Figure 3 and 4)
One per each GPS observation session is required.
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(d) Station/bench mark visibility diagrams (Refer to Figure 5)
One per each bench mark, for which GPS observations are submitted, is required.

(e) Photographs or rubbings of station (bench) marks (Refer to Figure 6 and 7)
One per each bench mark, for which GPS observations are submitted, is required.

(F) Raw GPS data

(9) Rinex GPS data

(h) OPUS results
4.1.  Data Submission

All required GPS data and documentation shall be submitted to CO-OPS within 15 business days
of the GPS observations or the removal of the gauge whichever is earlier.

All GPS data and documentation shall be submitted in paper format and in digital format such as
CD-ROM in duplicate, so that one copy stays with CO-OPS and other copy is forwarded to
NGS. For GPS data that are collected according to the contracts, there may be additional
requirements for submission, please check with the appropriate Contracting Officer’s
Representatives.

Submit all GPS project data and documentation to:

Chief, Requirements and Development Division
CO-OPS, N/OPS1, SSMC 4

1305 East-West Highway, Station 6531

Silver Spring, MD 20910-3233

Tel: 301-713-2897
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Figure 1 GPS PROJECT SUBMISSION CHECKLIST

Project Title :

Submitting Agency:

Observing Agency:

Receiver Type:

Antenna Type:

PACKAGE CONTENTS

( ) Project Report

() Station Description or Recovery notes

() Observations Log Sheets
Data which must be filled out: Station Designation, Date (UTC), General Location, Day
of Year, Project Name, Session 1D, Observation Session Times, Agency Full Name,
Operator Full Name, Phone Number, GPS Receiver, GPS Antenna, Antenna Height, Data
File Name

() Antenna height measurements

() Station Visibility Diagrams

() Photographs or Rubbings of Station Marks

( ) Raw GPS data

() Rinex GPS Data - See below

( ) OPUS Results

( ) Other
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DATA REFORMATTING

Convert the raw GPS data to RINEX2 format with your manufacturer's software. The software
should require you to enter the raw data filename, the output filenames, your name, the
observer's name and agency, and the antenna type used.

The NGS-standard data filenames are as follows:

Raw GPS input files: aaaaddds.xxx
Where: aaaa = Alphanumeric 4-character station identifier,
ddd = Julian day of the year,
s = session, yy = year of observations,
and xxx is the receiver-dependent file extension (e.g., .DAT, .EPH, .ION, .MES, etc.)

RINEX2 navigation and observation files shall be named as follows.

RINEX2 Navigation File: aaaaddds.yyn
RINEX2 Observation File: aaaaddds.yyo

For example, RINEX2 filenames for navigation and observation from station BALD 2 on session
A of 12/31/06 are BALD365A.060 and BALD365A.06n

Copy the raw GPS data files and the converted RINEX2 data files onto separate 3.5-inch
diskettes or CD ROM.
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Figure 2: Station (Bench mark) Description/ Recovery Form

--> Click here to clear the sample data <--

NATIONAL GEODETIC SURVEY
STATION DESCRIPTION / RECOVERY FORM

PID: __ QEZ736 Designation & Alias: BALD 2 RESET
Country: wsa; USA  State: OR County: LINCOLN

Latitude: N 44 49 49.17802 « |ongitude: w 124 G8 56.23447 -« Elevation:___ 17.0(mder /)

Original Description (check one): Recovery Description (check one):
0 P | Preliminary (mark has not been set yet) 0 F | Full description of a station pot in the database
0 D | Anewly set mark T | Full description of a station in the database
R | A recovered mark 0 M | Partial description of a station in the database
Established by: (NGS/ CGS/ Other) Oregon DOT | | Recovered by: (NGs f Other:) QOregon DOT
Date: Chief of Party (intials) 777 Date: Chief of Party (intids): CFS
Monument Stability (check one): Recovery Condition (check one):

[”A | Of the most reliable nature; expected to hold well | | B#G | Recovered in good condition

U B | Will probably hold position and elevation well 0 N | Notrecovered or not found

0 C | May hold well, but subject to ground movement 0 P | Poor, disturbed, or mutilated

U D | Of questionable or unknown reliability 0 X | Surface mark known destroyed
Setting Information: Stamping: BALD 2 1991

Marker Type: (Rod f Dig / Other) Agency Inscription: (nGs/cGs/Cther)  Qregon DOT
Setting Type: (Be#bek f Concrete / Other ) Rod Depth: (meter/ft), Sleeve Depth: {meter/ft)
&' /N /7 | Monument contains magnetic material? Monument is: (iwh / projecting / recessed) {emfinch)

Special Type (check all applicable): Transportation (check one):
0 F | Fault monitoring site OC | Car
0 T | Tidal Staion 0 P | Light truck (pickup, carry-all, etc)

[~ | Control Station { FBN / C8N / Bendt'mark ) U X | Four-Wheel Dnve Vehicle

0 - | Airport Confral Station: { PACS / SACS ) 0 Other (SrowCat, Plane, Boat, describe)

o N | Mark is suitable for GPS use? ¥ N | Pack Time (hike) to mark? (rhmm); ~ 00:03

See Back of Form to add Text Description
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General Station Location: Thgstaionisic i _ .
Lincoln Bay, 13 km north from Depoe Bavg and at the Uus1o1
Boiler Bay wayside rest area.

{Desorbe generd oostion, ks slitking delanoss o vee lowns of mispoed feaiurses )

Ownership: | Ne station is on the property of Oregon State
Department of Parks and Recreation.

iname, address, phone of landowner;

To Reach Narrative: 9o reach the station from the intersection of US routes 5 and 101
in Depoe Bay, go north on US 101 for 1 km to the south entrance
of the Boiler Bay wayside. Bear left on entrance road for 0.4 km
to the parking area on the left, Pack northwest inside fence for
about 90 meters to end of fence and the station on the right.

#ee-blen detances and dinscdions fam mals resd imlersection o mark

Monument Description and Measurements: The station s $€1 INtO drill hole in
bedrock, 7.6 m south from the north fence corner, 8.8 m east
from the west fence corner, and 3.6 m southeast from the
northwest end of the outcrop.,

(A & least Hyres measurerments o permanent, sdeetiSable, nearsy chiedts: ared g desoripon ofthe monurerd size shase, boigh ele}

NOTE: - Include a pencil rubbing, sketch, or photographs of mark.
Described by: _ John G Surveyor  phone:( (3013713-3194  e.mail.__jgs@ordot.gov
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Fiaure 3: GPS Station Observation Lod

--> Click here to clear the sample data <--

Station Designation: [check applicable: FBN /BN 7 PAC [ SAC /ggM) | Station PID, if any. Date (UTC)
GPS STATION BALD 2 RESET QE2736 31-Dec-98
OBSEFS’QHON General Location Airport D, if any: Station 4-Character 1D Day of Year
(01-ov=2000) Boiler Bay Wayside BALD 365
Project Name Project Number Slation Serial # (SSN). | Session ID:{(AB,C etc)
Sample GPS, 1998 GPS- 1234 A
NADB3 Lalitude NADS3 Longﬂ.ide MNADB3 Ellipsoidal Height Agency Full Name
44 49 4917802 124 03 56.23447 |\ 1 oem orper O d TS | erator Full Name Oregon DOT
s John Q. Surveyor
Observation Session Times (UTC) Epoch 15 17.0 meters Phone # .
Sched S 12:00 Sop 12.30. inierval=_" Seconds | 5261099 Gecid Height e (301) 713-3194
Actual Start _1_1__5_3_5_ Stop _1_7:_32_ Mask = _1_(_)_ Degrees -23.52 meters | e-mail address: iQS@OI'dOtAQOV
. o Antenna plumb before session? 4 / N} Circle
Gps Recelver_‘ GPS Antenna'_ Antenna plumb after session? &£ / N} Yes or No
Manufacturer & Mocel: Manufacturer & Model: . Arfienina oriented to true North? &Y / Nj I no,
Leica SR530 ) Trimble Choke ng Weather observed at antenna bt wf # N} explain
PN: p]n 6671 22 PN p,’n 29659-00 Artenna ground plane used?  #4Y /N)
SN s/n 0030354 S/N: s/n 02200-63591 Antenna radome used? {(YIN If yes,

Firmware Version

Version 3.0

v&amt‘orderﬂaﬂen;, 0 12v DC, 0 110V AC, O Other

Cable Length, meters 30 meters

Wehicle is Parked 2_5__ meters _ " _(direction) from antenna

Any obstructions above 107

ivg

Eccertric occupation {=0.5 mm)? (Y / N)./ describe.
Ny

Radio interference source nearby (Y / N} Vis. fom

Use

Tripod or Ant. Mount: check one:
Fixed-Height Tripod, 0 Slip-Leg Tripod, 0 Fixed Mount
Manufacturer & Model:

PN hone.
SN 97-G
Last Calibration date: 1998-11-01

** ANTENNA HEIGHT **

Beofore Session Begins:
measure and record both

After Session Ends:
measure and record both

(s00 back of form for measurement illustration) Meters AND Feet Meters  AND  Feel
A= Datum point to Top of Tripod  (Tripod Height) 2.000 2.000
B=xdditional offzet to ARP if any (Tribrach/Spacer) -0.003 -0.003

Tribrach: check ore
lone, 0 Wild GDF 22, O Topoon, O Other (describe)

Last Calibration date

H= antenna Height = A+ B
= Datum Point to Antenna Reference Point (ARP)

Mote: Meters = Feel X (0.3048)

Please note &/or sketch ANY unusual conditions

Height Entered Into Receiver ;_ZLQQQeters Be Very Explicit as o where and how Measured!
Barometer: Weather | Tine | prysub T WetBulb T % | Atm P Weather
Manufacturer & Model: DATA (UTC) Fa?:em:elt Cglrs?ug Faf?renhuelt CeelrsTupE. ESr‘nidli:y mor:gé H;e?nﬁlhlggr Codes *
i pretel altiplus A2
none. Before i
SN JQ8. 12:00 |74.0 68.0 74 294 00000
Last Calibraton or check Date Middle 4
11-Sep-01 14:45 |77.0 725 81 296 00001
Psychrometer: After | 17:30 |[82.5 78.0 82 |29.7 00102
Manufacturer & Model:
Psychrodyne i * Sea back
Nas Average of Readings Calculate of formor
» il codes

Remarks, Comments on Problems, Sketches, Pencil Rubbing, etc:

1. Winds, calm at start, gradually increased to 20 knots by end of session.

2. Semi-trailer parked 12 meters SSE of antenna from 15:17 to 15:32 UTC, possibly blocking

satellites and causing multipath environment.

3. Center pole of tripod projected 3 mm into dimple of disk.

@j%t%qna hekght was ﬁherefé)

ntes are Required T all Unsha

e(562m 3mm=1997m
areas

DataFileName(s):  pa) D365A dat

{Standard NGS Format = aaaaddds 00

‘where aaaa=4-Character |0, ddd=Day of Year, s=Session |D, xoe=file dependant extension

Wisibility Obstruction Form
Photographs of Station:
Pencil Rubbing of Mark:

Updated Station Description g#Attached
P Attached

%ﬂacﬁed

0 Submitted earlier
0 Submitted earlier
0 Submitted earlier
Aftached

LOG CHECKED
By

JGE
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Fiaure 4: GPS Antenna Height Measurements

ILLUSTRATION FOR ANTENNA HEIGHT MEASUREMENTS:
<Radius,,

R
/7 7 i BGP
X ARP

l. _Instructions for
Fixed-Height Tripods:

Measure & record the fixed-height tipod length (A}
and other offsets, if any, between the npod and the

Antenna Reference Point (ARP) (B) ‘ f
Antenna. Height-H-A+B A -, /
; o~ B ~
Il._Instructions for = S =
Slip-Leg Tripods: S S
| / i =4
/ ()]
1. Measure the Slant Height  (S) 'g A / / S o -
Measure the slope dislance from the mark to al least three notches o -! . [44]
on the Bottom of Ground Plane (BGPF) using two independent rulers = Q a Q-‘ [
(g fric and Imperial). Record measurements in the table below, |.___ Q ‘u-’ <
and compute the average = B iy Eb"/ Iy
_: e
Measure S Notch# | Notch# | Notch# | Average _Qj g’ / é
Before, cm 223 40 22330) 22330 :% .§ /
Before, inch | 67.95] 6/.94] 8703 = 3 /
After, cm 22340 22340 22330 g g f“l
After, inch 8707] s8706] 87.95 iL - /
Note: cm= inch x (2.54) Overall average, cm (v} i'
L
S=__ cm a
: -]
2. Record the Antenna Radius (R) /
and the Antenna Constant (C) ¢
The antenna radius (R) is the horizontal distance from the
center of the antenna to the measurement notch. The antenna \{ Datum =
constant (C) is the verlical distance from the ARP to the BGP P
Consult your antenna users manual for exact measurements
R= _____1__9_'_ Q_5_____ cm . .
350 lll. _Instructions for using the
c= . - -
R Leica Brand Measuring Hook:
3. Compute Antenna Height (H)
ks gL e B B By Follow the Leica operaling instructions, being sure to reduce
Use the following Pylhagorean souation the height to the Antenna Reference Point {ARP), NOT the
L1 Phase Center
Antenna Height=H=((yS*-R*)-C) Anfenna Height-H-a+b
Table of Weather Codes -- for entry into Weather Data Table on front of form:
CODE PROBLEM VISIBILITY TEMPERATURE | CLOUD COVER WIND
0 NO PROBLEMS GOO0D NORMAL CLEAR CALM
encountered More than 15 miles 32° F o 80°F Below 20% Under Smph (8km/h)
1 PROBLEMS FAIR HOT cLouUDY MODERATE
encounterad 7 to 15 miles Over B0°F (27C) 20% o 70% 510 15 mph
POOR COoLD OVERCAST STRONG
2 ghok--D Less than 7 miles Below 32°F {0C) Over 70% over15mph (24km/h)
Examples: Code 00000 = 0-No problems, 0 - good visibility, 0- norma temperalure, 0 - clear sky, 0 - calm wind
Code 12121 = 1 - Problems, 2 - poor visibility, 1 - hot temperature, 2 - overcast, 1 - moderate wind
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Figure 5: Visibility Obstruction Diagram

--> Click here to clear the sample data <--

NATIONAL GEODETIC SURVEY
VISIBILITY OBSTRUCTION DIAGRAM

/‘Eﬂlé\lde ;'

to the, eas%

/
|
{

2H)°

eeq arg 50 \ ) r 4 1 |

\ meten;s southlwest‘ 3/ TRE \,41 / ;) /
/ i 5 /‘i rf ,I /
OM ¥ J K, f )

\__\ - )/_/ y / P’
3 i s Q 4 .Y c
e, \\ \M‘SG—/ Seis ,100 & 130

40°— mete):ssouth

INST

Identify obstructions by azimuth (magnetic) and elevation angle (above horizon) as seen from station mark.
Indicate distance and direchon to nearby structures and reflective surfaces {potential multipath sources).

Designation: BALD 2 RESET PID: QEZ736
Location: Boiler Bay Wayside County: LINCOLN
Reconnaissance By: John Q. Surveyor Height above mark: _2__ Meters

AgencyiCompany: Oregon DOT Phone: (_(301)[713-3194  py46.1998-12-31




Figure 6: Station Pencil Rubbing Form

Station Pencil Rubbing Form

--> Click here to clear the sample data <--

Location / Airport Name

and ID Boiler Bay Wayside Project _ Sample GPS, 1998

Station Designation _ BALD 2 RESET PID QE2736  ate1998-12-31

Circle all applicable: Observer & ;

PACS SACS $ft FBN C#N OTHER Organization John Q. Surveyor, ORDOT
Station Pencil Rubbing

Instructions: Place the blank form (or other blank paper) over the mark and rub over the entre disk with a
pencil. For rod marks, rub only the designation and date stamping from the rim of the aluminum logo cap. If
it is impossible to make a rubbing of the mark, or if the mbbing appears indistinet, a sketch and/or photo graph
may be substituted.

Remarks: 5 =
This disk is reset into the same drill hole as Monument Type rass Uis

the original station BALD 1962.

Inscribed Agency Oregon DOT

BALD 2 1991

Stamping
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Figure 7: Digital Photograph of a Stamping of a Bench Mark
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NOTICE

Mention of a commercial company or product does not constitute an endorsement by NOAA.
Use of information from this publication for publicity or advertising purposes concerning
proprietary products or the tests of such products is not authorized.
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1 INTRODUCTION

The National Oceanic & Atmospheric Administration (NOAA) is a bureau of the U.S.
Department of Commerce (DOC). The NOAA mission is to understand and predict changes in
the Earth’s environment and conserve and manage coastal and marine resources to meet our
Nation’s economic, social, and environmental needs. NOAA’s vision in supporting this mission
is that of an informed society that uses a comprehensive understanding of the role of the oceans,
coasts, and atmosphere in the global ecosystem to make the best social and economic decisions.

The Center for Operational Oceanographic Products and Services (CO-OPS) of the National
Ocean Service (NOS) is an organizational element of NOAA. We operate and maintain a
network of 210 long-term water level measurement stations as part of the National Water Level
Observation Network (NWLON) around the coastal United States and the Great Lakes. The
NWLON supports the following four NOAA Mission Goals:

» Healthy Oceans

* Climate Adaptation and Mitigation

» Weather Ready Nation

* Resilient Coastal Communities and Economies

CO-OPS also installs and operates short-term water level stations in support of programs such as:

* Hydrographic and Photogrammetric Surveys
» Marine Boundary Determinations

* Treaty Regulation

» Harbor Dredging

* Climate Change

» Long-Term Sea Level Rise

 Habitat Restoration

* Real Time Navigation

* NOS VDatum Program

The data collected and the products derived from these water level stations are used to:

e Ensure safe, efficient, and environmentally sound maritime commerce.

e Provide data and products required by the National Weather Service to meet storm surge
flood and tsunami warning responsibilities.

e Enhance navigation through a national network of Physical Oceanographic Real-Time
Systems (PORTS") in major U.S. harbors.

PORTS" is a partnering effort based on the collaboration between NOS and local maritime
communities to identify and satisfy user needs for improving the safety and efficiency of
maritime commerce and coastal resource management through the integration of real-time
environmental observations, forecasts, and other geospatial information. PORTS® comes in
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different sizes and configurations, each designed to meet local user requirements. PORTS®
includes sensors, hardware, and associated communications systems which allow the centralized,
real-time data acquisition and dissemination of water levels, currents, and other oceanographic
and meteorological data. The modular design of each PORTS® installation allows the straight
forward integration of additional sensors to meet user requirements.

In carrying out our mission, CO-OPS performs the following:

e Establishes the standards for the acquisition and processing of water level and current
data.

e Collects and documents user requirements that serve as the foundation for all resulting
program activities.

e Designs new and improved oceanographic observing systems; develops software to
improve data processing capabilities.

e Maintains and operates oceanographic observing systems; performs operational data
analysis and quality control.

e Produces and disseminates oceanographic products.

e Archives the resulting oceanographic data.

These Standing Project Instructions provide the recurring requirements for installation,
operation, maintenance, and removal of water level stations in support of the NWLON,
PORTS", Coastal Oceanographic Applications and Services of Tides and Lakes (COASTAL)
Program, hydrographic and photogrammetric survey operations, NOS VDatum and reimbursable
special projects. These stations provide critical data to support the following activities:

e Ensure safe navigation

e Determine flow rates to support International treaties

e Determine tidal datums for the National Nautical Charting Program and the National
Shoreline Mapping Program

e Determine the baseline from which marine boundaries are delineated

e National Weather Service tsunami and storm surge warning programs

e (oastal resource restoration and management

e Long term sea level trend analyses.

The objective of these Standing Project Instructions is to ensure that all the deployed systems
and sensors are maintained in an effective and consistent manner for collecting continuous,
reliable, and defect-free data.

1.1 General Data and Reference Datum Requirements

The NOAA Nautical Chart Reference Datum for tidal waters is Mean Lower Low Water
(MLLW) based on the latest NOAA National Tidal Datum Epoch (NTDE) of 1983-2001. The
NOAA shoreline reference datums are MLLW and Mean High Water (MHW). See
http://tidesandcurrents.noaa.gov/publications/glossary2.pdf for descriptions of all tidal datums.
All tidal datum computations and water level reductions for shoreline surveys shall be referenced
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to these datums.

In cases where historical sites are re-occupied, every effort shall be made to collect the new data
series on the historical Station Datum (SD). In that case, data can be acquired relative to MLLW
for immediate application during the survey. If the historical datum cannot be recovered, an
arbitrary SD shall be assigned to the Primary Bench Mark (PBM) and the MLLW datum
calculated after 30 to 60 days of water level data are collected.

In non-tidal areas, including the Great Lakes, special low water datums have been defined and
are used as chart datum in these locations. For the Great Lakes, a unique Low Water Datum
(LWD) for each lake based on the International Great Lakes Datum of 1985 (IGLD 85) is the
reference datum. In other non-tidal coastal areas, LWD is determined by subtracting 0.5 ft from
the Mean Water Level (MWL), as calculated from the water level data collected in these
locations.

Leveling and GPS connections to geodetic datums are made at each water level station, as
described in Section 3.6 Geodetic connections.

1.2 Reference Documents

The following reference documents are referred in various sections of the Standing Project
Instructions.

(1) “NGWLMS Site Design, Preparation, and Installation Manual (NGWLMS Manual),
January 1991".
(2) “Xpert DCP User’s Manual, October 2006”. (Latest updated version)

(3) “User’s Guide for the Installation of Bench Marks and Leveling Requirements for Water
Level Stations, October 1987”.

(4) “User's Guide For Electronic Levels with Translev and Windesc, Updated September
2010”.

(5) “User’s Guide for Writing Bench Mark Descriptions, Updated January 2011”.

(6) “User’s Guide for GPS Observations at Tide and Water Level Station Bench Marks,
Updated December 2009”.

(7) “CO-OPS GPS Observations Implementation Plan, January 2003”.

(8) “CO-OPS Specifications and Deliverables for Installation, Operation, and Removal of
Water Level Stations, November 2008”.

(9) “Barometer Calibration Guidelines, Updated November 2008”.
(10) “Sutron Accubar Barometer Field calibration Procedures, Updated February 2008”.
(11) “Wind Sensor Alignment Procedure for the R. M. Young Wind Sensors, October 2005”.
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(12)

(13)

(14)

(15)

(16)
(17)

(18)

(19)
(20)

21
(22)

(23)

(24)

(25)

(26)
27)
(28)

(29)

(30)

€2))
(32)

“Guidelines for Meteorological Sensors Siting and Meteorological Sensors Height
Measurements, Updated January 2011”.

“CO-0OPS Water level and Meteorological Site Reconnaissance Procedures, Updated May
2009”.

“User’s Guide for 8200 Acoustic Gauge (Installation and Operation), Updated August
1998”.

“User’s Guide for 8200 Bubbler Gauge (Installation and Operation), updated February
1998”.

“‘NGWLMS GOES MESSAGE FORMATTING, Phil Libraro January 2003”.

“Standards and Specifications for Geodetic Control Networks”, Federal Geodetic Control
Committee, September 1984”.

“Spatial Data Modifications and Enhancements, FY05 Functional Requirements
Document, August 2005”.

“Revised NGS 3 — Dimensional (3 — D) Rod Mark, National Geodetic Survey, July 1996”.
“NWLON/DMS Quality Control Software (QC): Functional Requirements Document”.
“NOS Hydrographic Surveys Specifications and Deliverables, April 2011”.

“Water Level Station Specifications and Deliverables for Shoreline Mapping Projects,
Updated May 2009”.

“Attachment R, Requirements for Digital Photographs of Survey Control, NGS, January
2008”.

“SOP-06-001 for Upgrading or Installing a New Water Level Station, Updated August
2007”.

“SOP-06-004 CO-OPS Evaluation Criteria for Water Level Station Documentation,
Updated October 2009”.

“Engineering Bulletin 07-006 Exporting Data from Xpert Family DCP”.
“E-Site Report Application User’s Guide”, December 29 2009.

“SOP 3.2.3.5 E(15) E-Site Report User Access to Build, Submit, Reject, Advance, and
Approve Steps”.

“Engineering Bulletin 07-007 Downloading (Exporting) Data from Xpert Log Files using
Xterm” October 15, 2007.

“Engineering Bulletin 08-001 Standardization of Xpert Log File Sizes” February 13, 2008.
“Engineering Bulletin 09-003 Update to Xpert Log File Sizes” November 13, 2009.

“SOP-3.2.3.5 E8 Procedures for Requesting GOES Platform ID Allocations, November 14,
2007
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2 REQUIREMENTS FOR RECONNAISSANCE, INSTALLATION,
OPERATION, MAINTENANCE, AND REMOVAL OF WATER LEVEL
STATIONS

The following sections point to the references strategic to the reconnaissance, installation,
operation, maintenance, and removal of water level and/or meteorological stations.

The term Installer has been defined as a person or field party that performs any of the following
tasks: reconnaissance, installation, maintenance, repair, or removal of a water level station. The
installer could be CO-OPS personnel, NOAA ship personnel, Office of Coast Survey (OCS)
Navigational Response Teams (NRT), other NOAA personnel, or contractors.

2.1 Reconnaissance

The reconnaissance of water level and meteorological stations shall be performed in accordance
with Reference 13.

2.2 Water Level Sensor Specifications

The following sections provide the sensors and specifications that are used at CO-OPS water
level stations.

2.2.1 Primary Water Level Sensor
The primary sensor used at a CO-OPS water level station is one of the following:

e Aquatrak™ self-calibrating air acoustic sensor

e Paroscientific pressure sensors tied into a single or dual orifice gas purged bubbler
system

e BEI Motion Systems absolute shaft angle encoder (SAE)

e Design Analysis Waterlog microwave in a limited capacity

Currently, the Aquatrak™ sensor is used at the majority of tidal water level stations as the
primary water level sensor. At stations where the acoustic sensor cannot be used due to the
freezing of the water’s surface or the lack of a suitable support structure, a single or dual
Paroscientific intelligent pressure sensor(s) is incorporated into a gas purged bubbler system. In
the Great Lakes, a sump with a float driven absolute shaft angle encoder is used. A microwave
air gap sensor is used in selected PORTS® projects. Starting this year, a microwave sensor will
be used in a limited capacity at low wave energy locations.

The sensor type will be determined after the reconnaissance of the site is completed, the final
station design is performed, and CO-OPS has approved the site and the type of sensors. CO-
OPS’ approval of the type of water level sensor is mandatory for a project.
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The sensor measurement range shall be greater than the expected range of water level and the

installation shall be designed to measure the full range of extreme water level such as highest

observed and lowest observed water level data (100 years, if available). The highest observed
may have an additional wave allowance value added as determined by ED.

Sensors are calibrated prior to deployment, and the calibration is checked following removal.
The calibration standard’s accuracy is traceable to the National Institute of Standards and
Technology (NIST).

For NWLON water level data, the water level sensor resolution is 1 mm or better. For
hydrographic and photogrammetry surveys the required water level sensor resolution is a
function of the tidal range of the area in which water level data is collected: when the tidal range
is less than or equal to 5 m, the required water level sensor resolution is 1 mm or better; when the
tidal range is between 5 m and 10 m, the required water level sensor resolution is 3 mm or better;
and when the tidal range is greater than 10 m, the required water level sensor resolution is 5 mm
or better.

Known error sources for each sensor are handled appropriately through ancillary measurements
and/or correction algorithms. Examples of such errors are water density variations for pressure
gauges, sound path air temperature differences for acoustic systems, and high frequency wave
action and high velocity currents for all sensor types. At a number of NWLON stations, dual
orifice gas purged orifices which are mounted a fixed vertical distance apart and connected to
two vented Paroscientific pressure transducers are used so that a density correction can be
estimated for each sample based on the pressure difference and gravity.

The orientation of the primary sensor shall be carefully documented in elevation (side) view
sketches and photographs, as required. Orientation of the protective well (or sump and intake in
the Great Lakes) relative to the wave or current modifiers such as nearby pilings, bulkheads, or
other structures in the water shall be photographed and documented. All features in the vicinity
of the protective well such as, pilings, other wells, decking, buildings (tide house), etc., which
might cause uneven sun/shading of the well and resulting non-uniformity of temperature inside
the well shall also be well photographed and documented.

The installer shall have all forms and figures submitted using metric units and referenced to the
SD as applicable. Other references (e.g. orifice zero or tide staff zero) shall also be shown on the
forms with reference to the SD.

2.2.2 Redundant Water Level Sensor

The redundant sensor used at a CO-OPS water level station is one of the following:

e IMO, Druck, or KPSI pressure sensor tied into a single gas purged bubbler system
e Waterlog relative shaft angle encoder (SAE)

Standing Project Instructions for Coastal and
Great Lakes Water Level Stations, Updated August 2011 Page 6



At tidal water level stations, the redundant water level bubbler orifices shall be secured
structurally independent of the primary water level sensors (i.e. on a separate piling, etc). At
Great Lakes stations, the Waterlog shaft angle encoder (SAE) shall be set to read the same as the
Electric Tape Gauge (ETG) and the primary SAE.

The cable lengths of all water level and ancillary sensors shall be noted in the E-Site Report, or
Xpert Site Report, or Tide Station Report to the nearest tenth of a meter (rounded up to the
nearest meter value). This will assist with the efficient replacement of cables should a failure
occur.

2.2.3 Tsunami Data Requirements

NWLON and other water level stations installed and supporting the NOAA Tsunami Program
shall have 1 minute averaged water level data available in addition to the 6 minute data. The 1
minute averaged data will be mainly coming from the primary sensor during the normal
operations. In addition, 15 second data from the redundant sensor shall also be made available in
the event of a tsunami, or as per the request of National Weather Service (NWS) Tsunami
Warning Centers, and the Pacific Marine Environmental Laboratory of NOAA’s Office of
Atmospheric Research (OAR).

The RAM pack and other storage devices may be appropriate for storing the 15 second data. The
sizes of the data files (minimum number of days data) for 6-minute water level data (ssp.log), 1
minute tsunami data (tsulmin.log), and system log data shall be collected according to
Engineering Bulletin 09-003 dated November 13, 2009. This Bulletin is available on the ROS
Wiki Page and can be made available for contractors on request, if applicable.

2.3 Data Collection Platform

The primary Data Collection Platform (DCP) shall acquire and store water level measurements
every 6 minutes. The water level measurements shall consist of an average of three minutes of
discrete water level samples with the period of the average centered about the six minute mark
(i.e. :00, :06, :12, etc.). In addition to the average measurement, the standard deviation of the
discrete water level samples and outliers which comprise the 6-minute measurements shall be
computed and stored. The 6-minute centered average water level data and the standard deviation
provide valuable data quality information regarding each measurement.

For NWLON stations, a redundant DCP shall also be installed so that in case of a failure of a
primary DCP or sensor, water level data from the redundant DCP or sensor can be retrieved. The
redundant DCP also shall acquire and store water level measurements every 6- minutes and the
water level measurements shall consist of an average of three minutes of discrete water level
samples with the period of the average centered about the six minute mark (i.e. :00, :06, :12, etc.).

The primary and redundant DCP, where applicable, shall have a capacity to store at least 30 days
of 6 minute water level data and meteorological sensor data, if applicable.
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2.4 GOES Satellite Transmissions

The ability to monitor water level measurement system performance for near real-time quality
assurance is essential for operations. Water level data transmitted via satellite in NOS format is
retrieved and monitored by CO-OPS, and in the case of data gaps, sensor, or gauge problems,
corrective actions are taken immediately. At all sites where access to the GOES satellite is
available, and according to CO-OPS policy, the measurement system shall be equipped with a
GOES transmitter to telemeter the data to NOS. This section is applicable where water level
gauges are installed by CO-OPS or CO-OPS’ contractors for NWLON, Tsunami, COASTAL,
VDatum, Special projects, and NOAA in-house survey projects. This section is not applicable for
NOAA contract hydrographic or photogrammetric projects.

The data transmissions shall use the message format detailed in Reference 16. This format is
currently implemented in the Next Generation Water Level Measurement Systems (NGWLMS),
assuring compatibility with the CO-OPS Data Management System (DMS).

The NOS Continuous Operational Real-Time Monitoring System (CORMS) is a 24 x 7 data
monitoring operation. It monitors all water level measurement system data transmitted via GOES
to assure the gauges are operating properly. Data that is not transmitted by GOES but is
submitted to CO-OPS via diskette, CD-ROM, or such other electronic media, must also conform
to the format specified in the above document so that data can be loaded properly into DMS.

The clock accuracy of a satellite radio system shall be adjusted with a GPS clock for NWLON
gauges. For a tide gauge that does not have a GPS clock, or that transmits hourly or three hourly,
the clock accuracy of a satellite radio system shall be within 5 seconds per month for short term
water level gauges so that adjacent satellite channel overlapping does not occur. Non-satellite
radio systems shall have a clock accuracy of better than one minute per month.

2.5 Data Transmission Initiation and Station Database Configuration
Requirements

The CO-OPS’ Engineering Division (ED) Operational Engineering Team (OET) maintains the
GOES platform ID list for all water level stations in the NWLON. For new NWLON stations,
once the location, type of sensors, and DCP are selected, OET assigns the platform ID and
provides the satellite configuration data for the deployment.

For other types of water level stations, such as subordinate stations installed for NOAA in-house
hydrographic or photogrammetric surveys, or meteorological (met) only stations, OET also
assigns platform IDs, as appropriate. This section pertains to water level stations installed by
NOAA ships, CO-OPS, or CO-OPS IDIQ contractors. This section is not applicable for contract
hydrographic and photogrammetry stations installed by OCS and NGS survey contractors.

OET will provide station numbers and platform ID assignments for equipment setup and testing
when the location, which consists of a local name, body of water, and latitude and longitude, of
the station is reported to OET. OET can be reached by telephone at 301-713-2897, fax: 301-713-
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4465 or 301-713-4435, or e-mail address at nos.coops.oetteam@noaa.gov. Requests for GOES
platform IDs shall be submitted to OET at least 15 days before throughput testing to allow
sufficient time to receive radio frequency assignments. Refer to Reference 32 for procedures on
requesting a platform ID.

Critical Information required Prior to the installation of a station and initiation of GOES
for water level station database | data transmissions from the field, critical information that

configuration at CO-OPS is needed for database configuration shall be emailed or

Database Management faxed to OET. See the figure at left for the critical

System (DMS): information required for station database configuration in
the CO-OPS DMS. Test transmissions monitored by the

(1) Station Number and Name installer during the field unit installation may be

(2) Installation Date conducted outside this requirement.

(3) Latitude/longitude

(4) Platform ID, transmit time,

channel

(5) Serial numbers of all DCPs,
and sensors.

(6) Level abstract

(7) Sensor offset C1 (SNS) and
Datum Offset C2 (DAT) as
entered in the DCP for acoustic
sensor; and orifice offset(s) for
pressure sensors.

This station information must be configured in DMS for data to be accepted in DMS. Whenever
possible, within 24 hours after reporting the above basic information and before the complete
inspection package is submitted, the draft E-Site Report (or Xpert Site Report or Tide Station
Report) shall be forwarded to OET. This is called the one-day draft E-Site Report submission
requirement and its purpose is to:

1) Standardize the requirements for all of CO-OPS’ field efforts;

2) Provide feedback by OET to the Installer while at the site, so that critical information is
verified; and

3) Insure that timely corrective actions and required maintenance actions as described in the
station specific Project Instructions can be accomplished by the Installer while at the site.

Generally, OET will respond back to the Installer or provide feedback within 24 hours or earlier
during normal business hours during the work week. This requirement applies to all types of
water level stations and all types of sensors for every type of maintenance - installation, regular
scheduled maintenance, emergency maintenance and removal of a water level station, where CO-
OPS is expected to receive and/or process the data.
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CO-OPS has developed a web-based electronic site report (E-Site Report) that interacts with
DMS. Refer to Reference 27 and 28 for the User’s Guide and the SOP for using the E-Site
report.

The effective starting date of all operational sensor data series is the date and time when the data
is first received after the DMS configuration. It is the responsibility of the installer to ensure that
the required documentation is provided to OET prior to the date when the operational sensor data
are needed.

For the installation of the primary sensor, a leveling connection shall be made between the
Primary Bench Mark (PBM) and the sensor zero for the purpose of determining the sensor zero
height with respect to the SD. For the acoustic sensor, the sensor zero is the Aquatrak™ Leveling
Point (AQLP), which is the top edge of the collar on which the Aquatrak sensor rests. On the
ETG, the sensor zero is the ETG reading reference mark, also known as the ZETG, Zero of
Electric Tape Gauge. The Paroscientific pressure sensor zero is the vertex of the V-notch in the
side of the orifice, or the bottom of the top parallel plate. To make a leveling connection to this
sensor zero, a rod stop called the orifice staff stop - that can be leveled as part of the leveling run
- is installed at a point above the sensor zero and a calibrated steel tape measurement is made
between the sensor zero and the orifice staff stop. Using the height obtained for sensor zero with
respect to the SD, the datum offset (also known as Coefficient C2 or DAT), or the orifice offset
shall be calculated.

The field crew shall then submit the E-Site report, Xpert site report, or Tide Station report via
email or fax. Include a copy of the level abstract (and water level transfer form for Great Lakes
stations) to OET in addition to a phone call to OET so that sensor parameters can be properly
setup in DMS prior to the beginning of the accepted data collection.

The Installer shall contact OET (contact information is provided above at the beginning of the
section) and CORMS at telephone 301-713-2540, fax 301-713-4392, or e-mail corms@noaa.gov

a) Before performing any maintenance at a station
b) After the maintenance is completed

c) When a station is installed

d) When a station is removed.

The above procedure must be followed. If this procedure is not followed in timely fashion prior
to beginning of data transmission, data losses may occur. When the station sensors are properly
configured in DMS, the data is accessible through the CO-OPS’ web site at
http://tidesandcurrents.noaa.gov.

Changes to the satellite platform ID, or the DCP telephone number, shall be reported to OET and
the supporting Field Operations Division (FOD) office immediately via telephone, email, or fax.

The Installer/tester shall follow the appropriate throughput testing requirements as described in
Reference 24.
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2.6 Station Installation

The installation of water level station DCPs and sensors shall be accomplished according to
Reference 1, Reference 2, and the manufacturer’s instructions, as applicable. Nearly all of the
NWLON stations have the Sutron Xpert System (Xpert DCP and Xpert Dark as redundant DCP)
installed as of February 2011.

All new station installations, excepting short-term hydro/photo stations, shall undergo an
engineering design review in accordance with Section 3 of the ROS. FOD and NWLON O&M
contractor engineering design packages for station upgrades and installations shall be reviewed
and approved by the CO-OPS Field Engineering Review Subcommittee before any work actually
begins on the site. The installer shall obtain all required permits and permissions using CO-OPS
approved agreement templates for the installation of the water level sensor(s), DCPs, bench
marks, and utilities, as required and provide copies of signed agreements, permits, and
permissions to ED and the supporting FOD office as part of the design review process. A
complete reconnaissance report and station design heights shall also be submitted. The installer
shall be responsible for security and/or protective measures, as required, for protecting the
government furnished equipment and facility while installing, maintaining or removing a water
level station.

The water level station and its various components (tide house, Data Collection Platform, all
sensors, meteorological tower, bench marks, and pertinent access facilities such as railings, steps,
etc., as appropriate), when designed or installed by contractors, shall be installed and maintained
as prescribed by manufacturers installation manuals, appropriate local building codes, or as
specified by the Contracting Officer’s Technical Representative (COTR), if applicable. The
water level station and all installed components shall be structurally sound for its intended
application, secure, and safe to use for NOS, local partners, and general public, as appropriate.

The installer must provide CO-OPS with the GPS position, as noted below in Section 2.9, of all
tide gauges and sensors installed before data collection begins, including those that were not
specified in the Statement of Work. In cases where gauge location(s) needs to be different than
that specified in the Statement of Work, installer shall consult with CO-OPS prior to the
installation.

Digital photographs of water level station components (station, DCP, sensors, well, supporting
structure, equipment, and bench marks) shall be taken and submitted. GPS photos shall be taken
according to Reference 6.

A minimum of four photos for each bench mark shall be taken: close-up of the disk face; chest or
waist level view of disk and setting; and horizontal views of the location of the bench mark from
two different (perpendicular) cardinal directions. Photos shall also be taken of station
components such as protective wells, staffs, houses, shelters, met towers, DCPs, sensors, etc.
One general location photo shall be taken showing the water level station in relationship to its
supporting structure and the local body of water. All digital photographs shall be submitted in
JPEG format. All digital station photo files should be named such that the name of the file will
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indicate the station number and the type of photo taken. For example, the acoustic sensor photo
for DCP1 at Los Angeles shall be named as 94106601 sensor Al.jpg.

The station components and bench mark photographs are required when a new station is
installed. The bench mark photographs shall be updated whenever any changes are noticed, such
as damaged bench mark disk, or changes to settings, etc, or as requested in the station specific
requirements.

All digital station bench mark photo files should be named such that the name of the file will
indicate the station number, dash, PID number (if available), dash, stamping or designation,
dash, photo type, dash, date, dot.jpg. For a new mark, the PID is not applicable as it is
unavailable. A close-up photo showing the face and stamping of the bench mark is photo type 1,
an eye level photo showing the bench mark and its setting is photo type 2, and a horizontal view
of the bench mark showing nearby landmarks is photo type 3. For photo type 3 include the
cardinal direction (N, NE, S, SE, etc) that the camera is pointing. If more than one type of photo
is taken for a given view, then re-name them as 1A, 1B, 2A, 2B, 3A, 3B, etc. IfaPID is
available, then use the designation instead of the stamping for the naming of the file. Use a
maximum of 30 alpha numeric characters to the left of the dot. If you are exceeding 30 alpha
numeric characters in the name, then truncate the stamping or designation so that the maximum
number of characters in the name are 30 (including spaces and hyphens). For example, the bench
mark E close-up photo for the Seattle water level station should be named as 9447130-
7130E1990-1-20090101.jpg.

Sample file names for photo files:

Disk face photo of a new bench mark without a | 9414290-4290A2008-1-20090101.jpg
PID

Eye level view photo of an existing bench 9410660-DY2512-BM N-2-20090101.jpg
mark with a PID

North direction photo of an existing bench 9447130-7130E1990-3N-20090101 .jpg
mark without a PID

In addition, place a caption on each photograph, indicating the stamping or designation of the
mark, the PID, the photo type with cardinal direction, and the date of photograph taken. The
Windesc program for electronic leveling has a function to assist with the photo caption.

The above naming convention for the bench mark photo files shall be applicable for all of CO-
OPS’ work and OCS hydrographic surveys. For NGS Shoreline mapping projects, contractors
shall follow the NGS specifications for file naming of bench mark photos.

NGS Coastal Mapping Surveys require a slightly different file naming convention as described
in Attachment R of the NGS Specs which is located at
http://www.ngs.noaa.gov/ContractingOpportunities/SOW_Main_Text VI13B new.pdf. All
photos collected for NGS Coastal Mapping Surveys for both contract and in-house projects shall
be named according to NGS convention.
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A completed water level measurement station installation consists of the following:

e) The installation of the water level measurement system (water level sensor(s), primary
and redundant DCP as appropriate, satellite transmitter, ancillary sensors if applicable,
other equipment as necessary and its supporting structure, and a staff (if required), as
specified in the Annual Station Specific Requirements, or as specified in the contract
documents.

f) The recovery and/or installation of the required minimum number of bench marks and a
level connection between the bench marks, Primary Bench Mark (PBM), and the water
level sensor(s), or tide staff as appropriate. The minimum number of bench marks or
specific marks to be leveled will be specified in the Annual Station Specific
Requirements, contract documents, or as specified in Reference 3 (See section 3.3 Levels
for additional leveling requirements).

g) The collection of GPS observations, a minimum four hour session, on one bench mark,
and submission of the data through OPUS DB for publishing.

h) Validation by CO-OPS of complete data transmissions, and proper data ingestion into
DMS, as evidenced by the data display on the CO-OPS website.

1) The preparation of all documentation and data and submission to CO-OPS (ED and
supporting FOD field office) in a timely fashion (refer to Section 4 for requirements for
timelines, documentation, and points of contacts).

The installer shall follow the appropriate sections of the SOP-06-001 as referenced in the
Reference 24.

2.7 Station Maintenance Requirements

Water level station standard annual maintenance shall be accomplished in accordance with the
Appendix F of Reference 1, and the most recent version of the Al checklist, or as instructed by
the Contracting Officer’s Representative (COR), or by the Task Manager (TM). A PDF file or
digitally scanned copy of the completed Al checklist shall be submitted for each station annual
inspection. The specific maintenance requirements for each water level station will be specified
in the Annual Station Specific Requirements for individual task orders for contracts.

CO-OPS shall monitor the near-real time water level gauge data daily for indications of sensor
malfunction or failure, and for degraded or invalid data, when the data is disseminated via GOES
telemetry using the NOS satellite message format. This includes data from CO-OPS NWLON
stations, and stations supporting hydrographic and photogrammetric surveys where CO-OPS or
CO-OPS contractors, Navigational Response Teams (NRT), or NOAA Ships install the
subordinate water level gauges. CO-OPS shall not monitor the subordinate stations installed for
NOAA contract hydrographic/photogrammetric survey projects by NOAA contractors.
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This monitoring can be performed by accessing the CO-OPS web page
(http://tidesandcurrents.noaa.gov). The data over the web are typically available for review
within one to four hours after the configuration of the DCP and sensors in DMS during the
normal business hours, after the installations of the DCPs and sensors in the field, and once data
is reviewed and dissemination is turned on by CORMS.

During annual maintenance visits to a station that has an acoustic sensor, the Aquatrak™ sensor
and matching cal tube shall be replaced. For stations where wind sensors are installed, wind
sensor nose cones shall be replaced during the annual maintenance. The Ultrasonic wind sensor
leads (if in question) shall be cleaned with a contact cleaner with a zero residue base. All
applicable sensor serial numbers (inside the tide or gauge house) shall be verified by the installer
(recorded by one person and confirmed by a second person in the field party). Safety of
personnel is of utmost importance and safety gear as necessary shall be used while climbing the
towers, etc, when required. Most of the serial numbers of the DCP boards and sensors are
generally recorded and verified during the installation, and only when equipment is replaced
during the maintenance, then the re-verification of the serial numbers is required.

Necessary repairs or alterations to the stations and equipment shall be made and documented on
the approved E-Site Report, Xpert Site Report, or Tide Station Report.

Repairs or alterations required by the Standing Project Instructions or the Annual Station
Specific Requirements, but not completed, shall be documented, along with the reasons for the
incompletion, on the approved E-Site Report, Xpert Site Report, or Tide Station Report. Each
field party crew chief shall provide a draft E-Site report, Xpert Site Report, or Tide Station
Report wherever possible, within one day of completion of maintenance and leveling operations
to OET.

The report(s) shall be completed by the installer before leaving each station; and reviewed by the
field team leader or contractor supervisor after completion of the maintenance visit but prior to
submission. The reviewed station package shall then be submitted to ED and the supporting FOD
field office within 1 month after the completion of the maintenance, or as specified in the
contract documents.

A minimum of 30 days of 6 minute water level data and 15 days of 1 minute tsunami water level
data shall be downloaded during each maintenance trip for NWLON stations and the data shall
be forwarded to OET as described in Section 4.2.2 Documentation Requirements. Engineering
Bulletin # 07-007 “Downloading (Exporting) Data from the Xpert Log Files using Xterm”
provides information regarding how to download the data from Xpert DCP.

Sizes of the Xpert Log Files (ssp.log, tsulmin.log, and System.log) shall be configured according
to the Engineering Bulletin 09-003 “Update to Xpert Log File Sizes”.

Approved primer and anti-fouling paint shall be used on all new protective wells and all
protective fiberglass/PVC components that will be in water, excluding the acoustic sensor
calibration/sounding tube.
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For dual orifice pressure sensor configurations, the vertical stability and elevation to the leveling
points from each orifice shall be verified, including the distance between the two orifices. To do
so measure the elevation of each orifice to the staff-stop using a steel tape graduated in
millimeters. Two independent readings shall be taken and they should not vary more than 3 mm,
then report the average of the two readings. If the two readings vary more than 3 mm, then take
additional readings until two readings are obtained within 3 mm. The mounting assembly for the
two orifices shall be checked for structural integrity and the orifices shall be cleaned of
biofouling.

When first arriving at a station to perform annual maintenance, check and record the voltage for
each battery on all DCP units. Then remove AC power to both the Primary and Redundant
systems allowing them to run totally on battery power. After the units have had approximately an
hour of transmit loads on the Xpert DCP and at least 2 hours for the 9000 DCP, recheck the
voltage. If the battery voltage has dropped significantly (i.e. below 11.7 volts), replace it. Also
write the date of installation with permanent marker on each battery, and record this date on the
site report. Check all marine grade batteries to ensure that adequate water is in each cell. Use
only distilled water for replacement.

A new battery shall be replaced every four years during the maintenance trip for the NWLON
stations, where practical, or make arrangements to replace it at another time. The condition of a
newly installed battery shall be checked using the procedure described in the above paragraph
during the 2" or 31 year maintenance trip, and if the battery condition passes the test described
above then replace the battery during the 4™ year after the installation. Of course, if a battery
does not pass the condition test as described above, then it shall be replaced immediately during
that trip and the date of replacement shall be duly noted on the approved E-Site Report (or Xpert
Site Report or Tide Station Report, if applicable).

All repairs, adjustments, replacements, cleaning, or other actions potentially affecting sensor
output or collection of data shall be documented in writing using appropriate approved
maintenance forms (refer to Section 5 for requirements for deliverables for water level station
documentation and timelines) and retained as part of the water level data record. This
documentation shall include, but not be limited to, the following information: date and time
(GMT) of the beginning and the end of the maintenance activity; date and time of adjustments of
the sensors; changes in the configuration of the DCP - such as a new datum or sensor offset, or
setting the time; personnel conducting the work; parts or components replaced; component serial
numbers; tests performed and test results; etc.

Proper NOAA identification emblems with an emergency phone number 1 (800)367-6622 shall
be placed on all water level gauge house doors or shelters. Emblems which are unreadable
should be replaced.
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A completed station visit for maintenance (scheduled or emergency) consists of the following:

a) The maintenance or repair of the water level measurement system (water level sensor(s),
primary and redundant DCP as appropriate, satellite transmitter, ancillary sensors if
applicable, other equipment as necessary and its supporting structure, and a staff if
applicable), and as specified here in the Standing Project Instructions, the Annual Station
Specific Requirements, or as specified in the contract documents.

b) For scheduled maintenance, the recovery and/or installation of the required minimum
number of bench marks and a level connection between the bench marks, PBM, and the
water level sensor(s), or tide staff is required. The minimum number of bench marks or
specific marks to be leveled will be specified in the Annual Station Specific
Requirements, contract documents, or as specified in Reference 3 (See Section 3.3 Levels
for additional leveling requirements.)

For emergency maintenance, recovery of bench marks and levels are generally not
required, unless the maintenance is done which may affect the elevation of the AQLP, or
orifice(s) for pressure sensor(s), in which case leveling, to the PBM and at least 2 other
marks, is required.

Only for scheduled maintenance, GPS observations on one of the bench marks as
specified in the Annual Station Specific Requirements, or as specified in the contract
documents, may be required.

c) CO-OPS verification of complete data transmission throughput following maintenance,
from station to DMS ingestion.

d) The preparation and submission of all documentation and data to ED and the supporting
FOD field office in a timely fashion (refer to Section 4 for requirements for timelines,
documentation, and points of contacts).

The maintenance party shall follow the appropriate sections of the SOP-06-001 as referenced in
the Reference 24.

2.7.1 Additional Requirements for NOAA Sentinels

NOAA Sentinels are water level observing stations which have been strengthened to deliver real-
time storm tide data during severe coastal events. Elevated atop substantial single pile platforms,
these stations are specifically designed to withstand category four hurricanes. NOAA Sentinels
measure and disseminate real-time water level and meteorological observations. All of this
information helps coastal authorities prepare for, mitigate, and respond to storm tides generated
by severe coastal storms.
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The following are the additional maintenance requirements for the NOAA Sentinel stations
currently installed in the Gulf of Mexico:

Every Year:

Examine the anode and the anode attachment points. Inspect the attachment points for
excess corrosion and inability to remove fasteners. Provide measurements of the smallest
cross sectional area of the anode. Provide underwater photos of the anode and close-ups
of any excessive anode shrinkage or attachment point corrosion.

Every 2 years:

Inspect all painted surfaces for rust. Document significant rust areas in the Excel or E-
Site station report and provide photos of the occurrences. The repair of significant rust
areas shall be added to the following year’s project instructions along with procedures for
coating repair.

Inspect all galvanized surfaces for rust. Document significant rust areas in the Excel or E-
Site station report and provide photos of the occurrences. Repair spot rust with a wire

brush and cold galvanizing.

Inspect all welds for rust and cracks. Provide photos and document excessive rust and
cracks.

Check all fasteners on the protective well clamps, including half moon clamps, adjustable
arms, and attachment to clamp brackets. Tighten if loose.

Check the fasteners holding the solar panel mount to the railing. Tighten if loose.
Check all fasteners holding the enclosure to the support stand and the stand to the deck
grating. Also check the bracketing system along the upper portion of the enclosure.
Tighten if loose.

Check all fasteners on the Rohn tower. Tighten if loose.

Examine the underside of the high platform. Inspect the high platform bridge bolts for
looseness and rust. Document and tighten any loose bolts.

Examine the galvanized conduit for rust and cracks. Check also for water in the conduit
entering the bottom of the enclosure.

Examine the solar panel and Rohn tower flexible conduits for cracks and loose
fitting/tubing connections.

Grease the davit and winch. Examine for corrosion.
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Every 5 Years:
e Replace the battery pack in the Aid to Navigation light
2.7.2 Additional Requirements for Great Lakes Stations

e The shaft angle encoders shall be inspected to insure the offset pulleys are not binding.
Lift the float tape off of the offset pulley and free spin the unit. If any binding occurs,
replace the bearing in the center of the gear. In addition and while the float tape is off of
the encoder gear and pulley, spin the encoder shaft to represent both a 2 meter increase
and a 2 meter decrease in the readings from the present reading. Then match the reading
with the ETG reference and reset the tape back on the gear and pulley. After this process,
remember to check the tape at the float connection to ensure that it has not kinked. This
rotation procedure will ensure that the oil lubrication around the enclosed encoder
bearings remains fluid. NOTE: - This test should only be performed during the time
period that the DCP is not calculating the water level reading. This time period, for
computing the water level reading, is 90 seconds before and after the allotted 6 minute
interval. Also check to see that the float tape length has been installed such that the float
neither tops out nor the counterweight bottom out before reaching its extreme limitations.

e The float shall be inspected for corrosion and leaks; replace as necessary.

e When closing off the intake valve note how many turns it takes to close off the intake as
well as how many turns it takes to fully open it. This shall be reported in the remarks on
the inspection sheet and on a tag placed on the valve handle. Also note the difficulty in
turning the valve such that it can be predicted when the valve would become unusable
and need replacement.

e A water level transfer (inside/outside check) shall be performed at each station and
documented on the Site Report. The inside/outside water level must agree to within 0.006
m. The best time to perform a transfer is in the early morning or late evening when the
water level is most calm. The above procedure must be followed and actions taken to
correct any discrepancies.

e When diving at gauge sites measure and report the elevation of intake invert and valve
invert on IGLD 85, if not previously noted. NOTE: The invert elevation is the point
where the water level can no longer be measured accurately. If the intake has a gooseneck
at the end this measurement should be taken at the lowest point in the curve at the top of
the gooseneck, not the opening.

¢ Install rubber flaps over all locks on gauge shelters for protection against the weather.
The locks shall be inspected and lubricated to enable easy access.
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e Check gauge houses inside, outside, and around the doorframe for openings in the mortar
and caulk as required. Submit a statement of work to FOD for any work recommended
for completion by a contractor.

e Check gauge house structure, door, and frame for rust and paint chips. Scrape and paint
as necessary.

2.8 Ancillary Sensor Metadata
The meteorological sensor site selection and measurement guidelines are listed in Reference 12.

Specific metadata for ancillary sensors is required as detailed below. The installer shall make
note of this data in the remarks section of the Ancillary Sensor boxes on the approved Site
Report or E-Site report. Metadata documentation shall be completed during the annual
inspections, or emergency maintenance visits, as appropriate, for all stations with ancillary
sensors. A unique Temporary Bench Mark (TBM) may be selected at each station and all the
required measurements can be referenced to that TBM. The TBM must be connected via levels
to the PBM. Then ED will relate the sensor elevations to SD and other datums as appropriate.

Photos shall be taken of the supporting structure and all of the ancillary sensors installed. The
photos should include as many of the four cardinal compass directions as possible, with the file
name indicating the direction of the view, i.e. 87617241 Met tower looking south.jpg. Photos and
sensor elevations must be submitted by CO-OPS to the National Data Buoy Center (NDBC) in a
timely manner before NDBC will accept the met data into its quality control process. Annual
photos of the met mast and ancillary sensors are not required once the sensors have been
installed. Wind sensors shall be aligned according to Reference 11.

Ancillary Sensor Sensor Elevation Reference Point

Air temperature Center of the sensor above the station datum and above ground to the
nearest +/- 15 centimeter.

Water temperature Center of the sensor above the station datum as derived from subtracting
the distance from the leveling point to the center of the sensor from the
C2 value, to the nearest centimeter.

Barometric pressure Surface of the pressure port above MSL (see Barometer Calibration
Guidelines) to the nearest +/- 15 centimeter.

Wind Center of the sensor above the station datum and above ground to the
Speed/Direction/Gust nearest +/- 15 centimeter. Note any major physical obstructions in the
vicinity of the sensor.

Conductivity Center of the loop above the station datum to the nearest centimeter.

Relative humidity Center of the sensor above the station datum and above the pier/ground
surface to the nearest centimeter.
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Air gap Sensor zero above the station datum as determined from trigonometric
levels to the nearest centimeter.

2.9 Obtaining and Recording Positions of Stations, DCP, Sensors, and Bench
Marks Using a Hand-Held GPS Receiver

Latitude and longitude of the station, DCP, all sensors, and bench marks shall be recorded using
a hand-held GPS receiver and recorded as degrees, minutes, seconds, and tenth of seconds (e.g.
45 degrees, 34 minutes, 32.6 seconds). The positions of the primary and backup DCP and all
sensors that are installed in a tide house (gauge house) shall be recorded as that of a station. This
position will be obtained in front of the tide house (gauge house) at the center of the front
door/front wall of the tide house (gauge house). The front portion of the roof of the tide house
(gauge house) may also be used as applicable if the GPS satellites are blocked from the structure.
For a standalone DCP or met sensors that are 3 m (10 ft) or greater from the station, obtain
positions and report appropriately on the Site Report.

For barometers which are generally installed in the tide house, report the latitude and longitude
as that of the station, but report the elevation above station datum as obtained from the leveling.

For Aquatrak sensors or Paroscientific sensors that are installed 3 m (10 ft) or greater from the
station location, obtain the positions of the sensors at the center of the sensor. If the Aquatrak
sensor or Paroscientific sensor is installed inside a tide house (gauge house), then report the
latitude and longitude as that of the station, but report the elevation above station datum.

For bench marks, obtain positions using the hand-held GPS receiver by placing the receiver on
the (horizontal) bench mark. For bench marks that are installed vertically, obtain the position as
close to the mark as satellite coverage will allow.

Handheld GPS units come with either patch antennas or quadrifilar antennas. The proper method
for holding the GPS unit is vertically if the unit has a quadrifilar antenna, or horizontally if the
unit has a patch antenna. Holding the unit otherwise will degrade the reception of the satellite
signals and reduce the accuracy of the position obtained. The Garmin GPSmap 76S units used by
CO-OPS have quadrifilar antennas.

Take a digital photo of the GPS unit display for each location acquired. This will insure
verification of the latitude and longitude that is entered into the Excel and E-Site reports.

2.10 Gauge Removal

The installer shall remove a water level station, if required, and as specified in the Annual
Station Specific Requirements, or as specified in the contract documents. A complete removal of
the water level measurement station consists of the following:

a) Closing levels - a level connection between the PBM and all the bench marks in the local
leveling network at the station, the water level sensor(s), and/or staff, if applicable.
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b) Removal of the water level measurement system and restoration of the premises,
assuming reasonable wear and tear. The property owner shall be notified prior to removal
and thanked for supporting our programs.

c) Generally, GPS observations on one bench mark are done during the installation for short
term stations. If GPS observations are not done during the installation phase, and GPS
observations are required, then GPS observations shall be done during the gauge removal
time. Generally, GPS observations are required only one time for short term stations. For
NWLON and long term stations, the frequency of the GPS observations is determined by
the rate of sea level change at the station and if the GPS observations are required for a
specific year, those will be listed in the station specific project instructions.

d) The preparation of all documentation and data and submission to CO-OPS (ED and
supporting FOD field office) in a timely fashion (refer to Section 4 for requirements for
timelines, documentation, and points of contacts).

e) Return of all government equipment to appropriate supporting CO-OPS’ FOD field
office(s) in timely fashion within 15 days of station removal.
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3 BENCH MARKS AND LEVELS

3.1 Reference Documents

Bench marks and level operations shall be performed in accordance with Reference 3.

CO-OPS electronic/barcode level operations shall be performed in accordance with Reference 31
and the Leica Manual for the DNAO3 level. Help files for the TOPCON and Trimble level
instruments can be found in the Windesc and Translev programs available from NGS.

Bench mark descriptions shall be written in accordance with Appendix E of Reference 4 for
bench marks that are connected using the electronic levels. Descriptions for Great Lakes bench
marks shall be written in accordance with the NGS Bluebook, Formats and Specifications of the
National Geodetic Survey Data Base http://www.ngs.noaa.gov/FGCS/BlueBook/, since those
marks are not published by CO-OPS.

Bench mark descriptions shall be written in accordance with Reference 5 for bench marks that
are connected using the optical levels, where electronic levels are not used, or as specified in the
contract documents.

3.2 Bench Marks

Unless specified otherwise in the work order or contract documents, the total number of bench
marks in the leveling network shall be a minimum of ten marks for the NWLON stations and a
minimum of five marks for subordinate stations installed for hydrographic and photogrammetry
surveys, special projects, or contract projects for U. S. Army Corps of Engineers, unless
otherwise directed by ED.

Descriptions shall be checked by verifying distances with tape measurements in metric units,
verifying cited landmarks and using a compass to confirm directions.

The handheld GPS coordinates of each mark shall be entered in the description file for electronic
levels, or noted on the published bench mark sheet or equivalent (for optical levels). The latitude
and longitude fields of the bench mark shall be reported in the following format:
degrees/minutes/seconds and tenths of seconds. For example, 40 degrees, 45 minutes, 35.2
seconds.

New bench mark sketches shall use CO-OPS’ standard bench mark sketch title block, or
electronic equivalent. If a digital sketch is used, submit the digital file in JPG format with the
leveling files and photos. If AutoCAD or AutoCAD LT is used to generate the benchmark
sketch, both a JPG format and the AutoCAD DWG format shall be submitted. Submission of
updated bench mark sketches are required only when necessary to document newly established
marks or physical changes in the area.

CO-OPS has photos of nearly all bench mark disk faces, setting, and location shots of NWLON
and active subordinate station tidal bench marks. The station specific requirements shall note any
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additional photos needed to achieve a complete photo gallery of each mark.

If a bench mark is discovered disturbed or mutilated during the visit to a station, include it in the
level run to determine if it is holding its elevation relative to the PBM and report it to ED and the
supporting FOD field office. ED will make a decision and inform the installer via the next set of
Station Specific Requirements regarding the action that needs to be taken: destroying the mark, if
it is a NOS mark, or dropping the mark from the leveling network for other marks. If the PBM
has been disturbed, contact ED immediately for further direction.

Before installing a new mark, perform a 1.6 kilometer (1 mile) radial search from the tide station
(DCP) location at NGS web site, http://www.ngs.noaa.gov/datasheet.html to check if any NAVD
88 marks are available that are not part of the local leveling network. Inclusion in the local
leveling network of an existing mark(s) that has a NAVDS88 elevation, if it is located within a 1.6
KM (1 mile) leveling distance of the station location, is desirable and shall be preferred over
installing a new mark. If the bench mark is replaced, then the stamping of the bench mark shall
have a new letter designation (assigned by ED) and present year so that the new stamping is
different from the original stamping of the mark, or the stamping of other marks in the local
leveling network.

Digital photographs of bench marks shall be taken as described in Section 2.7 Station
Installation.

3.3 Levels

All leveling shall be performed with electronic/barcode systems, to either Second Order, Class I
or Third Order standards, in accordance with National Geodetic Survey (NGS) standards for
geodetic leveling, and CO-OPS "User’s Guide for the Installation of Benchmarks and Leveling
Requirements for Water Level Recording Stations, NOAA/NOS October 1987”. Beginning in
calendar year 2010, all CO-OPS and contractor field crews are required to use the NGS Windesc
description and Translev leveling software. Refer to the “User's Guide for Electronic Levels with
Translev and Windesc, Updated September 2010”

If digital bar-code leveling systems are to be used, the model should have been previously
evaluated by the Federal Geodetic Control Subcommittee (FGCS). These systems include the
Leica NA3003, Leica DNAO3, Topcon DL101C, Trimble DiNi 12, Zeiss DiNi 10, DiNi 11, DiNi
12 and DiNi 12T. Bench mark descriptions and leveling output must be in a NGS-supported
format to enable processing and adjustment of the levels by NGS. Station bench mark
descriptions and recovery notes shall be submitted in computer-readable form using WinDesc
software. The basic WinDesc usage instructions are built into the program. You simply go under
the HELP menu when you run WinDesc. Field book and field abstract software are required and
are dependent on the leveling equipment used for this project. Translev is a NGS program that
facilitates the process of editing, formatting and checking digital leveling observation data and
creates abstracts, bok files, and VERTOBS datasets for submission to the National Geodetic
Survey (NGS). WinDesc and Translev are the two programs currently being used by CO-OPS to

Standing Project Instructions for Coastal and
Great Lakes Water Level Stations, Updated August 2011 Page 23



submit leveling data to NGS. NGS training is available if needed. These NGS programs are
available online at http://www.ngs.noaa.gov/PC_PROD/pc_prod.shtml.

CO-OPS will provide appropriate training to contractors in the use of the Windesc and Translev
software for leveling operations,

Second-order Class I leveling connections shall be made from the primary water level sensor
(AQLP or pressure sensor orifice [staff stop], and in the Great Lakes the ETG RM and the Spike
RM) to a minimum of 5 bench marks on an annual basis, including the primary bench mark
(PBM). In the case of pressure sensors as primary sensors, the elevation of orifice zero to orifice
staff stop(s) shall be measured annually using a calibrated steel tape with millimeter graduations,
and elevation of the orifice staff stop(s) to PBM shall be determined using the conventional
leveling equipment.

As described in the “User’s Guide for the Installation of Bench Marks and Leveling
Requirements for Water Level Stations, October 1987 Section 3.3, Page 18, the levels are
required and shall be performed for seven cases listed. Particular emphasis is placed on
performing the check levels as per the specific project requirements or no later than 6 months
after the establishment of a new water level station. This is required for declaring a newly
installed water level station operational.

All of the bench marks in the leveling scheme shall be leveled within a two year period. This
may be accomplished by leveling to the PBM and four marks one year, then to the PBM and the
remaining marks the next year. In some cases, it may be practical to level to all the marks the
second year to reach the furthest marks from the station. A level connection to CORS reference
marks shall also be made once every two years, if those marks are within 1.6 KM (1 mile)
leveling distance from the water level station. The installer shall be responsible for ensuring that
every mark in the station bench mark network is leveled once every two years.

The two or three meter barcode rods for second order levels shall be used whenever possible at
all stations. At stations where three/two meter level rods cannot be utilized due to airline size
restrictions, justification for use of the Third Order barcode rods and levels shall be documented
on the NGWLMS Site Report. For stations in AK, HI, and Pacific Island areas the Second order
class I leveling requirement is waived and the Third Order levels are acceptable.

The primary water level sensor (ETG in the Great Lakes) shall be connected to the station bench
marks by levels. The levels shall be run upon sensor installation, in conjunction with annual
maintenance levels, if obvious sensor movement is noticed during regular/emergency
maintenance, and upon sensor removal. The levels to the sensor(s) shall be spur runs from any
bench mark, it is not necessary to have the spur run directly from the PBM to the sensor(s). If the
leveling starts at the sensor then it is not considered a spur run.

At Great Lakes sites where a spike is unavailable for use in performing a water transfer, (see
section 3.1, standing project instructions for a description of procedures to perform water
transfers), the water level in the sump shall be compared to the water surface outside the sump by
differential leveling and the use of the water level transfer program (h2o-tran). A difference
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exceeding 0.006 meters indicates a possible restriction in flow, which must be corrected. This
instruction must be recognized and initialed. Note: this procedure can best be accomplished in
early morning or late evening when the water is most likely to be calm.

When abstracting the raw level data using the electronic digital level system, the PBM shall
always be selected as the starting mark, and the AQLP, orifice staff stop, or ETG, as the case
may be, shall always be selected as the ending mark. If the original RAW file is edited before
processing, the original file (XXXXXXX0.RAW) shall be stored in a separate subdirectory
named “Original RAW”, and submitted with the edited RAW (XXXXXXX.RAW) file and other
level files.

While using the electronic levels, any changes made to the description file (XXXXXXX.DES)
require that the levels be reprocessed and submitted to ED. Dates of the DES file must be
chronologically consistent with the abstract ABS and other files generated. The date of the DES
file cannot be later than the date of the ABS file.

Newly installed barometric sensors shall be included in the level run as a spur. Barometric
pressure sensors shall be leveled, or their height otherwise determined in relationship to station
datum, during installation, or if the barometer is moved to a new location. Barometric sensors at
Great Lakes stations shall be leveled, or their height otherwise determined in relationship to
DYNAMIC/IGLD 85. Since small changes in elevation do not change the height correction, the
original leveling requirement to the barometer every five years is not needed. The elevation of
Mean Sea Level (MSL) above Station Datum in the header information for the specific annual
requirements for each station is based upon the 1983-01 tidal datum epoch. The Barometer C2
shall be computed to include both the calibration corrections and height corrections. The installer
shall ensure that the new elevation is also correct on the Site Report section for calculation of the
barometer C2. The barometer C2s shall be updated in the DCPs during the annual inspections.
The SSN for the barometric sensor shall be xx10 if it is included in the electronic leveling, where
xx is the part number. At Great Lakes stations, the “Barometer Installation Worksheet — Great
Lakes” shall be used to compute the Height of the Barometer above the ETG. Refer to Reference
9 for additional information.

3.3.1 Leveling to NOAA Sentinels and Elevated Platforms

Leveling connections on Sentinels and other elevated platforms require a combination of steel-
taped height differences between the AQLP or a TBM at deck level (“deck” TBM) and a TBM
near ground level (“ground” TBM), and a standard level run between the “ground” TBM and
bench mark network.

To level from the AQLP to a TBM that can be included in the standard level run a TBM shall be
chosen that can be leveled to the existing bench mark network using the standard barcode rod.
This “ground” TBM shall be named and described per Reference 5 so that surveyors can level to
the exact same TBM in future level runs during the maintenance of the Sentinel or elevated
platform. The point where the taped measurement is made is critical in this description. This
TBM shall also be placed in a position where a taped measurement can be made from the TBM
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to the AQLP. If this is not possible, another TBM at the deck level of the Sentinel or elevated
platform shall be chosen, then named and described per Reference 5, again with care to include
the point of measurement in the description. This “deck” TBM shall be connected to the AQLP
using standard leveling procedures.

The steel taped distance from the “ground” TBM to the AQLP or “deck” level TBM shall be
performed on a windless day. A plumb bob shall be dropped from the AQLP or “deck” TBM to
insure that the steel tape is held as vertical as possible. A set of five readings each shall be made
by a minimum of two people for a total of ten readings. Each reading shall have the zero of the
steel tape positioned at the high point of the “ground” TBM and the elevation shall be read from
the tape at the AQLP or the high point of the “deck” TBM. The steel tape shall also be moved
away from the TBMs and repositioned for each reading. The ten readings shall be averaged to
acquire the height between the “ground” TBM and the AQLP or “deck” TBM.

The averaged steel tape height shall be entered into the DNAO3 so that it is abstracted in to the
level run. This is done by manually entering a zero for the staff height on the “ground” TBM as
the Backsight, then entering the positive value of the averaged steel tape height for the
Foresight of the Forward Run. During the Backward Run, enter zero for the Backsight, then a
negative value of the averaged steel tape height for the Foresight. This will put the height of the
AQLP or “deck” TBM into the abstract when the levels are processed using Translev.

3.3.2 Leveling to Temporary Bench Marks (TBM)

Due to leveling to meteorological sensors and water level sensors connected to DCPs other than
DCP 1, the designation for TBMs shall be changed to include the full 8 digit station number:
XXX XXXXY, where XXX XXXX is the Station ID, and Y is the DCP number. For example: If
the barometer is installed on DCP 1 at 8410140 Eastport, the designation shall be TBM 841
01401 Barometer. If the barometer is installed on DCP 2, the designation shall be TBM 841
01402 Barometer. This format shall be used for all SENSOR TBMs

In addition, there have been several new water level TBMs added that are standardized in the
following table. Use the designations below to correctly identify the orifice and microwave water
level leveling point at a water level station. Due to the character limitations in WinDesc and
Translev, it may be also be necessary to assign an alias.

Leveling Point Sensor Zero
Leveling Point (LP) Designation A"%S Measurement Point
Designation
TBM xxx xxxxx Single Orifice LP Single Orifice LP Single Orifice Zero
. . Upper Orifice Zero
TBM xxx xxxxx Dual Orifice LP* Dual Orifice LP -
Lower Orifice Zero
TBM xxx xxxxx Upper Orifice LP** Upper Orifice LP Upper Orifice Zero
TBM xxx xxxxx Lower Orifice LP** Lower Orifice LP Lower Orifice Zero
TBM xxx xxxxx MWWL LP MWWL LP N/A
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*For Dual Paros installations sharing the orifice LP use the designation TBM xxx xxxxx Dual
Orifice LP.

**For Dual Paros installations with separate orifice LPs for the upper and lower orifice, use the
designations TBM xxx xxxxx Upper Orifice LP and TBM xxx xxxxx Lower Orifice LP.

3.4 Datum Offsets and Accepted Orifice Offset

The leveling connection to an acoustic sensor shall be done at the AQLP. The AQLP is defined
as the top shoulder of the mounting plate collar on the calibration tube. In order to facilitate rod
holding, a prefabricated leveling fixture may be slipped over the sounding tube to rest on the
leveling point. The height of the leveling fixture, as inscribed on the fixture, shall be
compensated for in the leveling record (abstract). The level abstract shall show the elevation of
the leveling point only. A barcoded rule or stainless steel rule, with metric graduation (mm) and
the zero at the end of the rule, as appropriate, may be used in lieu of the leveling fixture by
holding the rule directly on the leveling point. In cases where the leveling point is too high for a
rod shot, the leveling fixture designed for a down shot shall be utilized and the readings recorded
to reflect the down shot. Use of other leveling fixtures and leveling techniques must be approved
in advance by ED.

The leveling connection to an ETG shall be done at the reading mark (RM). A barcoded rule (60
cm scale) or stainless steel rule, with metric graduation (mm) and the zero at the end of the rule,
as appropriate, may be used by holding the rule directly on the RM.

The AQLP elevation above station datum is defined as the Datum Offset and is computed by
algebraically adding the PBM elevation above SD to the acoustic sensor elevation above/below
the PBM. The Datum Offset is also referred to as Coefficient C2 for the Sutron 9000 DCP and as
DAT coefficient for the Sutron Xpert DCP.

The orifice zero elevation for the Paroscientific pressure sensor(s) above or below the SD is
defined as the Accepted Orifice Offset and is computed by algebraically adding the PBM
elevation above SD to the (sensor) orifice zero elevation above/below the PBM. The orifice zero
elevation is considered to be the point of the V on the brass orifice. For dual orifice systems the
orifice offsets are established for both “N1” and T1” pressure sensors.

At Great Lakes stations, the Dynamic Height of the ETG RM, plus or minus the Hydraulic
Corrector, at all lake stations, defines the IGLD 85 datum offset. In the Great Lakes Rivers and
Connecting Channels stations the “Dynamic Height = IGLD 85, Hydraulic Correctors are not
applied. This datum offset is applied to the Primary Water Level C2 and should only be changed
by ED after reviewing the abstract and Water Level Transfer.

When using the electronic/barcode leveling system, all five decimal places shall be used to
determine the Datum Offset on the approved site report. After adding or subtracting the
difference between the leveling point and PBM, to the elevation of the PBM above the SD, round
off the five place value of the Datum Offset to four places. Rounding shall be done to the even
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number, for example: 1.53455 is rounded to 1.5346. A note shall be made to the effect that the
existing Datum Offset was retained in the DCP, or the new Datum Offset was entered with date
and GMT time it was entered. When new Datum Offset is entered into the DCP, additional
notification is required as listed below under Section 3.5 Movement. For stations that have the
Paroscientific pressure sensor(s) as primary sensor(s), the change of accepted orifice offsets shall
be documented on the Site Report with GMT date and time, and additional notification is
required as listed below under Section 3.5 Movement.

If optical leveling equipment is used, then all elevations shall be recorded to the tenth of a
millimeter level (e.g. 12.3457 m) on the leveling abstract.

After documenting the dynamic elevation for the ETG and SPIKE at Great Lakes stations, round
to four places and apply these elevations to the “Water Level Transfer” program. Then apply the
Hydraulic Corrector utilizing the sign, negative or positive in the program. This elevation is now
the hydraulically corrected reference elevation, Zero Electric Tape Gauge (ZETG) and is then
rounded to three places and entered in the DCP as Primary Water Level C2. C2 will not be
changed unless the elevation differs by greater than + 0.003 meters and only then after
notification and review by ED.

When setting up the encoder offset at Great Lakes stations, the C2 in the Xpert DCP (sensor 14,
coefficient 2 in the 9000 DCP) will need to be zeroed (0.000). The encoder gear will then be
turned to reference 6.000 M on the display. Then an ETG reading will be obtained and subtracted
from the 6.000 M reference. This difference, called the initial C2, is then stored in the Xpert
DCP (sensor 14 coefficient 2 in the 9000 DCP). All ETG/Display readings have to be within
0.003 m. If not, the set up procedure must be performed again. NOTE: This procedure can best
be accomplished in early morning or late evening when the water is most likely to be calm or by
closing off the valve.

The accepted PBM elevation above IGLD85 in meters shall be used as the starting elevation on
the level abstract at Great Lakes stations. This method results in all bench mark elevations
referenced directly to IGLDSS.

At coastal sea level stations, the accepted PBM elevation above the SD in meters shall be used as
the starting elevation on the level abstract. This method results in all bench mark elevations
referenced directly to the SD. "Old" (before sensor swap) and "new" (after sensor swap) AQLP
connections, if required, shall be treated as spurs. Regardless of whether the acoustic sensor head
is swapped or not, the leveling shall be done only once after the sounding tube has been cleaned
and everything is put in place. For stations that have acoustic sensors installed, upon initial
inspection of the station, if the installer suspects a movement of the well or that of the AQLP,
then leveling shall be done twice, once before disturbing the well or sounding tube for cleaning
and then after repairing the well or cleaning the sounding tube. For stations that have pressure
sensor(s) installed, upon initial inspection of the station, if the installer suspects a movement of
the orifice(s), then leveling shall be done twice, once before disturbing the orifice(s) and then
after repositioning/securing of the orifice(s).
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3.5 Movement

The movement of an entity, such as (a) AQLP, (b) pressure orifice zero, or (¢) bench mark is
defined as change in elevation of the entity in excess of 0.0060 m (0.020 foot) as obtained by
comparing the current difference in elevation of the entity with PBM, with the previous
difference in elevation of the entity with PBM. For acoustic sensors this difference shall be
compared to what is stored in the DCP and appropriate action shall be taken as described below.
For pressure sensor orifices this difference shall be compared with the accepted orifice offset as
listed on the site report (and stored in DMS) because the accepted orifice offset is not stored in
the DCP and appropriate action as described below shall be taken.

The movement shall be noted in the remarks box of the leveling section of the approved site
report. If the Datum Offset determined from the latest level run indicates a deviation exceeding
0.0060 meter from the value presently stored in the field unit, and the PBM has remained stable,
the new Datum Offset shall be entered into the field unit (no verification levels required) after
consultation with ED. If the PBM is determined to be unstable, and other bench mark differences
remain within the 0.0060 m allowable, the Datum Offset in the field unit shall not be changed.
The suspected movement of the PBM shall be specifically noted, as instructed above, for further
action by ED. At Great Lakes stations, if the Primary Water Level Coefficient 2 (C2) determined
from the latest levels indicates a deviation exceeding 0.003 meter from the value presently stored
in the field unit, and the PBM has remained stable, contact ED within 24 hours and provide the
leveling abstract and Water Level Transfer.

ED and the supporting FOD field office shall be notified by phone or email immediately when
the Datum Offset is changed in the DCP, or the accepted orifice offset has changed more than +/-
0.0060 m. An email (nos.coops.oetteam@noaa.gov), fax copy of the level abstract (fax 301-713-
4465), and a phone call (telephone 301-713-2897) if possible, must be received by ED and
supporting FOD field office within 24 hours of the change. Contact information for FOD field
offices are listed in Section 4.2.3.

3.6 Geodetic Connections

Water level datums are local vertical datums which may vary considerably within a geographical
area. A geodetic datum is a reference surface relative to which heights are determined. The North
American Vertical Datum of 1988 (NAVD 88) is the accepted vertical datum of the National
Spatial Reference System (NSRS) for the conterminous United States and Alaska and is
officially supported by NGS. The relationships of tidal datums to geodetic datums such as
NAVD 88 and to ellipsoid heights (above GRS 80 ellipsoid) support many hydrographic, coastal
mapping, and engineering applications including monitoring of sea level changes, the
deployment of GPS Electronic Chart Display and Information Systems (ECDIS), and the NOS
Vertical Datum (VDatum) transformation tool.

Existing Geodetic Bench Marks (GBM) in the vicinity (up to 1.6 km (1 mile) leveling distance)
of a water level station (primary and subordinate) shall be searched for and recovered. If a mark
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is either not recovered or not used in the survey/project, a separate report shall be made using the
NGS on-line Mark Recovery Entry Form at http://www.ngs.noaa.gov/ngs-cgi-
bin/recvy_entry www.prl

The connection to geodetic datums involves the following three leveling ties:

1) NAVDSS Level Tie
2) NAD 83 GPS Tie
3) NAVDS8S8 GPS Tie

An orthometric level connection and ellipsoidal GPS tie are required at each water level station
(primary and subordinate) which has at least one GBM located nearby (within 1.6 km (1 mi)
leveling distance of a water level station).

The required “NAVD 88 Level Tie” is described in this document and the required “NAD 83
GPS Tie” and “NAVD GPS Tie” are described in Reference 6.

3.6.1 NAVD 88 Level Tie
There are two parts for this requirement as described below in A and B.

(A) NAVD 88 Level Tie: At all water level stations, a valid level tie to at least two GBM is
required on each set of levels, where appropriate GBM marks are available within 1.6 KM (1 mi)
leveling distance of the station location. A GBM is defined as a bench mark that exists, is
useable, is available in the NGS database, has a Permanent ID (PID), and has a NAVD 88
elevation published on the datasheet. At many NWLON stations, the Primary Bench Mark
(PBM) is a GBM. At the majority of NWLON stations, there are two or more tidal bench marks
that are also GBM, thus increasing the chance that the geodetic level tie would be valid.

Make a Second-Order, Class 1 level tie to NAVDS8S for all NWLON stations in the conterminous
United States and Caribbean Islands. A Third-Order tie is used for all NWLON stations in
Alaska, Hawaii, and Pacific Island areas.

At stations supporting hydrographic or shoreline mapping surveys, or other special projects, the
tie shall be consistent with the accuracy of the levels required for the project (e. g. 2" order class
1 or 3" order levels, etc.).

The Translev leveling program includes a check function that will tell the user if a two mark tie
to NAVDS&S has been successful. Information on performing a valid level tie is also provided in
the Federal Geodetic Control Committee (FGCC) Standards and Specifications for Geodetic
Control Networks, listed at the following website:
http://www.ngs.noaa.gov/FGCS/tech_pub/1984-stds-specs-geodetic-control-networks.htm#3.5

Also, Section 3.4 of “User’s Guide for the Installation of Bench Marks and Leveling
Requirements for Water Level Stations, October 1987 provides the same information regarding
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how to perform a valid level tie. The information in User’s Guide is easier to follow as it is
written in layman’s terms.

The Second-Order, Class 1 tie is a requirement for digital levels to be accepted into the NGS
database. Short level runs to the sensor, PBM, and two marks are excluded from this requirement
since they are usually meant to verify sensor stability only. Since a level connection to GBMs
with dynamic heights defines the International Great Lakes Datum of 1985 (IGLD 85) datum
offset at each station in the Great Lakes, a valid connection to at least two GBMs (within a mile
of station location) is required at each site.

A note shall be made in the remarks of the leveling section of the Site Report that a valid tie was
achieved or not achieved. If a valid tie is not achieved, an explanation shall be provided and/or
recommendations made for making a valid tie in the future.

If a successful NAVD 88 level tie is performed, then NAVD 88 elevations for all the bench
marks in the local leveling network (10 for NWLON and 5 for subordinate stations) can be
determined for the NOS Vertical Datum transformation (VDatum) program.

If the water level station does not have two or more GBMs within 1.6 km (1 mi) leveling
distance of the station location, then the NAVD 88 level tie requirement is waived.

(B) NAVD 88 Level connection: An orthometric level connection is required at each water level
station (primary and subordinate) which has at least one GBM located within 1.6 km (1 mi)
leveling distance of a water level station. If the water level station has two or more GBM within
1.6 km (1 mi) of radial distance of the station location, then perform a NAVD 88 Level Tie (as
described above in A) which fulfills the requirement for NAVD 88 level connection.

A successful NAVD 88 level connection to a GBM will help determine the approximate NAVD
88 elevations for the all the bench marks in the local leveling network (10 for NWLON and 5 for
subordinate stations) for the NOS VDatum program.

If there are no GBM within 1.6 km (1 mi) leveling distance of the station location, then the
requirement for NAVD 88 level connection requirement is waived.

3.6.2 Leveling at CORS

For any NGS Continuously Operating Reference System (CORS) reference bench mark that is
located within 1.6 km (1 mi) leveling distance of a water level station DCP, a leveling
connection shall be made to the tidal bench marks in the water level station network every two
years.

Information about NGS CORS stations can be obtained at http://www.ngs.noaa.gov/CORS/.

As of 2010, there are a limited number of water level stations in this category, but NGS and CO-
OPS are attempting to secure funding to establish additional co-located sites to support long-term
sea level trends monitoring.
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3.6.3 GPS Connections

An orthometric level connection and ellipsoidal GPS tie are required at each water level station
(primary and subordinate) which has at least one GBM located nearby (within 1.6 km (1 mi)
leveling distance of a water level station).

GPS connections involve the following two ties:

1) NAD 83 GPS Tie
2) NAVDS8 GPS Tie

The required “NAD 83 GPS Tie” and “NAVD GPS Tie” are described in Reference 6.
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4 SCHEDULE, REPORTS, AND DELIVERABLES

4.1 Schedule and Reports

Operations schedules are prepared for all water level stations each September for the upcoming
fiscal year. Schedules for FOD and contractor operations are combined to produce one composite
plan for CO-OPS. Overall accomplishments are compared to the plan on a monthly basis and
reported to CO-OPS management.

Contractors shall provide ED and the supporting FOD field office a proposed annual schedule for
accomplishing the indicated work in the station specific annual project instructions, or task
orders, at the beginning of the task order with updates on a monthly basis, or as specified in the
contract documents. Changes to the schedule must be requested in advance and approved by the
Contracting Officer’s Representative (COR) or CO-OPS.

Operations related to the indicated work in the station specific annual project instructions, or task
orders, shall be discussed in a monthly activities report, or as specified in the contract
documents.

4.2 Deliverables — Timelines, Documentation, and Points of Contacts

4.2.1 Timeline Requirements

Wherever communications allow, the one-day draft E-Site Report (or Xpert Site Report or Tide
Station Report) along with level abstract shall be forwarded to OET within 24 hours after the
following maintenance activities:

a) Installation of a water level station;

b) Completion of regular scheduled annual maintenance;
c) Completion of emergency maintenance;

d) Completion of check levels; or

e) Removal of a water level station.

The purpose of the one-day draft E-Site Report submission requirement is to:

1) Standardize the requirements for all of CO-OPS’ field efforts;

2) Provide feedback by OET to the Installer while at the site, so that critical information is
verified; and

3) Insure that timely corrective actions and required maintenance actions as described in the
station specific Project Instructions can be accomplished by the Installer while at the site.

Generally, OET will respond back to the Installer or provide feedback within 24 hours or earlier
during normal business hours during the work week. This requirement applies to all types of
water level stations and all types of sensors for every type of maintenance - installation, regular
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scheduled maintenance, emergency maintenance and removal of a water level station, where CO-
OPS is expected to receive and/or process the data.

CO-OPS has developed a web-based electronic site report (E-Site Report) that interacts with
DMS. Refer to Reference 28 and 29 for Users Guide and SOP for use of E-Site report. The
Installer shall follow the SOP for using the E-Site report as described in reference 29.

The installer is required to submit the required documentation as described below in Section
4.2.2 to CO-OPS ED and the supporting FOD field office or the Task Manager within 30
calendar days of completion of water level station installation, maintenance, repair, removal,
GPS observations, or as specified in the contract documents, whichever is earlier.

All data and documentation submitted to CO-OPS shall be retained by the installer for a period
of not less than three years or as stipulated in the contract, whichever is longer.

4.2.2 Documentation Requirements
The standard water level station documentation package includes the following:

1) Transmittal letter (PDF format)

2) E-Site Report, or Water Level Station Xpert Site Report, or Tide Station Report (E-Site
report in web based electronic format, Water Level Station Xpert Site Report or Tide
Station report in Microsoft Excel format)

3) Google map image, or NOAA Chart image showing the station location including the
standard title block with NOAA chart number. (PDF format)

4) Name of the U.S. Geological Survey quadrangle map (7.5 seconds interval) indicating
the exact location of the station, with map name and scale shown (PDF format)

5) Sensor test worksheet (PDF format)

6) Sensor elevation drawing (PDF format) showing sea floor, pier elevation, and sensor
elevation if the sensor is mounted vertically.

7) Water level transfer form (for Great Lakes stations only - PDF format)

8) Barometer Installation Worksheet (for Great Lakes stations only - PDF format)

9) Bench mark sketch (PDF format) — Large-scale bench mark location sketch of the
station site showing the relative location of the water level gauge, staff (if any), bench
marks, and major reference objects found in the bench mark descriptions. The bench
mark sketch shall include an arrow indicating north direction, a title block, and latitude
and longitude (obtained from hand-held GPS receiver) of the gauge.

10) Bench mark descriptions with handheld GPS coordinates (d/m/s.s format), and “Station
to Reach” statement in Microsoft Word format (See Reference 5).

11) Digital photographs of each bench mark disk (four views), station, DCP, equipment,
underwater components, and vicinity (JPEG format).

12) Levels (electronic files) including leveling equipment information and field notes of
precise leveling, if applicable.

13) Abstract of precise leveling (electronic format).

14) Datum offset computation worksheet or Staff/Gauge difference work sheet as
appropriate showing how sensor “zero” measurement point is referenced to the bench
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marks.

15) Staff to gauge observations, if applicable (Microsoft Excel format)

16) Calibration certificates for Invar leveling rods, if applicable (PDF format)

17) Calibration records for sensors, if applicable (PDF format)

18) Agreements, MOU, contract documents, utilities/pier agreements, etc., if applicable
(PDF format)

19) Other information as appropriate, or as specified in the contract (PDF format)

20) Water level data download in specified format

21) GPS Deliverables - the OPUS published datasheet and 4 photos of the GPSBM in
electronic format for each observation session as described in the User’s Guide for GPS
Observations at Tide and Water Level Bench Marks.

22) Annual Inspection (Al) checklist (Applicable for all CO-OPS’ NWLON AlI)

The station documentation shall be submitted in digital format only. All GPS data and
documentation shall be published to NGS OPUS.

Water level data downloaded for NWLON, PORTS, Tsunami, COASTAL, or in-house projects
shall be in accordance with Reference 26 “Engineering Bulletin 07-006 Exporting Data from
Xpert Family DCP”’. Water level data downloaded for contract hydrographic and
photogrammetry survey projects and submitted to CO-OPS for validation shall be in accordance
with Reference 27 “NOS Hydrographic Surveys Specifications and Deliverables™ Latest update.

Generally, for established NWLON stations or long term water level stations (more than 1 year),
the bench mark sketch, chartlet, and "To Reach" statement need only be submitted if these items
have been revised during the station maintenance or removal, because these items are required
and are generally submitted with the installation station package.

When using the electronic/barcode system, all digital files created using the Windesc and
Translev programs shall be submitted. At stations where the automated or manual levels are
used, Precise Leveling sheets of actual runs (NOAA Form 75-29) and Abstract of Precise Levels
(NOAA Form 76-183) shall be completed and submitted.

For submission in electronic format, the station documentation shall be organized by various
folders under the main station number folder, and then pertinent information shall be placed in
the various folders and submitted on a digital media, such as DVD/CD-ROM, FTP sites, etc.

Here is an example of submission of the electronic folders for San Francisco tide station:

9414290 San Francisco 2010 Annual Inspection
/Transmittal letter

/Calibration records for sensors, if applicable
/Site Report or tide station report

/Station Chartlet

/Sensor test worksheet

/Sensor elevation drawing

/Bench mark sketch
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/Bench mark descriptions and “Station to Reach” statement

/Photographs of bench marks, station, DCP, equipment, and vicinity in digital format

/Levels (raw) (electronic files) and field notes of precise leveling

/Abstract of precise leveling

/Staff to gauge observations, if applicable

/Datum offset computation worksheet or Staff/Gauge difference work sheet (elevation of
sensor zero measurement point referenced to bench marks)

/Calibration certificates for Invar leveling rods, if applicable

/Agreements, MOU, contract documents, utilities/pier agreements, etc., if applicable

/Other information as appropriate, or as specified in the contract

/Water level data (6-minute, hourly heights, high/low, monthly means, station datum)

/GPS deliverables, as applicable

/Diving Documents

Submit required GPS deliverables, including the OPUS published datasheet, and 4 photos of
GPSBM on a separate digital media, such as DVD/CD-ROM, FTP sites, etc. For example, GPS
submission for San Francisco tide station will be as follows:

9414290 San Francisco 2010 Annual Inspection

/OPUS Published Datasheet

/Photos of GPSBM

4.2.3 Points of Contact for Deliverables

All required deliverables listed in Section 4.2.2 above shall be submitted to the proper point of
contact as listed in the project instructions, contract documents, if applicable; or to NGS or CO-
OPS (see below) within 15 business days of the GPS observations, installation, maintenance, or a
removal of a water level station, or as specified in the Statement of Work or contract, whichever
is earlier. All GPS data and documentation shall be published to NGS OPUS.

(A) For all work done by NOAA (FOD, NOAA ships, NRT, other NOAA personnel) submit one
copy of all the documentation including the GPS deliverable in digital media, such as DVD/CD-
ROM, FTP sites, etc., to:

Chief, Engineering Division

CO-OPS, N/OPS1, SSMC 4, Station 6531
1305 East-West Highway

Silver Spring, MD 20910-3233

Tel: 301-713-2897 x 145

(B) For all CO-OPS’ IDIQ contract work deliverables, submit two copies of all the
documentation including the GPS submission in digital media, such as DVD/CD-ROM, FTP
sites, etc. Submit one copy in digital media to:

Marty Welch
Contracting Officer’s Representative
NOAA/NOS/CO-OPS
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SSMC 4, Station # 6544

1305 East-West Highway
Silver Spring, MD 20910-3281
Tel #301-713- 2897 X 129

Submit the other copy of the completed station package to the Task Manager, or appropriate
supporting FOD field office.

For East Coast task orders, submit to:

Task XXX Manager, Field Operations Division Atlantic Regional Office
808 Principal Court

Chesapeake, VA 23320

Tel: 757-436-0200

For West Coast task orders, submit to:

Task XXX Manager, Field Operations Division Pacific Regional Office
7600 Sand Point Way, NE

Bin C15700

Seattle, WA 98115

Tel: 206-526-6360

(C) For OCS contract hydrographic survey projects, submit one copy of all the deliverables
(water level data, station documentation, and GPS deliverable) in digital media, such as
DVD/CD-ROM, FTP sites, etc., to:

Chief, Engineering and Development Branch
CO-OPS, N/OPS1, SSMC 4

1305 East-West Highway, Station 6507
Silver Spring, MD 20910-3233

Tel: 301-713-2897 x 190

(D) For NGS contract shoreline mapping survey projects, submit one copy of all the deliverables
(water level data, station documentation, and GPS deliverable) in digital media, such as
DVD/CD-ROM, FTP sites, etc., to:

Mr. Greg Stinner

Contracting Officers Representative
NOAA/NOS/National Geodetic Survey
SSMC 3, Station # 8609

1315 East-West Highway

Silver Spring, MD 20910-3281

Tel # 301-713- 3167
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HORCON/VERCON OBSERVATION LOG

DATE: SESSION: PROJECT NAME:

WX CONDITIONS: SITE NAME: SITEPHOTO(S): Y/N

OBSERVER(S): SITETYPE: HORZ./ VERT./ ATON/ BM / NEW /

DN: RECEIVER #: FIXED HEIGHT? Y /N

4 CHAR. SITE ID: ANTENNA #: SPACER? Y/N
ANT. MEASUREMENTS ANT. CONSTANTS

ANT. SLANT HEIGHT (S) | ANT.RAD. (R)] V.OFFSET (C)

SESS. FILE NAME: START STOP

ELEV. MASK: degrees m m m m

RECORDING INTERVAL: sec.s ft ft

OBSERVATION TIMES AND STATUS

RECEIVER TIME (UTC) PDOP LOCAL TIME #of SV’s POWER
START:
STOP:
INSTRUCTIONS: Office Check by:
HI to ARP=((SQRT(S*R?) - C): (m)

SITE SKETCH/LOC./NOTES:

OBSTRUCTION DIAGRAM MONUMENT RUBBING / DESCRIPTION

210 150
195 1gp 165

S




ILLUSTRATION FOR ANTENNA HEIGHT MEASUREMENTS

l. Instructions for HMR;US:H
Fixed-Height Tripods: —

: Y- BGP
Measure & record the fixed-height tripod length (A) A RP g \ / ﬁ f ARP

and other offsets, if any, between the tripod and the ‘ ‘

Antenna Reference Point (ARP) (B)
Antenna.Height-H-A+B

Heign

Il. _Instructions for
Slip-Leg Tripods:

1. Measure the Slant Height (S)
Measure the slope distance from the mark to at least three notches
on the Bottom of Ground Plane (BGP) using two independent rulers
(e.g., metric and Imperial). Record measurements in the table below,
and compute the average.

>
0p)

Measure S Notch #_ | Notch #_ | Notch#_ | Average

Antenna Height

Before, cm

Before, inch

After, cm
After, inch

I Note: em= inch x (2.54) i Overall average, cm i I

§= cm

Fixed Height Tripod Length
Stant

2. Record the Antenna Radius (R)
and the Antenna Constant (C)

The antenna radius (R) is the horizontal distance from the
=) L Datum V¥

center of the antenna to the measurement notch. The antenna _
constant (C) is the vertical distance from the ARP to the BGP. ﬂ |—Q| PO]“ I
Consult your antenna users manual for exact measurements.

R= cm

Cc= cm

3. Compute Antenna Height (H)

Use the following Pythagorean equation:

Antenna.Height-H=((yS*-R*)-C)
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GUI DELI NES FOR ESTABLI SHI NG GPS- DERI VED ELLI PSO D HEI GHTS
[ Standards: 2 cmand 5 cni
Version 4.3

Pr ef ace:

The foll owi ng guidelines were devel oped by the National Geodetic Survey
(NGS) for perform ng G obal Positioning System (GPS) surveys that are

i ntended to achieve ellipsoid height network accuracies of 5 cmat the 95
percent confidence level, as well as ellipsoid height |ocal accuracies of 2
cmand 5 cm also at the 95 percent confidence |evel. See Appendix A for

i nformati on about local and rel ative accuracies. These guidelines were
devel oped in a partnership with Federal, state, and |ocal governnent

agenci es, academ a, and private surveyors and are the result of processing
various test data sets and having extensive di scussions with various GPS
users groups.

We are confident that these guidelines, if followed, will result in
achieving the intended accuracy. Additional tests may show that sone of
these gui delines can be rel axed. These guidelines are intended for
establishing geonetric vertical control networks.

These guidelines will be expanded in the future to include the
establishnment of GPS-derived orthonetric heights that approach these sane
accuracies, 2 cmand 5 cm The slight differences between the accuraci es of
GPS-derived ellipsoid heights and GPS-derived orthonetric heights will be
generally due to the accuracy of the geoid nodel and published orthonetric
hei ghts used to evaluate the differences between the three hei ght systens,
i.e., ellipsoid, geoid, and orthonetric heights.

Not e: these guidelines assune that for the survey project area in question,
NGS has conpl eted the establishment of a high accuracy reference network at
100- kil ometer spacing or that a state-w de Hi gh Accuracy Reference Network
(HARN) has been established, i.e., there are A- or B-order stations

di stributed throughout the state at an approxi mate spaci ng of 50 km or el se
there are Federal HARN stations or GPS Continuously Operating Reference
Station (CORS) sites located within 75 km of the project area.

An effort should be made to connect to stations which were previously
deternmi ned using these guidelines (or equivalent).



| nt roducti on:

Accurate connections to the control stations cited in the Observations
section on the next page nmust be made in the International Terrestria

Ref erence Frane (I TRF) coordinate system (See Appendix C for nore
information on ITRF.) This is acconplished by sinultaneous observations
bet ween sel ected A-order (5 mm + 1:10, 000, 000 accuracy standards) stations
of the International GPS Service for Geodynamics (IGS) and/or NGS CORS or
NGS- approved CORS within about 75 km of the project. NGS-approved CORS are
those which NGS has positioned or approved with respect to the | TRF/ NAD 83
coordi nate systens. If there are none available, B-order (8 nm +

1: 1,000, 000 accuracy standards) stations within about 75 km of the project
may be substituted. However, it nust be noted that the use of sone of the
B-order stations nay nean that the network accuracy of +/- 5 cmw Il not be
achi eved.

These I GS stations and CORS sites are |ocated throughout the United States.
The I GS stations or CORS sites |ocated closest to the project nust be used.
The foll owing conmands are used to access the NGS CORS system

Ftp cors.ngs. noaa. gov
| ogi n: anonynous
Password: your conplete e-nmail address

The sane files are accessible with Web browers (i.e., Msaic, Netscape,
Internet Explorer). The NGS honme page is at http://ww. ngs. noaa. gov

"Informati on about A- and B-order stations is given on five sets of CD ROVs
covering the United States." The particular CD-ROMthat covers the project
area in question can be obtained by contacting NGS |nformation Services
Branch, 1315 East-Wst Highway, Silver Spring, Mryland 20910, (301)
713-3242 (voice), (301) 713-4172 (Fax). Alimted anount of this
information, i.e., the 100 cl osest stations of any type, can be retrieved
fromthe NGS world wi de web site. The electronic bulletin board system
and/or web site usually contain new stations that have been added after the
CD- ROM was produced.

Anal ysis of the quality of project data shall be based on repeatability of
measur enents, adjustnment residuals, and analysis of |oop misclosures.

Pl ease be aware that repeatability and | oop nisclosures do not disclose al
probl ens.



Observati ons:

The followi ng requirenents are for both 2-centinmeter and 5-centineter
st andards, unl ess otherw se stated.

1. Dual -frequency, full-wavel ength GPS receivers are required for base
lines greater than 10 km and are the preferred type of GPS receiver for al
observations, regardl ess of base-line distance. Geodetic-quality antennas
with ground planes are required. Whenever possible, antennas used during a
proj ect should be identical; otherw se corrections nust be nade for antenna
phase patterns. Different makes and nodel s of antennas have different
antenna phase patterns. If antenna phase patterns are not accounted for

m xing different antennas in a project can cause vertical discrepancies of
as much as 10 cm Sone manufacturers are including software packages which
correct for the use of different antennas. (It should be noted that choke
ring antennas help reduce the effect of nultipath and are highly
reconmended. )

The manufacturer, nodel, and conplete serial nunmbers of all receivers and
antennas nust be included on each station Session Cbservation Log.

2. The survey shall be referenced to at |east three existing Nationa
Spatial Reference System A- or B-order three-dinensional control stations

near the project area. The survey will also consist of at |least three
primary base stations that are referenced to the three control stations and
i nterspersed throughout the project. The survey will also include secondary

base stations and |l ocal network stations to neet the spacing requirenents
initemb5., below Primary and secondary base stations can be newy
established stations in this project.

A sanple project with observing schene is depicted in figure 1 |ocated at
the end of the section. A summary of the guidelines is provided in table 1
| ocated at the end of the vector processing section. See Appendix A for
nore information about control, base, and |ocal network stations.

3. For control stations and primary base stations, receivers shall coll ect
data continuously and sinultaneously for at |east three, 5-hour sessions on
3 different days during the project.

4. Observation periods for stations other than control stations and primry
base stations are as foll ows:

a. For the 2-Centineter Standard: Each base |line (adjacent station
pair) must be occupied for a mnimmof 30 mnutes per session

b. For the 5-Centineter Standard: Observations between primary and
secondary base stations nust be for a mninmmof 30 m nutes per session. Wile
there is no minimum observation tinme for |ocal network stations, each base
line (adjacent station pair) must be occupied | ong enough in each
session to ensure that all integers are fixed and the RMS for the base
line solution does not exceed 1.5 cm

5. The observing schene is based on the GPS survey of marks spaced as
i ndi cated bel ow for 2- and 5-centineter standards. Stations in the schene



are noted as either control, prinmary base station, secondary base station,
or local network stations. (The observing schenme chosen for a sanple
project is depicted in figure 1, page 7.)

For the 2-Centineter Standard: Spaci ng between |ocal network stations
cannot exceed 10 knm the average spacing nust be |ess than or equal to 7
km Spaci ng between prinmary base stations cannot exceed 40 km and spaci ng
between primary and secondary base stations cannot exceed 15 km

For the 5-Centineter Standard: Spacing between |ocal network stations
cannot exceed 20 knm the average spacing nust be |ess than or equal to 10
km Spaci ng between prinmary base stations cannot exceed 50 km and spaci ng
between primary and secondary base stations cannot exceed 20 km (Note that
secondary base stations may not be required in projects of snall area
extent. See Item 2. above.)

6. The observing scheme for all primary base stations requires that each
primary base station nust be connected to at least its nearest prinmary base
station nei ghbor and nearest control station according to the observing
procedures stated in item 3., above. Prinmary base stations nust be
traceabl e back to two control stations along independent paths.

In addition to this requirenent for primary base stations, the observing
schene for all base stations (primary and secondary) requires that each
base station be connected with at least its two nearest prinmary or
secondary base station nei ghbors according to observing procedures stated
initem4., above. For secondary base stations, one of these connections
nmust be to its nearest primary base station nei ghbor. Secondary base
stations nmust be traceable back to two primary base stations al ong

i ndependent pat hs.

Local network stations nust be traceable back to two base stations al ong
i ndependent pat hs.

The observing schene for all stations requires that all adjacent stations
(base lines) be observed at |east twice on 2 different days and at two
different times of the day according to observing procedures shown in item
4. on the previous page. The purpose is to ensure different atnospheric
conditions (different days) and significantly different satellite geonetry
(different tinmes) for the two base |ine nmeasurenents.

Observations on the second day should be conpl eted between 27 and 33 hours
after the conpletion of the first day's observations if the first day's
observations were begun prior to 12:00 noon. O, the observations should be
conpl eted between 15 and 21 hours after the conpletion of the first day's
observations if the first day's observati ons were begun after 12:00 noon.
This is necessary since the satellite constellation geonetry repeats itself
every 12 hours.

Exanpl es: First-day observations Second-day observati ons
Begun duri ng: Conpl eted anyti me between
8:00 am to 8:30 a.m 11:30 a.m and 5:30 p.m
10:30 a.m to 11:00 a.m 2:00 p.m and 8:00 p. m
1:00 p.m to 1:30 p.m 4:30 a.m and 10:00 a. m

3:30 ppm to 4:00 p.m 7:00 a.m and 12:30 p.m



(Note that the second day of observations does not need to follow

i medi ately after the first day. Satellite geonetry noves ahead, or
precesses, 4 minutes per day. If the second observations are not perforned
within 1 week of the first, this daily 4-minute change nust be accounted
for when neeting the different satellite geonetry requirenent.)

7. Selection of primary and secondary base stations in order of
nost-to-least- preferred are: 1. Hi gh Precision Geodetic Network
(HPGN) / HARN (either Federal Base Network (FBN) or Cooperative Base Network
(CBN) stations which have level ties to bench marks of A- or B-stability
quality during this project; 2. bench marks of A- or B-stability quality or
HPGN HARN st ati ons which were previously tied to bench marks of A- or
B-stability quality; 3. User Densification Network (UDN)stations which have
| evel ties made during this project; or 4. bench marks of C stability
quality. In areas of known or suspected subsidence or uplift, specia

gui delines may need to be followed.

8. Data should be collected during periods when the Vertical Dilution of
Precision (VDOP) is less than 6 for at |east 90 percent of each 30-m nute,
or longer, observing period. For shorter observing periods, as in sone
projects where the 5-centinmeter standard is the goal, a VDOP greater than 6
shoul d be avoided entirely. Travel between stations could be schedul ed
during | arge VDOP peri ods.

9. For sessions greater than 30 nminutes, collect data at 15-second epoch
intervals, starting at an even minute. For sessions |less than 30 ninutes,
coll ect data at 5-second intervals.

10. Track satellites down to at |east a 10-degree el evation angle. (Note
that tracking bel ow 15 degrees may be hel pful during processing when
collecting data for less than 30 m nutes.)

11. If possible, coordinate observations with | ocal, existing CORS which
are collecting phase data with dual -frequency receivers.

12. Meteorol ogical data nmust be collected at the control stations and

pri mary and secondary base stations. Wather data consist of wet- and
dry-bul b tenperatures (or dry-bulb tenperature and relative hum dity) and
at nospheric pressure. For sessions greater than 2 hours, record weather
data at the beginning, middle, and end of each session. For sessions that
are less than 2 hours in length, but nore than 30 m nutes, record weat her
data at the beginning and end of each session. For sessions that are |ess
than 30 mnutes in length, collect data at the m d-point of the session
Met eor ol ogi cal data shall also be collected i mediately after an obvi ous
weat her front passes during a session and also inmediately before it
passes, if possible. Atnospheric pressure neasurenents nust be nade at
approximately the sane height as the GPS antenna phase center. Record on
the observing log the tinme and where the weather data were gathered, and
any abnornmal weather conditions.

(Note that even though all of these data may not used in the vector
processing, they nay be hel pful during the analysis of the results and in
future reprocessing with nmore robust software.)



Bef ore taki ng weat her observations, the neteorological instrunents should
be allowed anple tine (approximtely 10 nminutes) to stabilize to anbi ent
conditions. Cbservations of wet- and dry-bulb tenperatures nust be observed
and recorded to at | east the nearest 1 degree Celsius. Baronetric readings
nmust be observed and recorded to at |east the nearest 1 millibar

Met eor ol ogi cal data should be collected at or near the antenna phase
center. Al equipment nust be checked for proper calibration.

13. Antenna set-up is critical to the success of the project. Plunbing
bubbl es on the antenna pole of the fixed-height tripod nust be shaded when
pl umbing is performed. Plunbing bubbles nust be shaded for at |least 3

m nut es before checking and/or re-plunbing. The perpendicularity of the
pol es must be checked at the beginning of the project and any other tine
there is suspicion of a problem

For the 2-Centineter Standard: Fixed-height tripods are required for al
receivers.

For the 5-Centineter Standard: Fixed-height tripods are preferred for al
receivers. Wen a fixed-height tripod is not used, the height of the
antenna nust be carefully neasured to prevent station set-up blunders.
Tribrachs used for these set-ups nust be checked and adjusted when
necessary. Totally independent measurenents of the antenna hei ght above
mark in both netric units and English units nust be nmade before and after
each session. Sonmeone other than the observer nust check the neasurenent
conmput ations by carefully conparing neasurenents and then entering his/her
initials on the |og.

14. A rubbing of the mark nust be nade at each occupation of a station
When not feasible to nake the required rubbing, a plan sketch of the nmark
nmust be substituted, accurately recording all markings.



Contr ol

Station 1 Control Statio
Primry Base 1 Primary Base 3
LNS 1 LNS 12
LNS 2 LNS 11
LNS 3 LNS 10
Secondary Base 1 Secondary Base 2
LNS 4 LNS 9
LNS 5 LNS 8
LNS 6 LNS 7

Primary Base 2

Control Station 3

n 2

me)

8:30 am

6 Receivers One Week
3 Control Stations (CS) of
3 Primary Base Stations (PBS) Fokkok ok ok ok ok ok ok bservations
2 Secondary Base Stations (SBS)
12 Local Network Stations (LNS) (1 hour travel ti
Cs1, CSs2, Cs3, PBS1, PBS2, PBS3 Days 1,2, and 3
5-hour sessions (8 a.m- 1 p.m)
PBS1, LNS1, LNS2, LNS3, SBS1, LNs4 Day 4
30-m nute session (8 am -
SBS1, LNS4, LNS5, LNS6, PBS2, LNS7 Day 4

30-m nute session (9:30 am- 10 am

PBS2, LNS7, LNS8, LNS9, PBS3, LNS10 Day 4

30-m nute session (11 am -

PBS3, LNS10, LNS11, LNS12, SBS2, PBS1 Day 4
30-m nute session (12:30 pm- 1 pn

PBS1, LNS1, LNS2, LNS3, SBS1, LNS4 Day 5

30-m nute session (12 pm -

SBS1, LNS4, LNS5, LNS6, PBS2, LNS7 Day 5
30-m nute session (1:30 pm- 2 pn)

PBS2, LNS7, LNS8, LNS9, PBS3, LNS10 Day 5

30-m nute session (3 pm -

PBS3, LNS10, LNS11, LNS12, SBS2, PBS1 Day 5
30-m nute session (4:30 pm- 5 pn)

Figure 1.--Sanple project observing schene.

11: 30am

12: 30 am

3:30 pm



Vect or Processing:

The followi ng requirenents are for both 2-centinmeter and 5-centineter
standards unl ess otherwi se stated. A sunmary of the guidelines is listed in
table 1 at the end of this section.

1. Final vector processing and quality review of collected data shall be
acconpl i shed usi ng NGS' program OMNI or other interactive,

gr aphi cs- produci ng software which produces results equivalent to OWI. The
vector between adj acent GPS-occupied stations shall be processed using the
nmul ti-station processing techni que which includes doubl e-difference phase
corelations (or equivalent) with a selection of a reference station that

m nim zes vector |engths.

2. Use precise ephenmerides. NGS precise ephenerides are available fromthe
U.S. Coast Guard Bulletin Board Systemor the NGS world wi de web site. The
Coast CGuard Bulletin Board System nunber is (703)313-5910 and the NGS web
site address is http://ww.ngs. noaa.gov The USCG web site address is
http://ww. navcen. uscg. m |/ navcen. htm

3. For sessions greater than 30 nminutes, process data using 30-second epoch
intervals. (Note that using a smaller epoch interval may inprove ease of
data processing.) For sessions |less than 30 minutes, process data using
5-second epoch intervals.

4. For sessions greater than 30 minutes, use only satellite data tracked
above the 15-degree el evation angle. For sessions |less than 30 mnutes, use
satellite data tracked above the 15-degree el evation angle; data collected
bel ow the 15 degree el evation angle should only be used if required to
derive a successful solution

5. Final processing shall consist of fixing all integers for each vector
for all sessions except to sone control sites. For short base |ines, under
10 km the L1 fixed solution may be the best choice. For vectors greater
than 40 kmto control sites, a session may consist of a set of partially or
conpletely fixed vectors and in the worst possible scenario may al so

i nclude float solutions where no integers could be fixed.

A nodel to account for tropospheric effects nust be used. The project
report nust state which nodel was used. Measured neterol ogi cal data should
be used only when it has been determined that the instruments have been
properly calibrated and the neasurenments accurately represent the current
at nospheric conditions at the station. |f standard neteorol ogical data are
used instead of actual neasured values, the processing software mnust
account for changes in standard default values due to the station's

| ocati on and hei ght above the vertical datum For base |lines greater than
15 kiloneters or with "large" height differences, a relative tropospheric
scal e paraneter should be solved for, along with the base |ine vector
conmponents.

6. The quality of collected data shall be determ ned fromthe
doubl e-di fference residual plots and RMS val ues. Final coordinates and
their quality assessnent shall be deternined by using | east-squares

adj ust mrent software and by analysis of repeated vectors and free-adjustnment
residuals and | oop nisclosures (nost |oops consisting of repeated vectors).



7. RMS val ues for each conputed base |line (adjacent station pairs) must not
exceed 1.5 cm

8. Reobservation criteria:

For the 2-Centineter Standard: For |ocal network requirenments, nust
reobserve any base |ine (adjacent station pair) where the difference in

el li psoid hei ght between the repeat observations exceeds 2.0 cm For
station pairs involving control stations, nust reobserve any contro
station base line where the ellipsoid height difference between the repeat
observati ons exceeds 5.0 cm

For the 5-Centineter Standard: Mist reobserve any base |ine (adjacent
station pair) or control station pair where the ellipsoid height difference
bet ween the repeat observations exceeds 5.0 cm

When reobserving base lines that exceed tol erance val ues, the new
observation nmust agree with an old base |ine which was observed using the
criteria in number 6. of the Observations section above, i.e., the two base
line measurenments nust contain significantly different satellite geonetry.
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Not es for Table of Summary of Guidelines:

1 Anal yses have indicated that when following all guidelines in this
docunent, 30 minutes of observations over base |lines that are typically

| ess than 10 kiloneters will meet the standards. For base lines greater
than 10 km but |less than 15 km 1 hour sessions should neet the standards.
For observing sessions greater than 30 minutes, collect data at 15-second
epoch interval. For sessions less than 30 minutes, collect data at 5-second
epoch interval. Track satellites down to at |east 10-degree el evation
cut - of f.

2 Base |lines nmust be reobserved on different days with significantly
different satellite geonetry.

3 The observing schene requires that all adjacent stations have base lines
observed at |least twice on two different days with significantly different
geonetry.

4 |f base line is greater than 40 kil onmeters, a partially fixed or fl oat
solution is permtted.

Dat a Submi ssion to NGS:

1. The project accession nunber is of the form GPS-xxx. (The project
accession nunmber will be assigned by NGS when draft project plans are
submitted to NGS for evaluation prior to the start of the project.)

2. A project report and the data elenents listed in Appendix L of "Input
Formats and Specifications of the NGS Data Base" nust be transmitted to
NGS. Quality checks for conformance to NGS fornmat standards shall be
performed using software progranms COVPGB and OBSDES.

3. Latitude, longitude, and ellipsoid heights, as well as X, Y, and Z
coordi nates shall be provided in both NAD 83 and | TRF coordi nate systens.
See Appendix C for nmore information on transformation paranmeters and

rel ated information.

Gui del i ne Updat es:

These Guidelines will be updated as the results of future projects and

ot her procedures are reviewed. There are other procedures that will also
achi eve the standards. The user should note which procedures in this
docunment were not foll owed and note how errors and systematic biases were
detected, reduced, or elimnated by the new procedure. NGS wel cones the
opportunity to exam ne alternate procedures and supporting data that
denonstrate the ability to achieve the accuracy standards stated in this
docunent. |f you have such data or would |like to coment, please contact
Dave Zil koski or Steve Frakes, tel ephone 301-713-3191, or wite:

Nat i onal Geodetic Survey, N NGS2
NOAA, 1315 East-West Hi ghway
Silver Spring, Maryland 20910- 3282
emai | : davez@gs. noaa. gov or

st eve@gs. noaa. gov



Appendi x A. -- Definitions
Accur acy

Local Accuracy - The local accuracy of a control point is a value expressed
in cmthat represents the uncertainty in the coordinates of the contro
point relative to the coordinates of the other directly connected, adjacent
control points at the 95 percent confidence |level. The reported | oca
accuracy i s an approxi mate average of the individual |ocal accuracy val ues
between this control point and other observed control points used to
establish the coordi nates of the control point.

Net wor k Accuracy - The network accuracy of a control point is a value
expressed in cmthat represents the uncertainty in the coordinates of the
control point with respect to the geodetic datum at the 95 percent
confidence level. For National Spatial Reference System (NSRS) network
accuracy classification, the datumis considered to be best supported by
NGS. By this definition, the | ocal and network accuracy val ues at CORS
sites are considered to be infinitesinmal, i.e., to approach zero.

St ati ons
Base Stations

Primary - Stations evenly distributed that surround the | ocal network.
These stations relate the local network to NSRS to the 5-cm or better
standard through sinmultaneous observations with control stations. They
can be newly established stations and be part of the |ocal network.

Secondary - Stations evenly distributed throughout the | ocal network that
ensure that the |local network does not contain a significant medi um

wavel ength (20-30 knm) ellipsoid height error through simultaneous observations
with primary base stations. These stations nmay be newly established stations
and are part of the local network. They are | ocated between Primary Base

St ati ons.

Control Stations

A- or B-order three-dinensional stations that surround the project area in
at least three different quadrants. These stations relate the |ocal network
to the National Spatial Reference Systemthrough simultaneous observations
with primary base stations. They nust be referenced to NSRS and they
provi de the network accuracy. They nmay be newly established stations in the
survey project if A- or B-order specifications and procedures are used to
establish them These procedures are not covered in this document, please
contact NGS for additional information.

Local Network Stations

These stations include all other stations that are not base (primary or
secondary) or control stations. They are part of the |ocal network. They
provi de the | ocal accuracy standard through sinultaneous observations between
adj acent stations.



Appendi x B. -- GPS Ellipsoid Height Hi erarchy and Basic Requirenents for

2-cm standard
HARN Control Stations
(75 km
Pri mary Base
(40 km
Secondary Base
(15 km
Local Network Stations
(7 to 10 km

HARN/ Control Stations

Primary Base Stations

O Cs1

O Cs2 CS3 O

Basi ¢ Requi renents

(0]

5 Hour Sessions / 3 Days
Spaci ng between primary base stations cannot exceed 40 km

Each primary base station nmust be connected to at |east its nearest
primary base station nei ghbor and nearest control station

Primary base stations nust be traceable back to 2 control stations
al ong i ndependent paths; i.e, base lines PB1L - CS1 and PBl - PB2 plus
PB2 -CS2, or PB1 - CS1 and PBl1 - PB3 plus PB3 - CS3.



Secondary Base Stations

0
PB1
SB1 SB2
SB3 <-------n-- 15 Km -=---=---- > SB4
PB2 PB3
o) o)

Basi ¢ Requi renents
0 30 Mnute Sessions / 2 Days / Different tinmes of the day

0 Spaci ng between secondary base stations (or between primary and
secondary base stations)cannot exceed 15 km

o All base stations (primary and secondary) nust be connected to at
least its two nearest primary or secondary base station neighbors.

0 Secondary base stations nust be traceable back to 2 primary base
stations al ong i ndependent paths; i.e., SBl- PBl and SB1- SB3 plus SB3
- PB2, or SBl - PBl1 and SBl1 - SB4 plus SB4 - PB3.

0 Secondary base stations need not be established in surveys of snall
areal extent.



Local Network Stations

O
PB1
LN1
SB1 LN2 LN3 SB2
LN4 LN5
LN6<--7 km -> LN7
SB3 SB4
PB2 PB3

Basi ¢ Requi renents
30 Mnute Sessions / 2 Days / Different tinmes of the day

Spaci ng between | ocal network stations stations (or between base
stations and | ocal network stations) cannot exceed 10 km

Al'l local network stations nust be connected to at least its two
near est nei ghbors.

Local network stations nust be traceable back to 2 primary base
stations al ong i ndependent paths; i.e., LN1 - PB1 and LNl - LN2, plus
LN2 - SB1, plus SB1 - SB3 plus SB3 - PB2, or LNl - PBl and LNl -LN3,
plus LN3 - SB2 plus SB2 - SB4 plus SB4 - PB3.



APPENDI X C.--1TRF TO NAD 83 TRANSFORMATI ON PARAMETERS
I nt roduction

The International Earth Rotation Service Terrestrial Reference Frane
(I TRF) has beconme an inportant coordi nate system for users of d oba
Posi tioni ng System (GPS) technol ogy. Both GPS and | TRF are gl obal
geocentric coordinate systens. The | TRF coordi nate system supports GPS
orbit conputations and provides a basis for nore precise GPS data
reducti on conmputations. Also, for many applications it is necessary to
use a coordinate system such as | TRF to account for the notions of the
Earth's crust. Published I TRF sol utions provide not only coordinate
val ues at a particular epoch in time, but station velocities as well
Thus, up-to-date | TRF station coordinate val ues can be conputed for
future epochs in tinme after the original solution.

The North American Datum of 1983 (NAD 83), on the other hand, has the
advant age of being fixed and stable relative to the North Anmerican
tectonic plate. Additionally, NAD 83 has been officially adopted by

t he Federal governnent as the coordinate system for mapping and
charting in the Unites States. Therefore, the relationship of ITRF to
regi onal or continental datuns |ike NAD 83 is of utnpst inportance to
GPS users.

The foll owi ng background informati on on NAD 83 shoul d hel p
under standi ng the differences, systematic and otherw se, between | TRF
and NAD 83.

NAD 83 Datum Definition

The NAD 83 adj ustnent conbined terrestrial data (di stances, azimuths,
and direction observations) with space-based data, such as 3-D
positions derived fromsatellite Doppler observations and 3-D
inter-station vectors obtained fromVery Long Baseline Interferonetry
(VLBI).

Along with these data, and equally inportant, was a set of inplied
constraints that defined the scale and orientati on of NAD 83. Also

i ncluded in the NAD 83 adjustment was a set of gl obal paraneters that
allowed the inplied constraints to have conplete influence. An exanple
woul d be that of a distance observation which has inplied scale, but

if a global scale paranmeter is included in its observation equation

it allows the scale to be determ ned el sewhere. Table 1 shows the

gl obal paraneters for the NAD 83 adjustment:



Table 1.--d obal paranmeters - NAD 83
adj ust ment .

Par anmet er Terrestrial Doppl erVLB
X Shi ft F

Y Shift F

Z Shift F

X Rot ation F A
Y Rot ation F A
Z Rotation F A A
Scal e A F A
F=fi xed

par anet er

A=est i mat ed

par anet er

The above table shows that the 3-D positions derived from Doppl er
observations defined the geocentricity, scale, and the ngjor part of
the orientation of the NAD 83 datum

The VLBI vectors are very inportant for several reasons. To begin
with, the VLBl vectors are extrenely preci se. These vectors span the
continent and are found to be internally consistent at the 2-3 cm

| evel . Second, the VLBI stations and data are an integral part of the
| TRF solutions and thus provide a |link between NAD 83 and | TRF. Third,
al t hough the VLBI vectors were not used to hel p define the NAD 83
scal e and orientation, the adjusted values for global paraneters
associated with the VLBl vectors tell how they were changed. This
provi des a quantitative nmeasure of the systematic difference between
NAD 83 and coordi nate systens based on VLBI



Tabl e 2.--Adjusted values for VLB
gl obal paraneters.

Par anet er Val ue

X Rot ation 0. 022 arc seconds
Y Rot ation 0. 026 are seconds
Z Rot ation* 0.010 arc seconds*
Scal e Change -0.075 ppm

*The actual adjusted value of the Z rotation was 0.375 arc seconds,
however there was a post-adjustment correction of 0.365 arc seconds
applied, resulting in the 0.010 arc seconds shown above. In effect the
coordi nate systemwas rotated to be nore consistent with the VLB
observations.

NAD 83 Upgrade Surveys

In 1988, the National Geodetic Survey (NGS) began to upgrade the NAD
83 coordinates by perform ng high accuracy reference network (HARN)
GPS surveys. This is being done on a state-by-state basis. The
strategy for deternmining the control for these upgrades follows. First
consider the following (X, Y, Z) transformation, designated equation
1

Xn = Tx + (1 + S)Xi + RzYi - RyZi
Yn =Ty - ReXi + (1 + S)Yi + RxZ
Zn = Tz + RYXi - RxYi + (1 + 9)zZi

This equation defines a seven-paranmeter transformation fromITRF to
NAD 83, where (Xi, Yi, Zi) denote geocentric cartesian coordinates in
| TRF and (Xn, Yn, Zn) denote geocentric cartesian coordinates in NAD
83.

In order to establish control stations for the new HARN GPS surveys,
NGS conmpl eted the foll ow ng:

1. NGS used a set of 12 VLBI stations located in North America to
deternine a seven-paraneter transformation (equation 1) from
| TRF89 (epoch 1988.0) to NAD 83 (see table 3).

2. NGS decided to accept the scale of |ITRF89 as being closer to the
true val ue.

3. The derived transformation paraneters, translations, and
rotations, but NOT scale, were applied to the conplete set of
| TRF89 positions to get NAD 83 values with corrected scale. A
conparison with the original NAD 83 coordi nates showed a change
in ellipsoid height of 0.6 nmeters, which was caused by scale
di ff erences.



Tabl e 3.--Transformation
paranmeters, | TRF89 (Epoch 1988. 0)

to NAD 83.

Par anet er Val ue

Tx = X Shift 0.9191 neters

Ty = Y Shift -2.0182 neters

Tz = Z Shift -0. 4835 neters

Rx = X Rotation 0.0275 arc
seconds

Ry = Y Rotation 0.0155 arc
seconds

Rz = Z Rotation 0.0107 arc
seconds

S = Scal e Change -0.0871 ppm [ See

item 3) above.

Apparent in Table 3 is the sinmlarity of the values for the rotations
and scale with those in Table 2. This indicates that the coordinate
system of the original VLBl vectors is very simlar to | TRF

Conmput ations of GPS Data in | TRF

Several other solutions of | TRF have been conputed by the
International Earth Rotation Service since the publication of |TRF89.
As nore and nore data have been collected and included in the | TRF

sol utions, the resulting coordinates and vel ocities have increased in
accuracy. Confidence in ITRF has grown to the point that npst geodetic
organi zati ons throughout the world now use | TRF as a basis for GPS
orbit conputations.

An inportant concept for the GPS user community to understand is that
since GPS precise orbits are referred to | TRF, fixed orbit solutions
of GPS produce vectors that are oriented in the | TRF coordi nate
system However, nost of the user community is working in NAD 83. The
systematic differences between | TRF and NAD 83 must be accounted for
if high accuracy is to be naintained.

Since we are dealing with inter-station vector conponents, instead of
positional coordinates, we need not worry about X, Y, Z shifts. Also,
recall that the scale of NAD 83 was corrected when the high accuracy
GPS survey began. But the X, Y, Z rotations between | TRF and NAD 83
nmust be accounted for. NGS adjustnment software ADJUST does just that.
ADJUST accepts GPS vectors expressed in | TRF as well as other

coordi nate systens as input, then, internal to the program applies
the X, Y, Zrotations to convert to NAD 83.



Tabl e 4 descri bes transformati on paraneters between NAD 83 and sone
nore recent solutions of |ITRF

Table 4.--Transfornmation
paranmeters: | TRF sol utions

to NAD 83.
| TRF93
Par anmet er (Epoch | TRF94
1995. 0) (Epoch = E, in years)
Tx = X Shift 0.9769 0.9738 neters
Ty = Y Shift -1.9392 -1.9353 neters
Tz = Z Shift -0. 5461 -0.5486 neters
0. 02755 +
Rx = X Rotation 0. 0264 0. 00009( E-1996.0) arc
sec
0. 01005 -
Ry = Y Rotation 0. 0101 0. 00077( E-1996.0) arc
sec
0.01136 +
Rz = Z Rotation 0. 0103 0. 00002( E-1996.0) arc
sec

S = Scal e Change 0.0 0.0 ppm



NOAA TECHNI CAL PUBLI CATI ONS
Nati onal Ocean Service/ National Geodetic Survey Subseries

The National Geodetic Survey (NGS), National Ocean Service (NOS),
NOAA, establishes and maintains the basic national horizontal
vertical, and gravity networks of geodetic control, and provides
Government -wi de | eadership in the inprovenent of geodetic survey

nmet hods and i nstrunentation; coordi nates operations to assure network
devel opnent; and provi des specifications and criteria for survey
operations by Federal, state, and other agencies.

NGS engages in research and devel opnent for the inprovenent of

know edge of the figure of the Earth and its gravity field, and has
the responsibility to procure geodetic data fromall sources, process
these data, and nake them generally available to users through a
central data base

Geodetic publications of NOAA, as well as the forner Coast and
Geodetic Survey and NGS, are sold in paper formby the Nationa
Geodetic Information Center. To obtain a price list or to place an
order, contact:

Nati onal Geodetic Information Center (N NGS12)
I nformati on Services Branch

CGeodetic Services Division

Nati onal Ocean Service, NOAA

1315 East-West Highway (Station 9202)

Silver Spring, MD 20910-3282

Tel ephone (301) 713-3242

When placing an order, nake check or noney order, in U S. funds,
payabl e to: National Geodetic Survey. Do not send cash or stanps.
Publ i cati ons can al so be charged to VISA, MasterCard, or Anerican
Express. They can be purchased over the counter at the Nationa
Geodetic Information Center, e-muil: info_center@gs. noaa. gov

An excell ent reference source for all Governnent publications is

the National Depository Library Program a network of about 1,400
designated libraries. Requests for borrow ng Depository Library

mat eri al may be made t hrough your local library. A free listing of
libraries in the National Depository Library Programis available from
the Library Division, US. Governnent Printing Ofice, Washington

D. C. 20401 (Tel ephone: (202)-275-3635).
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SOP: Ellipsoidally Referenced Surveys

1. OVERVIEW

This SOP outlines processing procedures to process an Ellipsoidally Referenced Survey (ERS).
Any errors or concerns with the technical information herein should be addressed to Corey Allen
(Corey.Allen@noaa.gov) or Steve Brodet (Steve.Brodet@noaa.gov).

2. GLOSSARY OF PROCESSING TECHNIQUES

Applanix IN-Fusion Single Baseline “SingleBase” - One dedicated base station is used to process
a tightly coupled solution for short base line processing up to approximately 20km. The base station
may be user-installed or downloaded form the various available networks (CORS/IGS/SOPAC).
Ephemeris corrections should be downloaded to obtain to highest level of precision of ephemeris
available at the time of processing (e.g. Ultra-Rapid, Rapid, Precise).

Applanix IN-Fusion Smartbase — Smartbase processing is based on Trimble VRS technology, the
virtual reference station solution that uses a network of user-installed or continuously operating
reference stations to compute a set of correctors for the roving receiver anywhere within the
network. Smartbase processing requires a minimum of four reference stations surrounding the
rover, but distance to the nearest reference station can be extended to 70km.

Applanix IN-Fusion PPP — Precise Point Positioning is a processing method that provides
positioning accuracies on the order of a few decimetres without needing a reference station. This
application is useful when a reference station cannot be found or installed within allowable distance
tolerances.

Effective Date: 3/7/2011 FOR OFFICIAL USE ONLY Page 2
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3. FLOWCHART OR WORKFLOW

The following figure shows the NOAA MBES Data Processing Flow Chart
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SOP: Ellipsoidally Referenced Surveys

USING POSPAC MMS 5.4 TO PROCESS GPS (SINGLEBASE)
SINGLEBASE STANDARD PROCESING

Step One: Create POSPac MMS 5.4 Template
* File, New Project, double click on <Blank Template>
* Under Project Explorer, right mouse click on Unnamed and select Project settings

* Navigate to the export tab and change the output format to “SBET” with an output rate “specified
time interval” of 0.02 seconds. Unclick “Use Real-Time solution” box.
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* Navigate to the Initialization tab and ensure the Initialize from real time solution box is unchecked
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* Navigate to the Lever Arms and Mounting Angles tab and enter Reference to IMU Lever Arm
values as shown (-0.008, -0.031,and 0.130):

* File, Save Project As Template

» Name the template NOAA_SHIP_Template and click the set as default button, then ok
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SOP: Ellipsoidally Referenced Surveys

Step Two: Create a POSPac 5.4 Project:
* File, New project. Highlight the template created in Step One and click OK

* File, Save Project. Save as Year_JulianDay_Vessel
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Step Three: Import the Raw POS

» Open a windows explorer window and locate the UNFIXED true heave file for the specific
project, vessel and day. Drag and Drop your .000 file into the Plan View window
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» Say OK at the following window. Antenna and Receiver should remain unknown for the POS
data.

* The project definition can remain unchanged. Simply select “OK”
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Step Four: Import raw Base Station GPS data (Rinex Format)
* From the toolbar, select Import or go to Project in the top Menu and then select Import or drag and
drop from a windows explorer window.

* Browse to the appropriate Ground_Control directory and select the Rinex file or files (*.YY0) you
wish to Import. Note: Ensure that the Rinex file or files covers the entire POS file you are
processing where bathymetric data exists
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When the Base Station data is finished importing the Raw Data check in window will appear; here
we need to specify the Manufacturer, Type, and Height of tripod of the GPS Base Station. In this
case it was a Thales receiver, THA800961+REC antenna type, and 2.00m fixed height tripod.

Right mouse click on the base station (in this case named SAND) and select Set Base Station
NOAA
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Then right mouse click on the SAND again and select Coordinate Manager and either input the
NADB83 coordinates for the station obtained from the OPUS report or if it has previously been input
as NAD83 then double click on the appropriate Station ID list to select the station.
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Step Six: GNSS Inertial Processor using Single Base
* From the toolbar select Process or go to Run on the top Menu and then select GNSS Inertial
Processor.

* From the pull down menu across from the GNSS Mode select Single Base
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« In the Initialization tab, ensure the “initialize from real time solution” box is unchecked and click
OK

« Select Run, or click on the Forward, Backward and Combine icon to run the GNSS-Inertial
processor

» Close when completed. The track lines should now appear green representing the data has been
corrected with a fixed integer solution.
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Step Seven: Quality Control Checks for the SBET
» Examine the message logs for the solution. Look for serious errors, cycle slips and data gaps.

» Examine the plots for the solution. There are multiple ways to examine the data. When examining
the data, ensure the HXXXXX_SBET_Checksheet.xlIsx is filled out.
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SOP: Ellipsoidally Referenced Surveys

0 Altitude. Found under “Smoothed Best Estimate of Trajectory” and “Altitude.” Oscillation is
normal as it reflects vessel motion, and usually a general tidal trend can be seen. Large spikes
should not be present; since this is the computed altitude the error will definitely carry through to
any data the SBET is applied too. If large spikes are present, try alternate processing methods. The
following is normal:

Effective Date: 3/7/2011 FOR OFFICIAL USE ONLY Page 17
Hard Copy of this SOP is obsolete- the OCS QMS electronic procedure is valid
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0 RMS Data. Found under “Smoothed Performance Metrics, reference frame” and North, East, and
Down Position Error RMS (m). The RMS should be better than 10 cm (not including the first and

last spike when no line data is being logged). A more realistic error is less than 5cm. The example
below is about .04m.
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SOP: Ellipsoidally Referenced Surveys

0 Calibrated Installation Parameters. Found under “Calibrated Installation Parameters” and then
X, Y, and Z Reference- Primary GPS Lever Arm. These values should settle out to an approximate
value for x, y and z. Record these settled values in the SBET Check sheet and look for similar

values for each vessel.
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SOP: Ellipsoidally Referenced Surveys

0 Number of SV’s. Found under “Solution Status” and then Number of SVs. The number of
satellites should be five or more. Drops in satellite numbers can be seen in the RMS error data.
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SOP: Ellipsoidally Referenced Surveys

0 PDOP. Found under “Solution Status” and then PDOP. The PDOP values are usually below 3.
The FPM has guidelines to keep this number below 6. When PDOP goes above three, there is
correlation in RMS error jumps.
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SOP: Ellipsoidally Referenced Surveys

0 Processing mode. Found under “Solution Status” and then Processing mode. There is a key
below this plot that identifies the numerical value of the processing mode. The best solution would
be a 0, or Fixed NL. Record the values in the SBET Check sheet.
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0 Smoothed- Reference Data. First, click on Tools, NAVDIF. Under the Reference Data file,
browse to H:\Surveys\HXXXX\CARIS\SBET\Year_JulianDay_Vessel\Mission 1\Extract folder and
select vnav_Mission 1.out. Change the Difference Data Output Modulus to 200. Click Difference.
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You are differencing the real-time navigation to the SBET solution. When the difference is done,
close the NAVDIF box. A new plot will pop up, called Smoothed- Reference Data. Look at the
North, East and Down position difference (m) plots. The min/max values for North and East

differences should be within +/- 0.50m. The min/max values for the Down difference should be +/-
Im
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Step Eight: Export, Rename SBET and Associated Error File
* Browse to H:\Surveys\HXXXXX\CARIS\SBET\Year_JulianDay_Vessel\Mission 1\Proc folder.
Locate the sbet_Mission 1.out file and rename it to ““Year_JulianDay_Vessel SBET.out.”

* Browse to H:\Surveys\HXXXX\CARIS\SBET\Year_JulianDay_Vessel\Mission 1\Proc folder.
Locate the smrmsg_Mission 1.out and rename it to Year_JulianDay_Vessel RMS.out
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SOP: Ellipsoidally Referenced Surveys

USING POSPAC MMS 5.4 TO PROCESS GPS (SINGLEBASE)
SINGLEBASE BATCH PROCESSING

Open POSPac MMS 5.4 and select Run -> Batch Manager, see figure 1 below.

_ >

Figure 1

This will bring up the Batch Manager. Click the New Batch icon in the upper left corner of the
pane, see figure 2 below.

O

Figure 2

This will bring up the save file dialog for the batch configuration file. Save the batch configuration
file to the POSPAC folder in the appropriate project,
W:/Control/HORCON/Projects/YY Y Y/OPR-XXXX-FA-YY/POSPAC/HXXXXX
(i.e. W:/Control/HORCON/Projects/2009/0PR-0119-FA-09/POSPAC/H12345)

Use the naming convention sheetnumber_daynumber as in “HXXXXX_DDD.posbat” (i.e.
H12072_172.posbat) for the batch configuration file.
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After saving the batch configuration file the batch editor dialog will come up, see figure 3. Enter the
POSPac project name, of which there is one for each POSPac (true heave) file. Use the name
“YYYY_DDD_VVVV” where YYYY is the year, DDD is the day number, and VVVV is the
vessel. On the POS Data Location tab use the open file button to the right of the First File field to
navigate to and select the appropriate POS data file for the vessel and day (the Last File field will
auto fill with the same file name and only needs to be explicitly set if multiple POS data files were
logged in immediate succession). POSPac files are stored under

\YYYY_Processed Data\GNSS DATA\OPR_XXXX_FA_YY\POSMV_Data\HXXXXX under
the boat day folder as .000 files. ***DON’T USE ANY .000.FIXED FILES- USE THE RAW
POSPAC FILE OTHERWISE YOU WILL HAVE PROBLEMS!***

Project name: YYYY_DDD_VVVV
(i.e. 2010_127_S220)

y Select POS MV file for the
© corresponding vessel and day

\/7
O

Figure 3
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Next select the GNSS Mode Settings tab, see figure 4 below, and change the GNSS Mode to Single
Base Station.

( > Figure 4

The Single Base Settings interface will come up, see figure 5. To the right of the Base File(s) field
click the button with the ellipse, this will bring up the Base GNSS File(s) dialog, see figure 6, click
Add to navigate to and select the rinex file (*.100) for the same day as the POS data. This may
include two files if data was logged after UTC midnight.

Find the rinex file at

11\2010 Processed Data\GNSS DATA\OPR_XXX_ FA 10\Base Station Data\Base Station Nam
e\SSSSddd0.100 where SSSS is the S/N of the GPS receiver.

NOTE: If you have previously added the control mark to the database click the Retrieve from DB
button and select the appropriate station from the dialog that opens. Confirm the height of the
antenna.
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Back on the GNSS Mode Settings tab, if this is the first time using the base station on the computer
enter the NAD83 (not ITRFOO0) Latitude, Longitude, Altitude (ellipsoid height), and station Name
from the OPUS solution or NGS datasheet and Enter the Height of the antenna from the observation
log. This information is located at W:\Control\HorCon\Projects\2010\OPR-0193-FA-10 Behm
Canal\POSPAC\HXXXXX Base Station.xIsx. After all the data is entered click the Add to DB
button to save the position for use with future processing.

Select base station’s Rinex
file for the day, see figure 6

Use the NAD83(CORS96)
coordinates for the horizontal/vertical

Figure 5
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-

Figure 6

After all the parameters are set you can add the project to the queue. Towards the bottom of the
Batch Editor dialog click the Add button, see figure 7 below, this will add the project to the

processing queue.

Figure 7

After the project has been added to the queue all the fields in the Batch Editor will stay unchanged.

Return to the POS Data Location tab seen in figure 3. For each POS data file from the same day for
other vessels update the Project Name and select the appropriate POS data file in the First File field
and click Add towards the bottom of the window.

After all projects have been added to the queue click OK.
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Back in the main window the Batch Manager pane will update with a list of the projects that you
added to the queue and the various tasks that will be performed for each project, see figure 8. Select
the Run Batch button, see below.

O

Figure 8

This will start the processing of all the projects in the queue, come back later to check that they all
successful completed.
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USING POSPAC MMS 5.4 TO PROCESS GPS (SMARTBASE)
SMARTBASE STANDARD PROCESSING
Step One: Create POSPac MMS 5.4 Template

* File, New Project, double click on <Blank Template>
 Under Project Explorer, right mouse click on Unnamed and select Project settings

* Navigate to the export tab and change the output format to “SBET” with an output rate “specified
time interval” of 0.02 seconds. Unclick “Use Real-Time solution” box.
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* Navigate to the Initialization tab and ensure the Initialize from real time solution box is unchecked
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* Navigate to the Lever Arms and Mounting Angles tab and enter Reference to IMU Lever Arm
values as shown (-0.008, -0.031,and 0.130):

* File, Save Project As Template

» Name the template NOAA_SHIP_Template and click the set as default button, then ok
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Step Two: Create a POSPac 5.4 Project:
* File, New project. Highlight the template created in Step One and click OK

* File, Save Project. Save as Year_JulianDay_Vessel
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Step Three: Import the Raw POS

» Open a windows explorer window and locate the POSPac file(s) for the specific project, vessel
and day. Drag and Drop your .000 file into the Plan View window
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» Say OK at the following window. Antenna and Receiver should remain unknown for the POS
data.

* The project definition can remain unchanged. Simply select “OK”
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Step Four: Download multiple base and ephemeris data
* Load appropriate APPA_RSDBS5.out file for specific project.

0 Browse to H:\Surveys\HXXXXX\CARIS\SBET folder and locate APPA_RSDBS5.out. This file
has been modified to include a specific selection of base stations for this project.

0 Browse to C:\Program Files\Applanix\POSPac MMS 5.4. In this folder, there will be an existing
APPA_RSDBS5.out file that includes base stations for the entire United States. Rename this file to
APPA _RSDb5_Original.out so this information is not lost.
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0 Copy and paste the APPA_RSDB5.out file from H:\Surveys\HXXXXX\CARIS\SBET folder into

the C:\Program Files\Applanix\POSPac folder. You should have both an
APPA _RSDB5_Original.out and an APPA_RSDB5.out file. POSPac will only read from the

APPA_RSDBS5.out file.

* In POSPac, Project > Find Base Stations,
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* Enter a search radius of 100 km (can be extended if necessary but want to avoid using stations too
far away)

* Select Preview Network and all stations within the search radius will be plotted in relation to the
POSPac Plan View. A minimum of four base stations is required for smart base processing.

» Select all ephemeris files (broadcast and precise) listed. If the POS data spans multiple Julian days
then two files for each base will be listed — select both.

* Select Download. Some stations might be unavailable; try downloading them again. If still
unavailable then choose another site that can take its place in the network.
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» Select Import. Raw Data Check in will appear, select OK

» When satisfied with the network, close the Find Base Station dialogue.
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Step Five: Ensure base station coordinates are NAD83, not ITRF00
* In Project Explorer pane, under Base Stations, right click and select Properties

» Compare the locations of each base station to those provided in the project instructions (NAD83
values)
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* If the project instructions do not include a base station you have downloaded, you can use the
published NAD83 position from the CORS datasheet to confirm the correct NAD83 coordinates.

0 CORS: http://www.ngs.noaa.gov/CORS/standard1.shtml
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» After confirming the correct locations, Select Run > SmartBase Quality Check. The Quality Check
Summary will appear.
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* Bad or adjusted positions will be highlighted in red or blue. Do not blindly accept adjusted
positions without investigating in coordinate manager. The control station is defaulted to the closest
station, if there are adjusted positions listed, change the control station to the next closest station
and re-run the SmartBase Quality Check processor (do not accept the adjusted positions). It is also
possible to disable a station with a bad position but only if there is another one to take its place in
the network.

* Select “Run the Applanix SmartBase processor” button that has a flashing red triangle to the left.

o If no errors appear, the network was successfully created and a yellow line will surround the
SmartBase network. Proceed to next step
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o If any error logs appear, it is usually because ASB was not satisfied with the Primary base station
either because of gaps or cycle slips. Open the message log and scroll to the Applanix SmartBase
(ASB) Processing log

o Look for “Total full data gaps” over 30 seconds for the primary base station. The Primary base
can be chosen manually. Select another nearby station from the Base Stations list (preferably one
with a 15 second data rate or better.) Right-click on it and select Set Primary.

o There will now be another station flagged in the plan view (if a site other then Control was
chosen). One is the Control and one is the Primary.
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0 Run the Applanix SmartBase Processor again. There may be a warning that the user-selected
primary is not the closest base; ignore it and select NO.

o If no errors occur, the virtual reference station is generated and GNSS Processing can occur.
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Step Six: GNSS Processor
* From the toolbar select the yellow star, GNSS-Inertial Processor

* Ensure the GNSS mode is SmartBase. Click on the properties icon
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« In the Initialization tab, ensure the “initialize from real time solution” box is unchecked and click
OK

» Select Run, or click on the Forward, Backward and Combine icon to run the GNSS-Inertial
processor

» Close when completed. The track lines should now appear green representing the data has been
corrected with a fixed integer solution.
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Step Seven: Quality Control Checks for the SBET
» Examine the message logs for the solution. Look for serious errors, cycle slips and data gaps.

» Examine the plots for the solution. There are multiple ways to examine the data. When examining
the data, ensure the HXXXXX_SBET_Checksheet.xlIsx is filled out.
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0 Altitude. Found under “Smoothed Best Estimate of Trajectory” and “Altitude.” Oscillation is
normal as it reflects vessel motion, and usually a general tidal trend can be seen. Large spikes
should not be present; since this is the computed altitude the error will definitely carry through to
any data the SBET is applied too. If large spikes are present, try alternate processing methods. The
following is normal:
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0 RMS Data. Found under “Smoothed Performance Metrics, reference frame” and North, East, and
Down Position Error RMS (m). The RMS should be better than 10 cm (not including the first and

last spike when no line data is being logged). A more realistic error is less than 5cm. The example
below is about .04m.
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0 Calibrated Installation Parameters. Found under “Calibrated Installation Parameters” and then
X, Y, and Z Reference- Primary GPS Lever Arm. These values should settle out to an approximate
value for x, y and z. Record these settled values in the SBET Check sheet and look for similar

values for each vessel.
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o Number of SV’s. Found under “Solution Status” and then Number of SVs. The number of
satellites should be five or more. Drops in satellite numbers can be seen in the RMS error data.
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0 PDOP. Found under “Solution Status” and then PDOP. The PDOP values are usually below 3.
The FPM has guidelines to keep this number below 6. When PDOP goes above three, there is
correlation in RMS error jumps.
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0 Processing mode. Found under “Solution Status” and then Processing mode. There is a key
below this plot that identifies the numerical value of the processing mode. The best solution would
be a 0, or Fixed NL. Record the values in the SBET Check sheet.
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0 Smoothed- Reference Data. First, click on Tools, NAVDIF. Under the Reference Data file,
browse to H:\Surveys\HXXXX\CARIS\SBET\Year_JulianDay_Vessel\Mission 1\Extract folder and
select vnav_Mission 1.out. Change the Difference Data Output Modulus to 200. Click Difference.
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You are differencing the real-time navigation to the SBET solution. When the difference is done,
close the NAVDIF box. A new plot will pop up, called Smoothed- Reference Data. Look at the
North, East and Down position difference (m) plots. The min/max values for North and East

differences should be within +/- 0.50m. The min/max values for the Down difference should be +/-
Im
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Step Eight: Export, Rename SBET and Associated Error File

* Browse to H:\Surveys\HXXXXX\CARIS\SBET\Year_JulianDay_Vessel\Mission 1\Proc folder.
Locate the sbet_Mission 1.out file and rename it to ““Year_JulianDay_Vessel SBET.out.”

* Browse to H:\Surveys\HXXXX\CARIS\SBET\Year_JulianDay_Vessel\Mission 1\Proc folder.
Locate the smrmsg_Mission 1.out and rename it to Year_JulianDay_Vessel RMS.out
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USING POSPAC MMS 5.4 TO PROCESS GPS (SMARTBASE)
SMARTBASE BATCH PROCESSING

Open POSPac MMS 5.4 and select Run -> Batch Manager, see figure 1 below.

_ >

Figure 9

This will bring up the Batch Manager. Click the New Batch icon in the upper left corner of the
pane, see figure 2 below.

O

Figure 10

This will bring up the save file dialog for the batch configuration file. Save the batch configuration
file to the POSPAC folder in the appropriate project,
W:/Control/HORCONY/Projects/20YY/OPR-XXXX-FA-YY/POSPAC
(i.e. W:/Control/HORCON/Projects/2009/0PR-0119-FA-09/POSPAC/)

Use the naming convention sheetnumber_daynumber as in “HXXXXX_DDD.posbat” (i.e.
H12072_172.posbat) for the batch configuration file.
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After saving the batch configuration file the batch editor dialog will come up, see figure 3. Enter the
POSPac project name, of which there is one for each POSPac (true heave) file. Use the name
“YYYY_DDD_VVVV” where YYYY is the year, DDD is the day number, and VVVVV is the
vessel. On the POS Data Location tab use the open file button to the right of the First File field to
navigate to and select the appropriate POS data file for the vessel and day (the Last File field will
auto fill with the same file name and only needs to be explicitly set if multiple POS data files were
logged in immediate succession). POSPac files from 1010, 1018, and S220 are stored under the
H:\Raw drive under the boat day folder as .000 files. ***DON’T USE ANY .000.FIXED FILES-
USE THE RAW POSPAC FILE OTHERWISE YOU WILL HAVE PROBLEMS!***

Project name: YYYY_DDD_VVVV
(i.e. 2009 _127_S220)

Select POS MV file for the
corresponding vessel and day

Figure 11
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Under the GNSS Mode Settings tab leave the GNSS Mode as SmartBase; see figure 4 below.

Figure 12

Towards the bottom of the Batch Editor dialog click the Add button, see figure 5 below, this will

add the project to the processing queue.

Figure 5

After the project has been added to the queue all the fields in the Batch Editor will stay unchanged.

Return to the POS Data Location tab seen in figure 3. For each POS data file from the same day for
other vessels update the Project Name and select the appropriate POS data file in the First File field
and click Add towards the bottom of the window.

After all projects have been added to the queue click OK.
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Back in the main window the Batch Manager pane will update with a list of the projects that you
added to the queue and the various tasks that will be performed for each project, see figure 8. Be
sure you have the POSPac key in your computer and then select the Run Batch button, see

below.

O

Figure 13

This will start the processing of all the projects in the queue, come back later to check that they all
successful completed.

Effective Date: 3/7/2011 FOR OFFICIAL USE ONLY Page 63

Hard Copy of this SOP is obsolete- the OCS QMS electronic procedure is valid



SOP: Ellipsoidally Referenced Surveys

USING POSPAC MMS 5.4 TO PROCESS GPS (PPP)

Step One: Create POSPac MMS 5.4 Template
* File, New Project, double click on <Blank Template>
* Under Project Explorer, right mouse click on Unnamed and select Project settings

* Navigate to the export tab and change the output format to “Custon Smoothed BET” with an
output rate “specified time interval” of 0.02 seconds. Unclick “Use Real-Time solution” box.

Project Settings
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» Select the “Mapping Frame” option at the bottom to bring the up the below image. It is extremely
important here to specify output datum to NAD83. Unlike “SingleBase” or “SmartBase”
processing where we’ve manually forced POSPac to process in NAD83 by modifying the reference
station position, PPP by nature, doesn’t have reference stations to modify. Since all PPP
downloaded data (Step 4 below) will be ITRF centric, we have to perform a datum transformation
within POSPac upon export to ensure our 3-D navigation solution is relative to NAD83.

Note: This Custom Smoothed Bet datum transformation procedure is also required in “SingleBase”

and “Smartbase” if data is left relative to ITRF during data processing. However this procedure is
not currently recommended.

Mapping Frame Paramekters ﬂ
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* Navigate to the Initialization tab and ensure the Initialize from real time solution box is unchecked
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* Navigate to the Lever Arms and Mounting Angles tab and enter Reference to IMU Lever Arm
values as shown (-0.008, -0.031,and 0.130):

* File, Save Project As Template

» Name the template NOAA_SHIP_Template and click the set as default button, then ok
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Step Two: Create a POSPac 5.4 Project:

* File, New project. Highlight the template created in Step One and click OK

* File, Save Project. Save as Year_JulianDay_Vessel
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Step Three: Import the Raw POS

» Open a windows explorer window and locate the UNFIXED true heave file for the specific
project, vessel and day. Drag and Drop your .000 file into the Plan View window

Effective Date: 3/7/2011 FOR OFFICIAL USE ONLY Page 69
Hard Copy of this SOP is obsolete- the OCS QMS electronic procedure is valid



SOP: Ellipsoidally Referenced Surveys

» Say OK at the following window. Antenna and Receiver should remain unknown for the POS
data.

* The project definition can remain unchanged. Simply select “OK”
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Step Four: GNSS Inertial Processor using PPP

* From the toolbar select Process or go to Run on the top Menu and select GNSS Intertial Processor.

* From the pull down menu across from the GNSS Mode, Select IN-Fusion PPP

W GMSS-Inertial Proc

o 4 Y E°

Settings ]
bizzion: Mizzion 1
GNS5 Mode: IN-Fusion PPP |
RTCM Type 1/9: IN-Fusion SmartB aze
GAMS: IN-Fuszion Single Bazelin
i IN-Fusion PPP
IH-Fusion Autorfimous
POSGMHS55 KAR
POSGHS5 PPP
Status &
Alignment 5tatuz: Unav ailable
Pozitioning Mode: Unav ailable
Pozition Accuracy;
0o .M 0 1.0 10 100m
Message Log ]
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;;l (S WFS

« Select Run, or click on the “All Processing icon Al processing |to run the GNSS-Inertial process.

» When prompted, Run the PPP download.

PPP Data Download =10l x|
Diownload | Product File: Mame Stabuz Frogress Butes Service
h Precise GPS Eph... | igg15755.5p3 Downloaded 1005 244734 IG5 Final j
I Precize GPS Clock | COD15755.CLE_... COCE Final [... j
v Earth Rotation P... | COD15757.ERP CODE Final j
¥ lonosphere model | CEIMOPE0.10M COCE Final j
v F1-C1 DCR F1C11003.0CE CODE DCE ... j

Select |v| Prewview | | --------- E:-:pressMu:nde --------- I Download Cancel Downloads Irmpaort Cloze

* Close when completed. The track lines should now appear green representing the data has been
corrected with a fixed integer solution.
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Step Five: Quality Control Checks for the SBET

» Examine the message logs for the solution. Look for serious errors, cycle slips and data gaps.

» Examine the plots for the solution. There are multiple ways to examine the data. When examining
the data, ensure the HXXXXX_ SBET_Checksheet.xlIsx is filled out.
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0 Altitude. Found under “Smoothed Best Estimate of Trajectory” and “Altitude.” Oscillation is
normal as it reflects vessel motion, and usually a general tidal trend can be seen. Large spikes
should not be present; since this is the computed altitude the error will definitely carry through to
any data the SBET is applied too. If large spikes are present, try alternate processing methods. The
following is normal:
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0 RMS Data. Found under “Smoothed Performance Metrics, reference frame” and North, East, and
Down Position Error RMS (m). The RMS should be better than 10 cm (not including the first and

last spike when no line data is being logged). A more realistic error is less than 5cm. The example
below is about .04m.
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0 Calibrated Installation Parameters. Found under “Calibrated Installation Parameters” and then
X, Y, and Z Reference- Primary GPS Lever Arm. These values should settle out to an approximate
value for x, y and z. Record these settled values in the SBET Check sheet and look for similar

values for each vessel.
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0 Number of SV’s. Found under “Solution Status” and then Number of SVs. The number of
satellites should be five or more. Drops in satellite numbers can be seen in the RMS error data.
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0 PDOP. Found under “Solution Status” and then PDOP. The PDOP values are usually below 3.
The FPM has guidelines to keep this number below 6. When PDOP goes above three, there is
correlation in RMS error jumps.
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0 Processing mode. Found under “Solution Status” and then Processing mode. There is a key
below this plot that identifies the numerical value of the processing mode. The best solution would
be a 0, or Fixed NL. Record the values in the SBET Check sheet.
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0 Smoothed- Reference Data. First, click on Tools, NAVDIF. Under the Reference Data file,
browse to H:\Surveys\HXXXX\CARIS\SBET\Year_JulianDay_Vessel\Mission 1\Extract folder and
select vnav_Mission 1.out. Change the Difference Data Output Modulus to 200. Click Difference.
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You are differencing the real-time navigation to the SBET solution. When the difference is done,
close the NAVDIF box. A new plot will pop up, called Smoothed- Reference Data. Look at the
North, East and Down position difference (m) plots. The min/max values for North and East

differences should be within +/- 0.50m. The min/max values for the Down difference should be +/-
Im
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Step Six: Export, Rename SBET and Associated Error File

* Select Project/Export or click the “Export” Icon

» Select Yes to the following.

* Browse to H:\Surveys\HXXXXX\CARIS\SBET\Year_JulianDay_Vessel\Mission 1\Proc folder.
Locate the sbet_Mission 1.out file and rename it to ““Year_JulianDay_Vessel SBET.out.”

* Browse to H:\Surveys\HXXXX\CARIS\SBET\Year_JulianDay_Vessel\Mission 1\Proc folder.
Locate the smrmsg_Mission 1.out and rename it to Year_JulianDay_Vessel RMS.out
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SBET QUALITY CONTROL PROCEDURES

The scope of this document covers how to check and ensure the quality of a SBET.

Section one ensures that you should even begin the extensive review of the SBET, if you perform
section one and encounter anything highlighted in red, recommend the file needs reprocessing.

In Section two we observe plots of various components that are, or result in the SBET Solution.
Values in red here should be written down and recorded in the QC Log.

In section three we discuss some advanced troubleshooting methods. For additional reading on the
subject, the POSPac Intertial Tools User Manual features some discussion on Solution Quality
Assessment.

0.0 SBET File Review

l. Open Project
e Check that the post-processed solution (Green Solution, PNAV) covers the vast
majority of the real-time solution (Pink, RNAV). If you see lots of pink, then it
might not have been processed with all the needed days of base station data, or
encountered some other problem.
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Check if the correct Base Station(s) (Smart and Single base, rinex format) and
imported POS (.000) files were used, if any.
e In Single-base, Find the base station (it has a flag and looks similar to this:

{3 You can left-click (drag over it) and see its properties. Ensure it is
positioned in the correct location, refer to the HXXXXX_Base_Station file
for reference.

Il.  Check the Message Logs (Toolbar Reports - Message Logs...).

Check each step, and scroll to the bottom, where you should note if the “Termination
status:* is anything other than “Normal. “Fatal errors” would strongly imply a
problem with the SBET.

There should be a “forward” “backward” and *“smoother” processing, in addition to
other steps. If any of these are missing, a processing error likely occurred.

Under POS Data Import, ensure that the POS status reached Full Navigation, or at
Least Fine Align, if it did not, note this.

Under IMU Data Continuity note any reported IMU data gaps. IMU data gaps are
typically caused by a data communication failure between IMU nad the POS
computer.

In Primary/Secondary GNSS Import, note any decoding errors, likely caused by
data communication failures due to corrupted bytes from the GNSS receiver data
stream.
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1.0 Plots

I11.  Select Display Plots either in the Reports tab or the icon in the tool bar.

Check the following categories:
e Under Smoothed Best Estimate Trajectory, Reference Frame, check the Altitude
for any odd behaviors and compare with Total Speed (m/sec).

e To display the Altitude and Total Speed together select both and right click
-> Display Selected...

¢ Odd behaviors in the Altitude should correspond to changes in the Total
Speed. If not make a comment in the Remarks selection of the Processing
Log. Some examples of odd behavior are below
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¢ Jumps in altitude as shown above should be noted and logged. Such offsets
will cause problems if the data is used to produce ellipsoidally referenced
surfaces. Jumps like this can also be highly indicative of other positioning
problems.
¢ Inthe Smoothed Performance Metrics, Reference Frame, select and display the
following simultaneously: North Position Error RMS (m), East Position Error RMS
(m), and Down Position Error RMS (m).
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e Excluding the very beginning and very end of the day, record the highest
error for each of the three in the Processing Log as the H/V value.

o |f the value exceeds 7 cm record in the Remarks selection of the Processing
Log.

¢ Record the peak RMS values for Pitch, Roll, and Heading Error.
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e Smoothed Estimated Errors
e Record the x, y, and z accelerometer bias values
e For Calibrated Installation Parameters, record in the Processing Log the final
positions for: X Reference-Primary GPS Lever Arm (m), Y Reference-Primary
GPS Lever Arm (m), and the Z Reference-Primary GPS Lever Arm (m).
e For each day within a vessel the values should be similar respectively to each
other.
¢ Record the Reference-Primary GNSS Lever Arm Figure of Merit value at the
end of the solution, it should be 100.
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e Under Solution Status, take note of the following subcategories:
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e GAM

e Number of SVs: log the minimum number of SVs observed during the
solution.
0 PDORP: record the highest observed PDOP value. Values less than 3
are preferred The number of satellites and the PDOP are related. If the
satellite count drops below 5, then the PDOP value will exceed 3.
¢ Baseline length (m), this is your distance from the base station, record the
highest value encountered. If the value exceeds 20,000 meters in single base
mode, problems are more prone to occur.
e Processing mode: record the solution in the Processing Log using one or a
combination of values from the Processing mode key.
| Procezzing mode: 0 =Fixed ML, 1 =Fixed WL, 2 =Float, 3 =DGPS, 4 = CiA 5= GPS Mav, 6 =DR |

e Only add 1, 2, or 3 etc besides zero if multiple spikes or the line stays at that
level for a while

S Solution

e Computed A-B antenna separation (m). Take mental note, don’t need to write
anything down.

e Smoothed — Reference Data: In the tool bar select Tools=>NAVDIF or select the

icon

, and a separate window will open.
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- -

- -

In the Data tab, under the Reference Data section, browse to:
W:\Control\HorCon\Projects\200X\Project\POSPAC\HXXXXX\HXXXXX_DDD\HXXXXX_VV

VVV_DDD\Mission 1\Extract\vnav_Mission 1.out.
Under Reference Data Set the Data Output Modulus to 1000. Under the Reference Data section
and click Difference. Once the process is complete, close the NAVDIF window. A new category
(Smoothed — Reference Data) will appear.
¢ For the North vs. East position difference (m) You should be looking at an
approximately round scatter plot — zoom into the most dense area of data
(near 0/0 on the graph) approximate the scatter plot center’s offset from 0/0
on the graph. Note in the Processing Log the N/S and E/W offsets of the
centermost location from zero.
o Alternatively you can look at the North and East Position Differences
individually and infer an individual average.
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[®] Morth vs East position difference [m]
Morth vs East welocity difference [m/sec) o
Marth position difference [m]
East position difference (m)
Down position difference [m]
North velocity difference [m/sec)
East welacity difference [m/zec]
Down velocity difference [mésec)
Rall difference [arc-min)
PFitch difference [arc-min)
Heading difference (arc-min)
2D radial position differences (m)
3D radial position differences (m)
2D radial velocity differences [m/sec]
3D radial velocity differences (m/sec]

-0 -05 -0.4 -03 -0z -01 0 a1 0z 03 04 as
East Posttion Difference (m)
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Down Position Difference (m)
e Record in the Processing Log the approximate trend line for the Down
position difference (m).
0 If unable to determine record as ‘na’

= e e e e o
8 Morth vs East velocity difference [m/sec] a
8 North position difference [m] 0002
® East position difference [m] _0.004
8 Down postion diference m] PP S I |1 B YL T | A R
B North velocity difference m/sec)
®m East velocity difference [m/sec)

[E] Down velocity difference [mfsec)
B Roll difference (arc-min)

8 Pitch difference [are-min) 0014 -
8 Heading difference (arc-min] 006 4----
B 20 radial position diffsrences (m) 008 4----
8 30 radial position differences [m) 0z de--
B 2D radial velocity differences [m/sec) P
= 30 radial velocity differences (m/sec) FE

EilivlF S
0028 4----

EiTiE .
0032 4----
0.0 -
0036 4----
Eilic:E B

004

0.008}----
KNI .
00zt

504,000 505,000 508,000 510,000 512,000 514,000 516,000 518,000
Time (sec)

< >

Ready

¢ 2D radial position differences (m)- generally below 2m is okay.
¢ 3D radial position differences (m)- generally below 3m is okay.
e For any abnormally large spikes, reference the Real-Time Performance
Metrics, North, East and Down Position Errors and compare with the radial
position difference time when there are large jumps in the position
differences. If the radial spike corresponds to any spikes in the Real-time
positions, we can assume the error occurred in real time and was not
introduced by the post-processing.
IV. Inthe Processing Log note in the Recommendation one of the following:
e Apply
e Apply with inspection
e Needs Trouble shooting
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2.0 Advanced Troubleshooting and considerations

If you encounter any major issues, one of the key questions will be determining if the vessel
was even logging data during the time of the error. Using a utility
(W:\Control\HorCon\Utilities\ GPS_Seconds.xlsx) we can easily convert the time displayed
on a plot or in the overview screen into a time that we can compare to .hsx logging times (or
vice versa). If the error is within logging times, inspect the lines manually and using directed
editing techniques.

Files can be reprocessed in POSPAC using alternative processing methods (PPP, Smartbase,
Singlebase) and without using batch and have the resultant solutions compared using plots,
or navdiff the resultant shets. Start and end times of processing can also be altered to not
process certain parts of the file.

Errors apparent in a given vessel can be compared across the same vessel during
different days, or compared to other vessels at the same time. 3-4 vessels
experiencing a similar error at the same time could imply external sources
(Atmosphere, satellites, etc), whereas a recurring error on one vessel may be
indicative of an internal issue (settings, hardware, software).

Effective Date: 3/7/2011 FOR OFFICIAL USE ONLY Page 99
Hard Copy of this SOP is obsolete- the OCS QMS electronic procedure is valid



SOP: Ellipsoidally Referenced Surveys

SETTING UP A SMARTBASE NETWORK

Research Stations

The first question you need to evaluate when trying to plan for a Smart Base project is how many
stations are roughly within 200 km of your working grounds? CORS is your best and easiest to use
resource if you are working in the lower forty-eight states, so | would start by checking out the
following website:  http://www.ngs.noaa.qov/CORS/

Ideally you would like six to twelve stations completely surrounding your survey to ensure a strong
network if data becomes unavailable from one or two stations throughout your survey. Also, it is
best to look for stations with recording intervals of 1 to 15 sec, but 30 sec stations have been used in
the past with variable results.

UNAVCO stations are a collection of plate boundary observatory (PBO) locations and also tend to
be in useful locations across Alaska. The problem with using these stations, however, is that while
CORS stations have NGS Data Sheets and good published positions, the UNAVCO stations tend to
have unreliable published positions in ITRF coordinates while we are using NAD 83. Therefore, in
order to make use of the UNAVCO or PBO stations, extra steps are required to download data from
the stations directly and submit it through OPUS (http://www.ngs.noaa.gov/OPUS/) in order to have
a reliable position. Good websites for checking out PBO site locations are both the UNAVCO site
(http://pboweb.unavco.org/) and the SCRIPPS Orbit and Permanent Array Center or SOPAC site
(http://sopac.ucsd.edu/projects/pbo/).
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Survey @
pA¢

The thirteen CORS stations selected above all meet the 200 km gistance requirement, have
recording intervals more frequently than , and provide a eometry, completely
surrounding the survey working grounds. Fowever, in the next step where you test the network for
good internal consistency and no POSPac position adjustments, the two stations circled in yellow

had to be thrown out. With those westernmost stations included, the Smart Base Network was
constantly making adjustments.

Creating the APPA File

The APPA file is officially titled “APPA_RSDBS5.out” and is located in C:\Program
Files\ApplanixX\POSPac MMS 5.4 on your local machine. This file is a listing of all base stations
POSPac is looking to download data from. The original file located in the C:\ drive contains nearly
five thousand stations from many sources including CORS, UNAVCO, and IGS for example.

1 REFERENCE_STATION DE

2 Wersion #2.780 - Applanix Database

sgitationlane, seitationful lNane ,eCoordice, d{Coord,d¥Coord, dZCooxd, &Vel ,d¥Vel ,dZVel, eDatun, i¥ear ,iMonth, ilay,i0Tear . iUMonth, ilhay , iNb0fServices, seGN35_Services
ACO3,ACO3, NETWORE_ADJ,-2838815.193,-1516045.841,5487572.521,0,0,0,MAD83,2005,1,1,2003,1,1, 1, UNAVCO
LCO6,ACO6, NETWORE_ADJ , -2613462. 790, -1566562. 172, 5487806. 681,0,0,0,AD83,2003,1,1,2003,1,1, 1, UNAYCO
ACL8,ACLS,NETWORE,_ADJ,-209:20654.605,-1536675. 566,5439867,229,0,0,0,ADS3,2003,1,1,2003,1,1, 1, UNAVCO
AC35,AC3S, NETWORE_ADJ,-2843Z215.734,-1559463. 280,5465731.435,0,0,0,MADS3,2003,1,1,2003,1,1, 1, UNAVCO
4C39,AC39, NETWORE_ADJ,-2951218.112,-1543249. 832, 5421552. 480,0,0,0,AD83,2003,1,1,2003,1,1, 1, UNAYCO
AC47,ACA7,NETWORK,_ADJ,-2832475.175,-1466717.825,5505507.916,0,0,0,ADS3,2003,1,1,2003,1,1, 1, UNAVCO
10 AC59,AC5S,NETWORK_ADJ,-2300772. 334,-1440891. 433, 5476476, 418,0,0,0,MAD83,2003,1,1,2003,1,1, 1, UNAVCO
11 AV02,AV02,NETWORE_ADJ,-2916880.628,-1458859.181,5463145.147,0,0,0,N4D83,2003,1,1,2003,1,1,1,UNAVCO
1z HELD,ZELD,NETWORK_ADJ,-2862120.600,-1540664.880,5469360.075,0,0,0,ADS3,2003,1,1,2003,1,1,1  UNAVCO

@1 m g

o
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TRIMBLE NetR9 SETUP

Setting up new Trimble NetR9 receivers

Start with a computer (field laptop) which is set-up with appropriate subnet mask and gateway.
Turn on NetR9 receiver, press enter, press down, press enter, Disable DHCP, Enter appropriate IP
address, subnet mask and gateway. Restart the receiver.

The computer should now connect to the receiver with the correct IP Address.

Under the security tab select Enabled with Anonymous Access, and give the anonymous user File

Download capabilities. Login as the administrator (User=admin, Password=Password), Change
Password to Admin.

Start at the top and follow the screengrabs:
Ignore Receiver Status
Under Satellites
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O8>

Click disable all, enable all, ok. This gets rid of the check boxes on ignore health.
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OC8 >

Click disable all, enable all, ok. This gets rid of the check boxes on ignore health.

Keep Defaults
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OCo >

Click disable all, enable all, ok. This gets rid of the check boxes on ignore health. See NOTE made
under Tracking section.
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Under Data Logging

Click on Default; Click enable, set; schedule = continuous, duration = 1440 (this equals 24 hours),
Measurement Interval = 1 sec, Position interval = 5 min, Name style = SystJJJh. All other defaults
okay. Press Ok

Click New Session and set the following settings; Session name = 30Min, Enable, Schedule =
continuous, Duration = 30, Measurement Interval = 1 sec, Position = 5 min, Path Style = Date,
Name Style = SystJJJhmm, Press ok.

Under Receiver Configuration
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Enter Antenna Serial Number and Antenna Height = 1.5

Station Name = Site?
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>
>

Enable GPS L5 and GLONASS L2. NOTE: enabling the logging of GLONASS and GALILEO
will increase the file size. Until more testing is done it is currently not allowed to use these systems
for processing. FA will log these systems in addition to GPS L5 for testing purposes for the 2011

season.

Set PDOP Mask value = 6.
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Disable 1PPS, enable VFD Rotation (This will make the screen easier to read when mounted)

Keep defaults
Under 1/0O Configuration
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ETHERNET RADIO CONFIGURATION
(to enable remote downloading of basestation data)

IP Configuration via Serial

This can also be done via the web interface but only if you already know the radio’s IP.
1. With the radio off
2. Attach PORTL1 on the radio to COML1 on the computer via RS232 9 pin cable
3. Open HyperTerminal and configure the session to connect on COM1
a. Port Settings: 19200, 8, None, 1, None
4. Power on the radio, in HyperTerminal it will first ask if you want to enter setup, type “y”
5. Next it will prompt you for a password, default password is “admin”
6. Select the IP Setup
7. Configure the station to have the following values

a. IP Address 10.48.19.##4# (see IP table)
b. Subnet Mask 255.255.255.0

c. Default Gateway 10.48.19.1

d. Web Port 80

e. Management VLAN ID 0

f. Data VLAN ID 0

g. Tagging N/A

8. After making these changes exit the interface, and reboot the radio

Radio Setup

1. Confirm computer’s NIC setup, IP should be in the 10.48.19.XXX subnet.
2. Open IE Browser and navigate to “http://10.48.19.###” (radio’s IP)
3. Use the menu on the left side of the page to navigate to “Radio Setup”

Eall

Under “Operation Mode” configure the following
a. Network Type: Multi-Point
b. Modem Mode: Gateway
5. Under “Multipoint Parameters” set the “Network ID” to 250
6. Save changes
7. On radios running firmware version 2.15 you will have to do an explicit reboot as well
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REMOTE DOWNLOAD OF BASE STATION DATA

Connecting to the Ethernet radio

An Ethernet radio is used to communicate with the NetR5. The radio allows for communications
with the base station as if it were part of the internet. Make sure the radio is connected to power and
has the antenna plugged in. The radios have established a connection if the Carrier Detect (CD)
light on the radio is green. Connect the computer to the radio with an Ethernet cable and start a web
browser. Radio settings can be checked using the IP address of the radio in a web browser.

Connecting to the basestation

The NetR5/R9 has a web page interface that allows for easy access through a web browser.
Communications are established by typing the ip address of the base station into the address bar as
shown below here:

The NetR5 website will come up with a menu on the left hand side that looks like:

Frmare |
o |

This menu gives access to all the NetR5 settings and functions.

Start / Stop Logging
Select “Data Logging” the left hand menu:
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- Data Logging

File System  Size Available  Auto Delete

linternal |57 33 MB|53.37 MB | 93% r Format
[External r Format
Session Schedule Status Enable
DEFAULT, Always Disabled r
CANOE Daily 14:00 Logging v

720 Min. | /Internal/10661260A.T01

By clicking or unclicking the check box next to the station name (CANOE in this case) under the
Enable column logging is started or stopped. This session has the correct setting for the base station
(elevation mask, logging rate, antenna height, etc) preset.

Downloading Data

Under “Data Logging” on the menu select “Data Files”:
Receiver Status

Satellites

Data Logging

Receiver Configuration

/O Configuration
Bluetooth

Network Configuration
Security

.
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I Directory: /Internal
I 1.1 | Top Level Directory

] «» Parent Directory
Filename Created Size
Select All| [%]
Delete Selected Files | [%]

2009-05-06T15:39:39 GPS | 2.611 MB

I Click here
N

Files that are in bold can be downloaded. The file that is currently being logged cannot be
downloaded until logging is stopped. To download data select the desired file. Internet Explorer will
object, right click on the bar under the address bar and select “Download file...”.

Other things of interest

When logging onto the Base Station there are several attributes to take note of and log. These
include the battery level, the amount of memory and PDOP. These can all be found in the Receiver

Status menu. Click Activity:
Satellites Tracked:10

GPS (8): 2,4, 7,13,16,20,23, 25
SBAS (2): 135,138

Data Logging:
/Internal/10661260A T01

There are currently no active /O streams

Temperature: 26.65°C
Runtime: 1 Day 05:14:29
Power Source: Port 1

Disk: [53821KB/58708KB]
Port1:  [76%/12.67V]
Port2:  [0%/0.64V]
Battery 1. [92% / 8.10V]
0% 100%

Take note of the Disk numbers (this is the amount left). Log the voltage on Port 1 daily.

Click on the Position Tab:
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Position:
Lat: 55° 54" 8.54613" N
Lon: 132° 9 21.05874" W
Hgt: 3496 [m]
Type: SBAS
Datum: WGES-84

Position Solution Detail:
Position Dimension: 3D
Position Type: SBAS

Maotion Info: NIA
Augmentation:  GPS

RTK Solution:  N/A

RTK Init:  MN/A

RTK Mode:  MIA

RTK Network Mode: MNIA
Age of Corrections: NIA

Height Mode: Normal

Satellites Used:6
GPS(6): 4, 11,20, 23, 31, 32

Satellites Tracked:8
GPS(6) 4,11 20 23 31,32
SBAS (2) 135,138

Receiver Clock:
GPS Week: 1530
GPS Seconds: 334931
Offset: -0.27992 [msec]
Crift: -0.18123 [ppm]

Multi-System Clock Offsets
Master Clock System: GPS

Velocity:
East 0.02 [m/s]
Maorth: 0.01 [m/s]
Up: 0.00 [m/s]

1-Sigma Estimates:
Harizontal: 1.496 [m]
East 0.643 [m]
Morth: 1.237 [m]

Up: 2.057 [m]

Dilutions of Precision:
PDOP:24
HDOP: 1.4
VDOP:19
TDCP:14

Log the PDOP and number of satellites used when beginning and ending a file.

Information on each Instrument:

Instrument IP Address Corresponding Instrument
Ship Radio 10.48.19.150 Ship’s Network

Shore Radio 1 10.48.19.151 Bert (Trimble 1066)
Shore Radio 2 10.48.19.152 Mobile Radio

Shore Radio 3 10.48.19.153 Ernie (Trimble 1054)

Bert (Trimble 1066) 10.48.19.155 Shore Radio 1

Ernie (Trimble 1054) 10.48.19.156 Shore Radio 3
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CONVERTING TO RINEX

Run Convert to Rinex this can be found either on the desktop or on the start menu at All Programs -
> Trimble -> Convert To RINEX

File -> Open to open the .t01 files which are found in
1:\2010 Processed_Data\GNSS_DATA\[*Project_Name*]\Base_Station_Data\[*Base_Name*]
This will take a little bit to load, it will say Scanning...

Scamming 10841120 TOLl. ..
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Once loaded change the Agency and Observer name to NOAA and NOAA Ship Fairweather (see
the image below). Also confirm that the Marker name is the same as the last four of the serial.

B3 Convert to RINEX

File  Tools  Help

L |

= A2010_Processed Datahl
10541120,

B

RIMEX file path

RIME file werzion

RIMEX MET A8l file generation rule

1 Rinex Header Settingz - Hequired

I:A2010_Processed_Data\GMH55_DATA
ver2ll
doMotCreate

Agency
Obzerver name
Program run by
2 Binex Header Settings
tarker approsimate 4, meters
b arker approximate ', meters
Marker approximate 2, meters
M arker name

b arker number

b arker type [v3.00 anly]

3 Antenna Settings
Antenna measurement point
Antenna offzet, meters
Antenna zerial number
Antenna type

HOAA
MOAA Ship Fairweather
convertl oHINEA

-2407487.7154
-2748702.3568

Zephyr GRodetic 2

B 4 Receiver Settings
Receiver zenial number 4910KE1054
Receiver type HetR5
Receiver version Yerzion 4.03
H 5 Converzion Control Settings
Antenna iz initially moving False
T T e TR S v
Obzerver name
L4 >
Scanning 105411Z0.TO1. .. Completea!
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Once happy click on File -> Convert Files, the status window will say Converting, again this takes
a little while and will update to say “SUCCESS!”” when done.

Scamming 1054110 TOl. .. Complete!
Conwverting 105411FZ0_TOl. .. SUCCESS!
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SUBMITTING TO Online Positioning User Service (OPUS)

Why Submit?

OPUS is a great tool for getting a very precise position for centimeter accuracy. We use the
position calculated by OPUS to correct for inaccuracies in the acquisition platform’s position. In
addition, Field Procedures say we are required to obtain an OPUS solution from at least a 4 hour
observation on a benchmark. We like to submit our base station position to OPUS when we first
acquire data and then do a weekly submission in order to verify the position is still accurate during
hydrographic acquisition. In order to obtain a precise solution, OPUS can take up to 19 days to
obtain a final precise orbit because it uses a combination of seven analysis centers worldwide and
these centers take several days to upload the orbit data to the International GNSS Service (IGS).

Obtaining a Solution

After creating a RINEX file from the base station receiver raw file you may then submit the file to
OPUS in order to get a precise position solution. If bandwidth is an issue, as it usually is aboard the
ship, you may need to decimate and zip the RINEX file in order to get the file size smaller to
achieve a reasonable upload time (a 3 mb file usually takes about 3-5 minutes to upload on the
ship).

Once your RINEX file size is reasonable, got to the OPUS website at:
http://www.ngs.noaa.gov/OPUS/

From the figure above follow these steps:
1. Enter your email address

2. Browse and select your RINEX file, this is your .100 file
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3. Select your antenna type from the dropdown, for FA this will either be the Trimble antenna
(TRM55971.00 Zephyr GNSS Geodetic Model 2) or the Ashtech antenna
(ASH701975.01AGP Geodetic IV, Rev. A with groundplane)

4. Enter your antenna height. This will usually be 1.5 meters, which is what you set your
tripod height to.

5. Click the OPTIONS button. This will take you to the following page

Leave all numbered sections as is except for 4. Extended Output and 5. Draft XML Output. Choose
“Yes” for both of these and they will be included in the OPUS solution emailed to you. At the
bottom section 8. Choose “STATIC” if your observation was more than 2 hours. This will give you
a more precise solution.

After choosing “STATIC” you should receive a pop-up window stating that your file is being
uploaded. Once it is uploaded, it will take some time for OPUS to create a solution. Check your
email in about 15 minutes and you should receive a solution. Once you do, open the email and save
all the text as your OPUS solution. The solution will give you useful information like your antenna
name, antenna height, start and stop times of the observation, and most importantly, your latitude,
longitude, and ellipsoid height (this position is what you will input for your base station coordinates
in POSPAC when processing true heave data).
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Submitting to the OPUS Database
You first must register with OPUS in order to submit to their database. To register go to their main
page: http://www.ngs.noaa.gov/OPUS/ and click on their “View” tab

Scroll down the page and complete the following steps:
1. Select your agency from the dropdown menu, this should be National Oceanic and

Atmospheric Administration
2. Enter your email address
Read the “Terms of use” and check the accept terms button
4. Once complete, click the “Register” button

w
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If your registration was successful, you should see the information above and you are now

registered with OPUS DB.
Now you are ready to submit. Go through the same process as above for obtaining a solution with

the email you used to register with OPUS DB. The only difference is that on the OPTIONS page,
under section 8, click on the “Yes, publish” button and then click “STATIC”.

After your RINEX file finishes uploading, you should get the step 2 of 4 page, “ldentify your
Mark”.
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From the page above, double check your OPUS entries and click on one of the publishing options,
New Mark, Recovered Mark, or Abort. In most cases you will be describing a new mark so you can
click the button marked, “Describe New Mark”. If any of your OPUS entry information is
incorrect, you can click the “Abort” button and start over. Once you click on “Describe New Mark”
you should get the page below, “Step 3 of 4: Describe New Mark”.
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Make sure to fill in all required fields:

e Designation: This is a user-friendly identifier, unique for the area and usually descriptive of
the mark stamping and/or location. For tidal benchmarks, you can find the designation
under the tides COOPS submission under “Bench Mark Descriptions” in the W drive.

e Stamping: Is the unique lettering, if any, manually added to the mark by the original
marksetter. For tidal benchmarks, you can find this in the “Bench Mark Descriptions™.
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e Type: This describes the surveyed object. For our purposed, the most likely type is a
“D=Disk”. When you choose disk, you will then be given a dropdown to the right of
“Type” which you need to identify the type of disk. In most cases this will be “DB=Bench
mark disk”.

e Setting: This is the structure to which the mark is affixed. This can sometimes be found in
the “Bench Mark Descriptions” described above. The most common will be:

0 2 = Object driven into ground
0 66 = Inrock outcrop or ledge
o 80 =1Inaboulder

e Descriptions: Describe new marks by noting distances and directions to local witnesses
(posts, trees, curbs, etc.) along with any other salient features (recommended approach,
hazards, etc.). This will help future surveyors recover and assess the suitability of your
mark. In most cases you can find a suitable description in the “Bench Mark Descriptions”
described above.

e Close-up photo: Use the browse button to select a close up photo of the mark

e Horizon photo: Use the browse button to select a horizon photo of the mark

For optional fields, make sure to fill in at least stability and magnetic:
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e Stability: This is your best estimate of the mark's ability to maintain a long-term, constant
position relative to other local features. Consider the setting quality, soil type, threats from
construction or traffic, etc.

e Magnetic: Copper, brass, aluminum, and stainless steel are not magnetic. Alloys containing
iron, cobalt or nickel are magnetic. Use a magnet to test. Most of the marks we recover are
not magnetic.

Once this is complete, click on the “Continue” button.

You should then see a page which states, “Almost Done...”. At this point check for an email from
OPUS. In the body of the email, you should be prompted to click on a link to verifty that the
information you provided is correctly presented. Click on this link.

You should be sent to the “Step 4 of 4: Approve your Datasheet” page. From this page, you can
either publish, edit, or abort your submission. If you feel your submission is complete and correct,
click on the “PUBLISH” button.

OPUS will then review your submission and if accepted, will publish the database submission on
their website. You can check to see if your submission has been published by click on the “View”
tab from the OPUS main page. You can then click on one of the many ways you can retrieve
datasheets. The most common would be by “email of submitter”. Once it is published it should
look similar to the following:
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Congratulations, you have now successfully submitted a mark to the OPUS database for all to see.
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USING POSPAC MMS TO COMPUTE VESSEL OFFSETS

Computing Vessel Offsets with POSPac
(Calibrated Installation Parameters)

For 2011 testing we are post-processing the POSMV files recorded during the GAMS calibration to
refine offsets between the IMU reference point and the primary antenna phase center. The GAMS
calibration data is used because in general it is the most dynamics that a vessel will see. This helps
resolve the offsets quickly in post processing and to a higher degree of confidence.

Reference Station

All of the GAMS calibrations were run in the North end of Lake Washington in the vicinity of the
NOAA Sand Point facility. Because of the proximity to the CORS station SEAI
<http://www.ngs.noaa.gov/cgi-cors/corsage.prl?site=SEAI> SingleBase is deemed the most
appropriate processing method.

POSPac does not download the full data rate of station SEAI (1 sec). It will need to be manually
downloaded. To get a trimmed file (save bandwidth) use the User Friendly CORS website
<http://www.ngs.noaa.gov/UFCORS/>. While the site requests that 1 second data requests be
limited to 2 hours there is no restriction if additional is needed. Grab only what you need but don’t
hesitate to grab extra, it’s all in the family.
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File Management

All the POSMV files from the GAMS calibration will be stored by vessel in:
T:\Testing_2010\GNSS\POSMV Files\GAMS_Calibrations
or
\\Survey-server\Survey 3\Testing_2010\GNSS\POSMYV Files\GAMS_Calibrations
A folder has been created on the W drive for the POSPac projects and base station data, again by
vessel:
W:\Control\HorCon\Testing_2010
or
\\Survey-server\Hydro_1 (H)\Control\HorCon\Testing_2010

Processing

The general idea is to process the POSMV data multiple times at the 10cm confidence level. Each
time inputting the resulting calibrated installation parameters as the initial lever arm offsets for the
following run. This is repeated until the resulting offsets vary by only millimeters.

To process drag, both files (Rinex and POSMV) into POSPac. You will not need to enter
coordinates for SEAI because the NAD83 coordinates are in the Rinex header and it really doesn’t
matter because as with ERDDM we are concerned with relative differences not absolute.
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Make sure to select the base station and in the right click dialog click “Set Base Station.” For the
first run you will also want to confirm the lever arm offsets in the Project Settings -> GNSS-Inertial
Processor -> Lever Arms and Mounting Angles. The “Reference to IMU Lever Arm” should not be
changed but should be checked; X:-0.008, Y:-0.031, Z:0.130 (unless processing S220 which does
not reference the mark on the IMU).
Run backward, forward and combine. After the first run do a basic QC check, make sure there
aren’t gaps in data, low numbers of satellites, or terrible DOP in the solution, review RMS... get
confident in the dataset.
To get statistically robust final values for the calibrated installation parameters there is a handy
macro that runs in Pydro. Open Pydro, on the menu bar select Misc -> Run Macro. The Macro is
located in:

W:\Control\HorCon\Pubs-Refs\Scripts

Navigate to and check the project name, click descend/confirm, this will find the “Proc” folder.
Then click Apply, it will look like nothing happened. In the background behind the Pydro window
is the command prompt associated with Pydro the macro will have output the data in this window.
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BEE
<

|2 Pydro

C:wProgram Files“Pydro“Sourcerecho off

Puydro version 9.18 (»2824) Mo updates available.
Mo update to perform

A

initialize geotransz engine = A

Microzoft Windows XP ?2.18 {(r2824>

Licenze: B294cBabhB26f318325 exp:2/2811

Read Reglatry- HREY LOCHL HHCHIE\EOFTUHRE\CHRIE\HIPE\E i

1

W: \Cuntrul\Hurﬂun\Pruaectﬁ\EEE?\OPR —-P357-FA-B? Hachemak Bay-POSPAC~H1288%7_2
28.2007_228_S5228~Mission 1~Procwiincal Mission 1.out
— Stats computed from last __18__ minutes of file:
xMean,.yMean.zMean = —11.849.8.889,-13.171
¥Std,.vStd.=8td = 8.1Ye—004,.2 95%e-0084 .5 _8Ye—004

Note the values and standard deviations, rinse and repeat. Input these new values to the lever arm.

Example offset processing for vessel 2805

X Y Z
Start [ -0.806 -0.682 -3.623
Trailing 10 minute average

X X Std Y Y Std Z Z Std
Run 1 -0.787 0.000689 -0.73 0.000215 -3.153 0.000758
Run 2 -0.788 0.000692 -0.73 0.000198 -3.138 0.0013
Run3| -0.788 0.000692 -0.73 0.000197 -3.137 0.00133
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ELLIPSOIDALLY REFERENCED DYNAMIC DRAFT MODEL (ERDDM)

Analysis Using the Pydro macro ProcSBETDynamicDraft

Step One: Establish desired tide package in Pydro: (a) Discrete Zoned Tides or (b) TCARI

1 (a) If you have Discrete Zoned Tides (ZDF + .TID(s))

From Pydro's main menu, Tides > Load Zoning Data (.ZDF)

Tides > CO-OPS Office Tools > Download Zoned Tide Stations

- Pydro console window will echo a "trying to download stations™ list

- If you have problems, or you don't otherwise have internet access, you can consult with HSD and
your HSTP representative to obtain a stations file for your ERDDM analysis. Such a station file is
loaded "manually” via Tides > CO-OPS Office Tools > Load Zoned Tide Stations

<OR>

1 (b) If you have TCARI Tides

From Pydro's main menu, Tides > Load TCARI Data (.tc)

Step Two: (a) Examine discrete or TCARI zones and (b) load/view water levels

2 (a) To see the ZDF or TCARI zones in a Chart Window

Window > Show/Hide > Display Properties (or F3 key if Pydro window frame has focus)
- Plotting tab: Check "Tides" in Auto Draw & Middle Button Mouse Draw

- Press the Zoom to Chart Overview (Globe toolbar button) on Chart Window, then Middle Button
on mouse to refresh the display--drawing zones

<AND>
2 (b) To load water level data for both discrete and TCARI zones in a Chart Window
Tides > Load WL Data or Tides > Download WL Data, for the applicable to ERDDM data

acquisition
- QC WL data via Tides > Show WL Graphs
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Step Three: Analyze the ERDDM data via the Pydro macro

3 Misc > Run Macro - browse/select ProcSBETDynamicDraft.py (should be present in the default
directory in the dialog: <Pydro install path>/Lib/site-packages/HSTP/Pydro/Macros)

- Browse to select ERDDM POSProc SBET file--either binary (.out) or ASCII (.txt) will work

- Enter year-doy of start of ERDDM data

- Enter start,end times [units are seconds-of-GPS-week]; it defaults to the min/max of the SBET file
- The data analysis graphs and dynamic draft table appropriate for use in CARIS HIPS will pop up
shortly thereafter

Notes:

- While both binary (.out) and ASCII (.txt) POSProc SBET data files may be used, height
uncertainty data is not available in the binary files. If you want to use the POSProc height
uncertainty, export SBET data to ASCII and process that with the ProcSBETDynamicDraft.py

- The tide correction may take some time, especially in the case of 200 Hz (undecimated) SBET
data. The Console Window that accompanies Pydro will show progress, counting through the
number of tide look-ups performed. Left at 200 Hz, an dynamic draft calibration SBET file may
require on the order of one million tide "corrector™ look-ups.

- Figure 1 Ellipsoid Height [m] vs. time is for entire SBET file data; i.e., to help ascertain start,end
times to clip the SBET data for all subsequent analysis and plots. Note that this height plot is
uncorrected for tide; compare to subsequent graphs which are tide corrected. You may have to
select the Figure 1 tab on the Windows system task bar to make it visible on your Desktop.

- Figure 2 Altitude [m] is corrected for tide and records are per start,end clipping.

- Figure 3 is the resulting speed vs. draft appropriate for use in a CARIS HIPS HVF.
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Figure 1
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Figure 2 - NO TIDES; 4th-order fit, nominal two-times standard deviation +/-0.6m
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Figure 2 - YES TIDES; 4th-order fit, nominal two-times standard deviation +/-0.3m

Figure 3 - YES TIDES; 4th-order fit, dynamic draft table
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LOADING ATTITUDE/NAVIGATION IN CARIS

Step One: Load Attitude/Navigation Data

Note: It is best to this one day or vessel at a time. If you have a day with multiple SBET’s add them
starting with the end of the day and loading the first one of the day last.

* In HIPS, select the lines to be loaded with Attitude/Navigation

» Select Process, Load Attitude/ Navigation Data...

* Click “Add” and select the SBET.out file(s) that correspond to the same time period as the lines
being loaded. SBET(s) are found in:

H:\Surveys\HXXXXX\CARIS\SBET\Year_JulianDay_Vessel\Mission
1\Export\Year_JulianDay_Vessel SBET50Hz.out

Effective Date: 3/7/2011 FOR OFFICIAL USE ONLY Page 139
Hard Copy of this SOP is obsolete- the OCS QMS electronic procedure is valid



SOP: Ellipsoidally Referenced Surveys

Load Navigation, Attitude Data x|
— File Lizt
FAPOSAZE0RDM033N2009_053_2303_SBETA0Hz. out

Add...

Remove

i

4 [+

— Reference Week

¥ Default I Sielect Day |

— Import Data

v Mavigation I—EI'IEI zeconds
v Gyro Iililll? zeconds
[¥ Pitch Iiﬂlﬂ gaconds
V¥ Ral Iililll? seconds

¥ GPS5 Height I 002 seconds

¥ Load data for lines that are only partially covered.

V¥ Allow gap between data records max I 0.03 seconds

[T Apply Time offset: I 000 zeconds
[ Apply Time Buffer: I 0 seconds

Load | Cancel | Help |

* Enter 0.10 seconds for Navigation, 0.02seconds for GPS Height and Allow gap between data
records max of 0.08seconds

— Ophions

» Select “Load”. Check the HIPS Output window to ensure no errors are reported. A correct
application will not report an error.

* After applying PPK, lines will need to be re-examined using the Navigation Editor tool in CARIS.
Be sure to check for spikes or gaps in Navigation data.
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LOADING ERROR DATA IN CARIS

* Select applicable survey lines

* Process, Load Error Data...
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* Click “Add...” Browse to H:\Surveys\HXXXXX\CARIS\SBET\Year_JulianDay_Vessel\Mission
1\Proc\Year_JulianDay_Vessel RMS.out

Load Error Data |

— File List
d4WPREAPOSS 230450 09842009098 2804 RS, out

Add...
Remove |
\ [»]
— Reference ‘Week
¥ Default I Select Da_l,ll
— |mport D ata

[V Fosition RS 1000 seconds

W

v Down RS 1.00 seconds
v Roll kS I 1.00 zeconds
W Pitch RMS 100 seconds
¥ Guro RiMS I—'I':":I seconds

— Dptions

L

I¥ &pply to all partially covered line.

*

¥ Allow gap between reconds.

b awirnamm: 00200 secomds

[ Apply Time affset: 0.00 seconds

Load | Cancel Help |

* Under the “Import Data” dialogue box check Position RMS and Vertical Down RMS with a time
of 1.00 seconds

* Under the “Options” dialogue box select Allow gap between records with a maximum time of
0.08 seconds

* Click Load

"

Note: Load Error Data step should be done for both ERS and non-ERS projects. For ERS projects,
the post-processed POSPac RMS file (smrmsg) should be used. For non-ERS projects the raw POS
PCS file (.000) should be used.
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* Be sure to check the CARIS Worksheet window and view the summary report for all survey lines.
Make sure there are values for all the areas checked above, and no error reports.

Effective Date: 3/7/2011 FOR OFFICIAL USE ONLY Page 144
Hard Copy of this SOP is obsolete- the OCS QMS electronic procedure is valid



SOP: Ellipsoidally Referenced Surveys

COMPUTE GPS TIDE IN CARIS

Compute GPS Tide

Note: HSD should be providing the VDatum solution offset of Ellipsoid-MLLW. If necessary, this
file should be renamed to ProjectNumber.txt so it is CARIS compatible. If it is necessary to create
your own Ellipsoid-MLLW offset, refer to VDatum tool section in areas where applicable.

* Select all survey lines in CARIS

* Process, Compute GPS Tide...
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Process Data to the Ellipsoid

Compute GPS Tide x|

— Sounding Datum

% Single Height IEI.EIEID mm
" Madsl file: |><:\EH5 GPS Projects'GPS  EBrowse.. |

Process Data to MLLW using VDatum
Model

Compute GPS Tide x|

— Sounding D atum

" Single Height IEI.UDEI m
* Model file: IX:'\EHS GPS ProjectshGPS Browse. .. |

— Optionz
[ Smooth height

¥ &pply Dynamic Heave

v &pply MAU Femate Heave
W Apply Anterna Offset

W apply Dynamic Draft
r From Inztallation =ML

— Optionz
[ Smooth height

v &pply Dpnamic Heave

v &pply MRU Remote Heave
v Apply Snterna Offset

v Apply Dynamic Draft

¥ ApplyWateline Offiset [ Fram Installabion #kML

Campute ! Cancel |

v &pply W aterline Offset ! . f I
f lable.
I™ &pply Height Comection Iravazble. [~ Apply Height Conrection H avalshie
[ffaet: I | [ffzet: I i
Help | Cancel | Help |

Compute !

* Enter a single height of 0.00m to keep the
data referenced to the ellipsoid

* Apply dynamic heave, MRU remote heave,
Antenna offset, dynamic draft and waterline
offset. See Compute GPSTide reference table
* Click Compute

* Check the output window to ensure no
errors occur

* Browse to
H:\Surveys\HXXXXX\CARIS\SBET folder
and select ProjectName.txt file

» Apply dynamic heave, MRU remote heave,
Antenna offset, dynamic draft and waterline
offset. See Compute GPSTide reference table
* Click Compute

* Check the output window to ensure no
errors occur
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COMPUTE GPS TIDE REFERENCE TABLE

GPS Tide = GPS Height - Datum Height - Dynamic Heave + Remote Heave + Antenna Offset +
Dynamic Draft - Waterline + Height Correction

The GPS Tide calculation is dictated according to how components are included in the formulation,
if at all (per CARIS HelpDesk - Service Request #00800588):

“Apply” = GPS Tide Notes
“Remove” Component Option
Smooth [GPS] GPS Height time series data may be
Height smoothed according to smoothing
coefficients computed in HIPS Attitude
Editor.
X Apply Datum Height | "Apply" to subtract a constant offset or

linearly-interpolated offset from a scalar
(gridded) field of offsets to achieve the
desired (ellipsoid-to-chart) datum

transform.
X Apply Dynamic "Apply" to subtract dynamic heave from
Heave the GPS Height. Select this option to

remove dynamic heave from the GPS
Height time series. In particular, if heave
is applied during HIPS "Sound Velocity
Correct”, select Apply Dynamic Heave in
the GPS Tide calculation to prevent
double-compensation of heave motion
(assuming heave present in the GPS Height

data).
X Apply MRU Remote | "Apply" to subtract remote heave from the
Heave GPS Height. In computing remote heave,

HIPS treats the HIPS Vessel File (HVF)
reference point (RP) as the center of rigid
body rotations for moment arm
calculations. Remote heave is that vertical
component of the moment arm calculation
resulting from an off-RP mounting of the
vessel motion reference unit (MRU). Now,
MRU remote heave is applied when heave
is applied in HIPS "Sound Velocity
Correct™; therefore, Apply MRU Remote
Heave is necessary only when the Apply
Dynamic Heave Option is set (assuming
remote heave not already removed from the
GPS Height data).
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SOP: Ellipsoidally Referenced Surveys

X Apply Antenna
Offset

(only meaningful if
HVF Navigation
#IMU)

"Apply" to adjust the GPS Height for roll-
and pitch-projected antenna vertical
component offset per those x,y,z offsets
entered in the Navigation sensor section of
the HVF. Note that if the GPS Height was
reduced to the HVF RP during data
acquisition, the Navigation offsets in the
HVF would be zeroed; hence, checking
this option would not affect the
computation.

X Apply Dynamic
Draft

"Apply" to add dynamic draft affects into
the GPS Height time series data. In
particular, if the dynamic draft table in the
HVF is applied during Sound Velocity
Correction (for accurate determination of
the initial conditions for geometric ray-
tracing) it is necessary to apply dynamic
draft in GPS Tide computation.

X Apply Waterline
Offset

[Simrad only]:

-From Installation
XML, if available

"Apply" to adjust the GPS Height to the
waterline as per the HVF; optionally, for
Simrad, use the waterline value from the
installation XML metadata. RP - WL

Apply Height
Correction

"Apply" to add a constant offset to the GPS
Height time series data.

The “Apply” = “Remove” field is to undo what SV Correction initially did to the observed depths if
these fields are set to “Apply” = Yes in the HVF. This checking to remove paradigm exists in a
Tide/ERS scenario, in a strait ERS paradigm the HVF could be modified to “Apply”=NO at the

project’s onset.
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SOP: Ellipsoidally Referenced Surveys

COMPUTE GPS TIDE IN CARIS

Compute GPS Tide

Note: HSD OPS will provide the VDatum SEP Uncertainty values in the project instructions.

» Select all survey lines in CARIS

* Process, Compute TPU...

Compute TPU

Survey spedfic parameters

Tide values: Measured

Sound Speed values: Measured

Sweep spedfic parameters

Peak to Peak Heave: | [

Max Rall: | 0

Max Pitchs | O

a

]

m
deg

deg

Compute Cancel

m Zoning 0.1
mfs Surface [

Uncertainty Source

@) Vessel Settings

Error Data

Help

m

m/s

Currently, CARIS does not have a process or placeholder for the separation model

uncertainty, so the following is our current workaround. Input the one sigma

VDatum maximum combined uncertainty value provided in the project instructions
into the Tide Values: Zoning (e.g 0.10m).
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FOR OFFICIAL USE ONLY
Hard Copy of this SOP is obsolete- the OCS QMS electronic procedure is valid

Page 149



SOP: Ellipsoidally Referenced Surveys

VERTICAL DATUMS TRANSFORMATION TOOL (VDatum)

Once you load Attitude/Navigation, your bathy data is referenced to the ellipsoid. We’ll need to
prepare a file to be run through VDatum to provide your Ellipsoid-MLLW offset. Launch Pydro.

1. Select TCARI/Load TCARI Data

2. Select TCARI/CARIS GPS Tide/Export TCARI Nodes for VDatum

3. Save file as “Year_Project Number_TCARI_Nodes.csv”
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SOP: Ellipsoidally Referenced Surveys

Launch the VDatum Transformation Tool by double clicking “VDatum_v2.bat”
The following windows will open:
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SOP: Ellipsoidally Referenced Surveys

Choose the correct area that corresponds to the sheet boundaries.

. Transformation Grid Folder will be left as the default setting

Under the “Datum Information” dialogue box choose the correct Horizontal Datum “NAD 83
(NSRS2007/CORS96/HARN), WGS84, ITRF”

7. Input the correct Vertical Datum “NAD 83 (NSRS2007/CORS96/HARN) — North
American

8. Select the correct Output Vertical Datum. MLLW — Mean Lower Low Water

9. Inthis case the Geoid will be set to GEOID 2003, but check the command prompt VDatum
Window and verify “Current TSS grid will require g03

o s

10. Height Units will be in meters

11. Under the “Height/Sounding” option check Sounding

12. Under the “Coordinate System” dialogue box choose Geographic Coordinate System

13. Nothing will be inserted under the “Point Conversion” dialogue box

14. Under the “File Conversion” dialogue box, uncheck “With ID Key (GIS data)” and select
Latitude Longitude

15. Under “Input” File select the .csv that was output from Pydro (ex. “Year_Project

Number_TCARI_Nodes.csv”) The Output File or Folder option will automatically be selected to

create the file in the same folder as the .csv file, and the file should be named “Year_Project

Number_Ellip_MLLW.csv.”

After the following selections have been made, the Vertical Transformation window will look like
the following:
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SOP: Ellipsoidally Referenced Surveys
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SOP: Ellipsoidally Referenced Surveys

ELLIPSOIDALLY REFERENCED ZONED TIDES

An alternative option in areas lacking a published VDatum model is to relate "traditional” zoned
water levels to the ellipsoid. This is done by measuring the height of the GPS antenna to the water
line. Then a SEP is created by adding this ellipsoidally-referenced water line measurement to the
zoned water level “corrector.” The SEP is then applied to the ellipsodially-referenced hydrography
to reference it to chart datum. ERS-ERZT data may be readjusted at a later date when VDatum
coverage becomes available. Additional tools and documentation will be made available via a
Hydrographic Technical Directive later this year.
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SOP: Ellipsoidally Referenced Surveys

MERGE IN CARIS
* Select all applicable lines

* Process, Merge
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SOP: Ellipsoidally Referenced Surveys

* Check “Apply GPS Tide”

Note: To go back to MLLW with tides applied, remerge the lines with “Apply GPS tide”
unchecked
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SOP: Ellipsoidally Referenced Surveys

HORCON / VERCON OBSERVATION LOG

DATE: SESSION: PROJECT NAME:
WX CONDITIONS: SITE NAME: SITE PHOTO(S): Y/N
OBSERVER(S): SITETYPE: HORZ./ VERT./ ATON/ BM / NEW /
DN: RECEIVER #: FIXED HEIGHT? Y /N
4 CHAR. SITE ID: ANTENNA # SPACER? Y/N
ANT. MEASUREMENTS ANT. CONSTANTS

- - ANT. SLANT HEIGHT _ (S) | ANT. RAD. (R)[ V. OFFSET (C)
SESS. FILE NAME: START STOP

ELEV. MASK: degrees - - - -
RECORDING INTERVAL: sec.s ft fi

OBSERVATION TIMES AND STATUS

RECEIVER TIME (UTC) PDOP LOCAL TIME #of SV's POWER
START:
STOP:
INSTRUCTIONS: Office Check by:
HI to ARP=((SQRT(S*-R*) - C): (m)
SITE SKETCH/LOC./NOTES:

OBSTRUCTION DIAGRAM MONUMENT RUBBING / DESCRIPTION

S
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SOP: Ellipsoidally Referenced Surveys
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SOP: Ellipsoidally Referenced Surveys

SBET QUALITY CONTROL LOG

Sample:
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Table 4-9. Uncertainty values for use in CARIS with vessels equipped WITH an attitude sensor

Entry in HVF 1 Sigma Recommended Value (Units)
Attitude
Gyro error (heading) for POS/MV 320 0.02deg
Heave (amplitude)* for POS/MV 320 5%
Heave * for POS/MV 320 0.05m
Roll for POS/MV 320 0.02deg
Pitch for POS/MV 320 0.02deg
Nav. position 0.5 to 2.0 depending on differential qualit im
Nav. Timing** Integration dependent .01(.005)s
Gyro Timing** Integration dependent .01 (.005)s
Heave Timing** Integration dependent .01(.005)s
Pitch Timing** Integration dependent .01(.005)s
Roll Timing** Integration dependent .01(.005)s
Vessel variables

Offsets (x, y, 2) mm to dm depending on measurement accuracy m
Vessel speed 0.03 plus average current in the area (used for dynamic draft table entry) m/s
Loading Range = 1cm to 30cm, dependent on vessel, fueling frequency and m

frequency of draft measurement.
Draft Range = 1cm to 20cm, depends on how accurately draft may be read m

(sight glass, six inch draft marks, etc)
Delta draft Range = 1cm to 3cm, dependent on methodology and magnitude of effect m
MRU alignment (yaw) Uncertainty in the patch test offset value determined for transducer yaw. (Standard

deviation of several calibration iterations) [Multibeam boats only] <ldeg
MRU alignment (roll/pitch) Uncertainty in the patch test offset value determined for transducer pitch/roll.

Standard deviation of several calibration iterations) [Multibeam boats onl <1deg
Entry in TPE Controller Window 1 Sigma Recommended Value (Units)
Measured Range (0.01m - 0.05m) dependent on gauge accuracy and duration of deployment m
Zoning (discrete) Range (0.01m - 0.40m) dependent on distance from gauge, range of tide, rate of tide

change, and meteorological factors. Value provided by CO-OPS in the tide document in

the project instructions package. m
Zoning (TCARI) TBD m

Sound Speed

Measured Range (0.5m/s to 4 m/s) dependent on spatial and temporal variability

Use 1 m/s for casts every 15 min or less

Use 4 m/s for casts every 4 hours m/s
Surface Range (0.2 m/s to 2 m/s): dependent on surface sound speed gradient m/s
e,

*Note: For heave accuracy must use the larger value of 0.05m or 5%.
**Note: All timing depends on integration: serial connections = 0.01s, ethernet with precise timing = 0.005s.




Subject: CARIS HVF Uncertainty Values

Table 4-10. Uncertainty values for use in CARIS with singlebeam vessels WITHOUT an attitude sensor
Entry in HVF

HTD 2007-10

1 Sigma Recommended Value (Units)

Gyro error (heading)
Heave (amplitude)
Heave

Roll
Pitch

Nav. Timing
Gyro Timing
Heave Timing
Pitch Timing
Roll Timing

Offsets (X, v, 2)
Vessel speed
Loading

Draft

Delta draft

MRU alignment (yaw)

MRU alignment (roll/pitch)

Entry in TPE Controller Window

Measured
Zoning (discrete)

Zoning (TCARI)

Measured

Attitude
Dependant on crab angle and boat handling conditions
N/A
Based on heave experienced in the field
N/A
N/A

Nav. position 0.5 to 2.0 depending on differential qualit im

Integration dependent
N/A
N/A
N/A
N/A

Vessel variables

mm to dm depending on measurement accuracy

0.03 plus average current in the area (used for dynamic draft table entry)

Range = 1cm to 30cm, dependent on vessel, fueling frequency and
frequency of draft measurement.

Range = 1cm to 20cm, depends on how accurately draft may be read
(sight glass, six inch draft marks, etc)

Range = 1cm to 3cm, dependent on methodology and magnitude of effect
N/A
N/A

Range (0.01m - 0.05m) dependent on gauge accuracy and duration of deployment

Range (0.01m - 0.40m) dependent on distance from gauge, range of tide, rate of tide
change, and meteorological factors. Value provided by CO-OPS in the tide document in
the project instructions package.

TBD

Sound Speed

Range (0.5m/s to 4 m/s) dependent on spatial and temporal variability
Use 4 m/s for casts every 4 hours
For less frequent casts, estimate variability of the area and use an appropriate value

5-20deg

0%

0.707*(heave amplitude) m
Odeg

Odeg

.01s
Os
Os
Os
0s

m

m/s
m

1 Sigma Recommended Value (Units)

m
m

m/s
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S-57 and NOAA Attribution Guidance

S-57 Required Attribution

The following tables will serve as guidance and reference on S-57 Required Attribution.

Attribute Description

All Feature Objects: ALL surveyed objects will have the following attributes

populated.

SORIND (Source indication)

Country code — US

US Authority code - US for OSC
Source — graph

ID code - registry number

Ex: US,US,graph,H12345

SORDAT (Source Date) The last day of survey acquisition formatted as

YYYYMMDD

Instances which require altering SORDAT and SORIND:

New feature

Modification to the geographic position of a feature

Modification to the geometry (shape) of a feature

Modification to the geographic primitive of a feature (example: point becomes line)
Modification to a feature’s object class

Modification or addition to a feature’s attribution

Note: Disproved and Retained features will always maintain the original SORDAT and
SORIND




NOAA Required Attribution

The following is a list of customized NOAA attributes for new, updated, and disproved features.
The Attribute column is divided into separate columns for equivalent attributes within CARIS,
HYPACK and Pydro.

Attribute Description
CARIS
& Pydro
HYPACK

Portrays the field charting action.

e New - New features or new positions

e Updates - Modification of attribution,
geometry, and/or feature object class

e Delete — Disproval’s or erroneous features.
Examples include situations where:

o Feature no longer exists
o0 Geographic position is altered
o0 Geographic primitive is altered (i.e.
descrp Chart poin'_[ feature modified to a line; point
modified to an area, etc.)

e Retain — Addressed items that are represented
properly on the chart. A remark should be
included for informational purposes as
necessary

e Not Addressed - For items that were
‘assigned’ by the HSD Operations Project
Manager or COTR but that were not
addressed. Include remark describing why the
feature was not addressed

Indicates the status of the feature and is

particularly helpful during side scan sonar

processing. The status is used to associate new
items that correlate to a given real world feature,
or lack thereof in the case of disproving the
existence of a charted feature.

e Primary - principal feature that can be

S associated with one or more secondary
prmsec tatus features. The primary feature is always the
feature with the most accurate position and
least depth (if applicable).

e Secondary - Signifies that the feature is
correlated to the primary.

e Pending - a tool used during data processing.
There should be no features left as pending
once a survey is complete.

Note:
e Features that have only one observation are also labeled primary.




e The final Primary item should be either based on bathymetry data or a DP, unless the
item is insignificant or significance could not otherwise be determined before the
termination of data acquisition.

¢ In Pydro the software status defaults to Pending for all items inserted or otherwise
created in Pydro. Relative status levels can be assigned for sets of spatially correlated
or grouped items. No Pending items shall remain in the Pydro PSS file for a
completed survey submitted to AHB or PHB.

e InCARIS and HYPACK if the prmsec is populated with ‘2- Secondary’ prkyid must
also be populated. See prkyid attribute below for further information.

Used to provide additional information about
features that is not captured elsewhere in the
digital data (e.g. S-57 attribution).The
hydrographer’s feature remarks should include
what the feature is and what techniques were
used to identify the feature.

remrks Remarks

Note:
e Only the primary item representing the feature requires a remark, but the remark may
often contain information about the secondary items as well.

o Remarks shall be written either in longhand or using the standard abbreviations
tabulated in Appendices IV.

Provides survey data reviewers and cartographers
additional information about a feature. While
Recommendatio | explicit charting recommendations are not

recomd ns mandatory it is important to clearly communicate
all information necessary to ensure proper
charting of a feature.
Note:

e Only required for new features and charted feature disproval’s.

o Do NOT include exact geographic positions (Latitude and Longitude), least depths,
etc. in Remarks or Recommendations. However, the practice of including the
correlating AWOIS number (RECRD field) in the remarks is acceptable.

Indicates a feature with a special designation
ATON - ATON investigations

AWOIS - AWOIS investigations

DTON - Dangers to Navigation

Maritime Boundary — Maritime Boundary
investigations

e CEF - Cartographic Evaluation File

sftype Keyword, DToN

Note:
e  Only required for special feature type objects.
o In Pydro items can be marked as DTON only if they are first flagged Chart.




NOAA Discretionary Attribution

The following is a list of additional NOAA Customized Attributes that are recommended, but
now mandatory.

Attribute Description
CARIS
& Pydro
HYPACK

Indicates assignment status of items delivered
to the field by the project manager from HSD
Operations.

asgnmt Keyword e Unassigned
e Assigned
e For Info Only
Images associated with a feature are used to

images documer}t an individual _
feature (i.e. such as screen-grabs, side scan
snapshots, or digital photos).

Note:

e The required format for all images including 3-D graphics and photos shall be JPEG.

e A standard naming convention: <Hxxxxx_3D_a.jpg> for 3-D images and
<Hxxxxx_Photo_a.JPEG> for photos shall be used.

e If more than one image is required, files shall be named in sequence starting with the
letter 'a’ <H12345 SSS100a_1m.tif>.

e All images (including SSS contact images) and photographs should be placed in the
Multimedia folder. A copy of the side scan sonar contact images should remain in the
CARIS HDCS folder.

Customized word used for processing or
querying data. Users can expand the set of
keywrd Keyword attributes and flags by making Keyword
assignments to features under the Keyword
tab or attribute.

Note:

In Pydro, once a new Keyword is added in the Editor’s Notebook, it is available to assign
to other features within the PSS. Standard Keyword values pre-defined in Pydro include
“Assigned”, “Bottom Sample”, “ATON” and “AWOIS”.

A tracking tool used during data processing
that ensures features are fully investigated as

necessary.
Investigate and | e Investigate - indicates that further field

acqsts ST . :
Resolved examination and analysis are required.

e Resolved - indicates that field
examination and analysis have been
completed for an item.

Note:




The Final Feature File (.hob, .000, or .pss) to be submitted to AHB or PHB shall not
contain any Unresolved items.

The Investigate flag and attribute enables the direct export of specific items to
Maplinfo MIF/MID, HYPACK TGT, and .000 format for planning further
investigation or development.

The project manager at HSD OPS uses this
field to define specific investigation
requirements for the field. There may be
specific requests from customers about
particular features, or questionable features
that may warrant extra attention.

invreq Remarks

The primary key ID shall be populated for
secondary features with the primary feature’s
prkyid Database key ID (i.e. when prmsec =
secondary). This is a means for manual
correlation in CARIS and HYPACK.

The unique ID shall be populated with a
unique name or number. This attribute is
used as a unique identifier instead of the
dbkyid (Database Key ID) in CARIS because
the dbkyid can change during imports and
exports.

userid DispName




Additional Pydro Flags

The following is a list of additional flags in Pydro to support data processing and analysis:

Pydro Flag

Description

Submitted

Denotes that items flagged as Primary+Chart+DTON have been
exported from Pydro to a DTON report for submission to MCD.
Once marked Submitted, these items will not be re-exported during
creation of subsequent DTON reports unless the “Submitted” flag is
manually cleared prior to generating the report.

Office QC

Denotes that AHB/PHB examination and verification have been
completed for an item. The Pydro PSS for a completed survey to be
submitted to HSD or otherwise archived shall not contain any
Primary items that are not flagged Office QC. This is a Processing
Branch tool only.

Rejected

Identifies any item that the hydrographer does not want included in
the survey. Any pertinent information explaining why the feature has
been rejected should be included under the Remarks tab of the
Editor’s Notebook. Rejecting an imagery feature in Pydro will flag
the corresponding SIPS contact as rejected, but will not delete the
contact. Rejecting a bathymetry feature in Pydro will clear the
Outstanding flag in HIPS, but will not reject the corresponding
sounding data.

Significant

Identifies features which meet the NOAA significant contact height
criteria set forth in the HSSD (see section 5.2.2 and 6.2.1), or some
other priority condition determined by the field unit, and warrant
further investigation and/or development. If applied to a Primary
feature, the Significant flag will automatically be applied to all
correlating Secondary features.

Tgt
Exported

Denotes that an item was flagged Investigate and has been exported
to MapInfo MIF/MID and HYPACK TGT format, typically for some
subsequent investigation procedure. This flag will be set
automatically when “Export Investigation Items” function in Pydro is
performed. Once marked Tgt Exported, these items will not be re-
exported unless the Tgt Exported flag is manually cleared prior to
performing the export.

In Bathy

Forces a feature’s least depth to be explicitly included in the PSS
database of shoal-biased binned line (PVVDL) data for plotting in
Pydro, Maplnfo (via Hydro_MI’s “Draw PSS” function), or




otherwise exported from Pydro. A sounding must first be classified as
a bathymetric feature to be designated In Bathy. Once flagged In
Bathy, that depth will take priority over other PVDL bathymetry data
and other feature depths in the PSS during over-plot removal.

Designated

This flag is used to force a feature’s least depth to be explicitly
included in the two PSS bathymetry databases (as applicable) for
display/analysis in Pydro (both over-plot removed Depths and
ZSurfaces), plotting in MapInfo (via Hydro_MI’s “Draw Pydro Data”
Post Survey tool), or otherwise exported from Pydro: (i) HIPS
BASE/Weighted Grid data and (ii) shoal-biased binned line (PVDL)
data. During bathymetry layer over-plot removal (aka “excessing”) in
Pydro, feature depths may suppress other (deeper) feature depths;
however, non-feature depths do not suppress feature depths,
regardless of magnitude (i.e., all feature depths are regarded as being
shoaler than all other depth nodes in the grid). In CARIS, the
Designated flag should be used when a single least depth
measurement is preferred over the weighted-mean depth calculation
for BASE surface grid nodes. Designated soundings often equate to
navigational significance and, hence, the desire for a symbolized
feature to be rendered on the chart—and why HIPS Designated
soundings are read into Pydro as candidate features (items from
bathymetry). However, this is not always the case. For example, if the
area of least depth has been adequately surveyed, yet contains a small
number of soundings, the Designated flag should be used. Also, if a
feature’s least depth was determined by DLDG, the Designated
flagging mechanism must be used to accurately represent the (single)
measurement in the BASE surface. Designated soundings are applied
to the BASE surface during the Finalize step in CARIS by checking
the "Apply designated soundings™ option.

Outstanding

Flagging a sounding Outstanding can only be accomplished in HIPS,
but this action correlates to creating a bathymetry feature in Pydro.
In other words, a sounding flagged Outstanding in the HDCS data
will automatically be a bathymetry feature in the PSS. Likewise,
creating a bathymetry feature in Pydro will write an Outstanding flag
back to that sounding in the HDCS data.
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Attributing and Flagging for Automated Feature Reports

Special Feature Types

The following attributes and flags shall be used to distinguish features for HCell compilation and
the Feature Report.

Note: There are several logic paths for some of the items in Pydro

Special Feature SARIE
Types: & Pydro
) HYPACK

_ . Primary + Accepted (i.e., not

DTONSs [pESr‘nﬂsece—_lgP[r)l_lrpgm ¥ flagged Rejected) + Chart +
ype = DTON
e Report + Primary +

_ : [Keyword == “AWOIS”]

AWOIS [prmsec =1 Primary] + | | Report + Primary +

[sftype =2 AWOIS] Accepted + Non-DTONSs +

Secondary AWOIS

e Report + Primary +
[Keyword == “Maritime
Boundary”]

e Report + Primary +
Accepted + Non-DTONSs +
Secondary Maritime Boundary

[prmsec = 1 Primary] +
Maritime Boundary | [sftype = 2 Maritime
Boundary]




New and Charted Features

New & Charted
Features:

CARIS
&
HYPACK

Pydro

New

[prmsec = 1 Primary] +
[descrp = 1 New]

e Report + Primary +
Accepted + Non-DTONSs (with
no Secondary from Chart GP
or AWOIS)

e Report +
[Keyword=="DR_UnCharted”]
+ [Chart = New]

Updated

[prmsec = 1 Primary] +
[descrp = 2 Updates]

e Report + Primary +
Accepted + Non-DTON:Ss (i.e.,
not flagged DTON) +
Secondary ChartGP (but no
Secondary from AWOIS)

e Report +
[Keyword=="DR_Charted”] +
[Chart = Update]

Disproval

[prmsec = 1 Primary] +
[descrp = 3 Delete]

e Report + Primary +
Accepted + Non-DTON:S (i.e.,
not flagged DTON) +
Secondary ChartGP (but no
Secondary from AWOIS)

e Report +
[Keyword=="DR_Charted”] +
[Chart = Delete]

Retain

[prmsec = 1 Primary] +
[descrp = 4 Retain]

e Report + Primary +
Accepted + Non-DTON:S (i.e.,
not flagged DTON) +
Secondary ChartGP (but no
Secondary from AWOIS)

e Report +
[Keyword=="DR_Charted”] +
[Chart = Retain]

Not Addressed

[prmsec = 1 Primary] +
[descrp =5 Not
Addressed]

e Report + Primary +
Accepted + Non-DTON:Ss (i.e.,
not flagged DTON) +
Secondary ChartGP (but no
Secondary from AWOIS)

e Report +
[Keyword=="DR_Charted”] +
[Chart = Not Addr]




Customized Attribute Equivalencies
CARIS - HYPACK - Pydro

NOAA Required Attribution:

CARIS
& Pydro Comments
HYPACK

descrp Chart -? Description

prmsec Status Primary/Secondary status

remrks Remarks Remarks

recomd Recommendations *Only required for new and charted feature
disprovals*

sftype Keyword==ATON or | Special Feature Type

AWOIS
DToN Flag

NOAA Discretionary Attribution:

CARIS & HYPACK Pydro Comments

asgnmt Keyword==Assigned | Assignment Flag

images Images Images

keywrd Keyword Customized keyword

acqsts Investigate & Acquisition status
Resolved Flags

invreq Remarks Investigation requirements

prkyid NA - CARIS and Primary key ID — supports manual correlation
HYPACK only in CARIS and HYPACK

userid DispName Unique ID




Standard Shorthand for Features

Notes made in Remarks or Recommendations fields should be concise and use
approved shorthand:

att attached milw mean lower low water

bdk bedrock mbes multibeam echosounder

bch beach mnt maintained

bkwr breakwater N north

blidrs | boulders nain not addressed inshore
of NALL

brg bearing nall navigable area limit line

ch channel ntd noted

chd charted ofsh offshore

cir circle ort oriented

conn connected par parallel

cov covers pos position

c/u covers/ pt point

uncovers

dbn daybeacon pvt private

dia diameter rk rock

dis disproval rng range

DP detached position shl shoal

dup duplicate sig significant

E east sl shoreline

ext extent sndg sounding

ftr features S south

fl flashing subm submerged

flt floating swm seaward most

fm fathoms vbes vertical beam echo
sounder

ft feet vfd verified

GC Geographic Cell W west

ht height witr water

hp high point

hw high water

inshr inshore

invst investigation

Klp kelp

Idg ledge

Idr lidar

Imt limit

It light

Itd lighted

Iw low water

m meter

mhw mean high water
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Data Management and Survey Deliverables

CONTENTS
Digital Data Submission CheckliSt ..........cccvvviiiiiiecee e 305
Hydrographic Survey Quality Control CheckIist ...........cccooviieiiiiiiniicce e 307
Hydrographic Survey Review ChecKIiSts ........ccccoovieiiiirie e 311
FHEVEIITIEr SOP ... et 313
D CTo AN O AN I =T oo SR 323

Hard Copy of this SOP is obsolete- the OCS QMS electronic procedure is valid



Digital Data Submission Checklist

OPR-A###-FA-##
HXXXXX Survey X

CARIS

Background Files

Any background files to be submitted with the survey
Fieldsheets

HXXXXX (Non-Finalized BASE Surfaces)
HXXXXX_2m_0to40 Naming convention: HXXXXX_Resolution(m)_DepthRange
HXXXXX_5m_30to70
HXXXXX_10m_50t0120
HXXXXX_20m_100t0200
HXXXXX_35m_180t0350

HXXXXX_Final_Combined (Finalized & Combined BASE Surface)
HDCS Data

HXXXXX (processed CARIS HDCS data)

Critical Soundings

VesselConfig (only vessels that apply to this survey)

DeviceModel.xml (DeviceModel used for processing this survey)
Notebook Files

HXXXXX_Original_Composite_Source.hob
HXXXXX_Composite_Source.hob OR HXXXXX_Updates_Ntbk.hob
HXXXXX_Updates_Pydro.hob
HXXXXX_Disprovals.hob
Preprow
ISIS (raw XTF data and True Heave from ISIS)
SVP_raw (raw SV data from Velocwin)
Trimble (raw data from TerraSync & exported SHP files from GPS PathFinder)
SVP (processed CARIS SVP data files separated by vessel)
1010
1018
S220

Tide
Observed, Verified or Smooth .tid & .zdf (only tide files applied to data at time of submission)
* No Sessions submitted at this time

DESCRIPTIVE REPORT
Report Body
HXXXXX_Descriptive_Report.doc
HXXXXX_Title_Sheet.pdf
HXXXXX_Cover_Sheet.pdf
Digitally Signed Approval Memo
Appendices
I. DTON Report(s)
HXXXXX_DTON.xml (XML of DTONSs exported from Pydro)
HXXXXX_DTON_Report.pdf (report produced in Pydro)
HXXXXX_DTON_email.txt (copy of submission email)
other email correspondence related to DTONs including MCD confirmation




Il.  Survey Feature Report
HXXXXX_Survey_Feature_Report.pdf (report produced in Pydro)
Ill. Final Progress Sketch & Survey Outline
HXXXXX_Survey_Outline.tab & final Progress Sketch files
IV. Tides & Water Levels
Official smooth tide note issued by CO-OPS to identify files used for final correctors
Request for Tides
HXXXXX.pdf (Smooth Tides Request & Abstract Times of Hydro)
HXXXXX.mif/mid files
V. Supplemental Survey Records & Correspondence
HXXXXX_Correspondence.xxx (digital copies of emails, request & correspondence)

Separates
I. Logs
Acquisition & Processing
HXXXXX_1010_8101_Log.xls
HXXXXX_1010_8101_Log.xls
HXXXXX_S220_8111 Log.xls
HXXXXX_S220 8160 _Log.xls
Detached Positions
HXXXXX_Pydro_Feature_Log.xls
HXXXXX_DPForms.pdf (Scanned DP forms)
HXXXXX_Boat_Sheets.pdf (Scanned boat sheets)
II. Sound Speed Data
Not Applicable, submitted by Project with the DAPR
Ill. Hydrographic Survey Letter Instructions
Letter Instructions, changes and amendments for the project

IV. Checkpoint Summary & Crossline Comparisons
Checkpoint Summary & Crossline Comparisons

Public Relations and Constituent Products
Include all products that were provided to constituents or used for PR

PSS (Pydro Preliminary Smooth Sheet)
HXXXXX.PSS
Photos (Non-SSS contact images associated with Pydro features, named w/unique identifier )

HXXXXX Contents
Survey data included in transmittal list text file

Command prompt

. H: (to go to drive)

size cd (can use rt click paste to put in path to
number of files folder)

number of folders




Hydrographic Survey Quality Control Checklist

Survey: HXXXXX Project: OPR-XXXX-FA Survey PIC:

SURVEY PLANNING Completed:

INTTIAL DATE
Read and Understand the project Instructions
Letter Instructions

Standing Instructions

Start filling in Survey Log
pertinent Chart scales listed

Shoreline Prep

Shoreline files prepped

Boat sheets produced

TIF/TFWSs opened and checked in TerraSync

Initial TIF/TFWs produced for MBES launches in Isis

Cross Lines
Plan to run crosslines early, prior to MS if possible
Plan to obtain 10%
Atleast 5% collected

Multibeam Polygons produced and updated
DO NOT send multibeam boats inshore of the eight meter curve until shoreline has been run in area
Initially create SHIP & LAUNCH polygons only - Launch polygons can be driven by any Cox'n
NEAR_SHORE & HIGH_WATER_ONLY polygons not created until shoreline has been run in area
Discuss NEAR_SHORE & HIGH_WATER_ONLY areas with FOO/CST - run by experienced Cox'ns only
Polygons converted to shp format and put in R/Transfer and on Launch hard drive

Bottom Samples Prepped
Bottom Sample chartlet/boat sheet produced
Create a tif/tfw of your bottom sample sites
TIF/TFWs opened and checked in TerraSync

DAILY CHECKS Completed:

INTTIAC DATE
Quality Control of Survey Data
Review BASE surfaces
Review data in subset mode for SV error, tide problems, holidays & noise
Check coverage and update polygons
Check for immediate DTONs and notify FOO
Immediate DTONs submitted

Review Acquisition and Processing logs
Check for issues/problem data in both Acquisition and Processing sections
Make sure the SV application method is documented (e.g. NIDWT-4hrs)

Note if True Heave could not be applied & document in DR

Track issues in HXXXXX_Survey_Log.doc
Note which vessels were used for the day (especially useful for shoreline boats)
Document special circumstances/problems, HVF changes & deviations from DAPR
Issues explained in DR

FIELD PROCESSING Completed:

INTTIAC DATE
Pydro Processing
All DPs/GPs & Bottom Samples imported
Features reviewed, flagged, S57 attributed and CartoAction selected

Remarks/Recommendations completed




Pictures labeled correctly, in one folder, & inserted in PSS
AWOIS investigations completed
.mbd file inserted in Pydro
Database updated in AWOIS editor, with investigation methods and remarks
Tide and SVP correctors applied where necessary
HXXXXX_Pydro_Feature_Log completed
Feature .xml's exported using Pydro Tree Templates

Notebook Processing
All Pydro features imported
Features reviewed with DP forms and boat sheet
Address all data including CFF, Chart, Lidar, and new items
All remarks fields completed or state "Unable to Verify"
Unverified items flagged with Marker Text
Photos, not associated with a Pydro feature, added to features in Ntbk in a marker note
Notebook Photos are stored in PSS\Photos\Notebook Photos
Verify Sound Velocity Files
Compare SVP files listed in digital acquisition logs with files on I: drive — all should match
Review cast profiles in HIPS SVP Editor
Display SV cast positions in CARIS to check for gross error
Check file management on H: and I: drives
Query data to make sure only master concatenated files (HXXXXX_VSSL.svp) were applied
If HXXXXX_VSSL.svp is not applied to lines, then discussed in DR
SV acquisition/processing deviations from the DAPR are noted in the DR.

Updated Shoreline TIF/TFWs created and sent out to field before any near shore MBES run
Examine Range Displayed CUBE surfaces (make sure that CUBE surfaces have Depth Ranges in name)
Coast Pilot review & write up with edits completed

POST ACQUISITION Completed:

INITIAL DATE

Review of CARIS Data

Re-insert all HDCS lines (not DPs) into HXXXXX_QC session

Review data using CARIS Subset Editor (include looking at rejected and BASE child layers)
Subset tiles created for review process
Data checked for systematic errors (Std deviation child layer especially useful)
Flyers cleaned out, where it affects appropriate surface for that depth
Contours & Soundings generated from finalized/compiled surface (CARIS FS Editor)
Review all examined soundings (to designate, mark outstanding, or reaccept)
Designate soundings in areas where surface does not accurately represent the bottom

# of Designated Soundings

Data issues discussed in DR if present

Smooth Tides Request (*.mif/mid and times of Hydro)

All data inserted in Pydro for correct Times of Hydrography

Request with letter, times, & mif/mid generated and saved in Appendix Il
E-mail CST & FOO when complete

Survey Outline
Produced & saved in Appendix IlI
E-mail CST & FOO when complete

DTONSs (Dangers to Navigation)
Select DTONs
soundings marked outstanding in CARIS
inserted in Pydro as CARIS Line Feature
Notify FOO that they are ready for review
DTONSs chosen by CO should be marked Designated in Pydro or CARIS
Use the Pydro Report function to generate a DTON Report
E-mail CST, FOO & CO when selection and report are complete



Submittal e-mail/DTON Report saved in PSS folder

Additional (Observed, Verified or Smooth) Tides Applied

Tide file reviewed & checked for gaps/flyers (txt in Notepad, .tid in Caris Tide Editor)
Apply zoned file to all HDCS lines

Apply zoned file to all DPs

Data remerged in CARIS after tides have been re-applied.

Recompute BASE surfaces

Complete H##### Data_Log (file is in Separates\Logs)
MBES MS tab complete, query Main Scheme lines only
Count data files on H: and I: drives
Number of raw files matches number of HDCS lines, and matches total # of survey lines
Compare queries to daily acquisition logs to check for discrepancies
Tide correctors applied are correct and most current (observed, verified or smooth)
Master SV files applied for all vessels (or as noted in DR)
Vessel speeds meet object detection requirements for relevant depths
MBES XL tab complete, query Crosslines only
MBES DEV tab complete, query Development lines only (generally lines run over AWOIS items)
Features Query completed in H#### Data_Log
Compare fields of matching colors
Statistics tab reviewed and box copied to DR
Problems/discrepancies investigated

Pydro Review
All features resolved
DP forms match features in PSS
Scanned into a single .pdf and saved in DP Log folder
Use DP editor to ensure correct vessels were selected for all data
Apply necessary correctors (tides) to DPs and merge data
DPd for height items - additional processing complete
copy attributes from Pydro to Ntbk feature (watlev etc)
change UWTROC in Pydro to $CSYMB
if smooth tides delivered, copy smooth tide height of feature to Ntbk, update DR
Remarks/Recommendations completed
Disprovals marked Report, contain search methods in Remarks & have a recommendation
Chart GPs produced if necessary
Changes to MHW (including islets) marked Report
include description paragraph in Remarks and have a recommendations
AWOIS items finalized
Features Report produced and saved in Appendix |

Notebook Review
Features compared to Pydro session

Remarks reviewed for consistancy & completeness (All features must have a remark!)
S57 attribution correct and complete

Descriptive Report
Digital images of limits and junctions produced and inserted
Fill in Statistics in Data_Log & add the box to DR using paste special as picture
Dates of survey match- DR, Cover Sht, Title Sht,Sm Tide Req, Raw Isis & Trimble folders
Check that the General & Sub-Locality for survey in DR, Cover Sht, & Title Sht matches LlIs
Add LI date signed added to DR, if LI changes affect your survey add verbage to that affect
Cross-line comparisons completed and documented
Required quantity of XLs met. If not, addressed in DR.
Junction comparisons completed and documented
Prior surveys were reviewed because of special issues
Issues explained in the DR
Chart comparisons completed and documented
Chart edition & date corrected through included in DR
Notice to Mariners checked for recent updates
Special circumstances, problems, HVF changes, deviations from DAPR documented




Shoreline processes described
Separates reviewed & complete
Acquisition logs checked
True Heave applied and how SV applied noted (nearest in time etc.)
Coverage requirements were met (use finalized surfaces to assess coverage)
If not, addressed in DR.

Run the interpolation/triagulation to assess holidays
For holidays larger than 3 nodes across
corresponding MBES backscatter sidescan was examined
were any navigationally significant items found in backscatter?
Discuss in DR, if necessary
Accuracy requirements were met (use IHO error calculator)

If not, addressed in DR

SUBMISSION Completed:

INTTIAL DATE
Data Checked & Ready for Review
Any HVF changes or alterations are discussed in DR
H#### QC session ready
If multiple fieldsheets are necessary, naming includes resolution & geographic identifier
Surfaces include depth threshold ranges and resolutions in name
cov or bot_dep in name, if bottom depiction srfcs used in addition to coverage srfcs
Finalize surfaces with depth thresholds applied; to produce critical soundings
Use finalized surfaces to assess that coverage requirements were met
Adjust overlap if necessary, there should be no gaps between surfaces
Produce a combined surface from finalized surfaces
produce soundings & contours from combined surface
Open and save to session the best chart(s) for the survey area
Make combined surface transparent, so that chart shows through
PSS data is not Stale or Outdated

Shoreline session contains all files named properly & located in Notebook Files folder on I: drive

Create & Examine Fledermaus session from compiled surface, save to Survey Files/Fledermaus

Descriptive Report Components
Approval Memo, Cover & Title sheets copied from templates, completed and saved in DR folder
Appendices completed as necessary
Separates completed as necessary

Three-hole punch hard copies of DP forms & boat sheets and put them in a folder with a label

File Management
File management SOP consulted
Fieldsheet folder contains only deliverable fieldsheets, all others removed
All files accounted for and in correct location

Content of all submission folders (CARIS, DR, Field Products, & PSS folders) checked
Complete, suitable, and non deliverable items removed

Notification e-mail to CST & FOO that survey is ready for review
All data and DR submitted for Review and Approval

POST-APPROVAL Completed:

INTTIAL DATE
Digitally sign approval memo and put in Descriptive_Report\Report_Body\Approval_Sheet folder



Hydrographic Survey Review Checklists

Survey: Project:
QC REVIEW QC Reviewer: Completed:

INITIAL DATE
Bold underlines require date and initials when item is completed.

1. Survey Data and Documentation Familiarization

QC Check reviewed
Quality Control Checklist done by sheet manager is complete and reviewed

Descriptive Report reviewed
Check that the cover sheet, title sheet and the DR information correspond with Letter
Instructions (eg. Locality, Registry #, etc.)
Base Surface and Field sheet Table
Date for Letter Instructions in DR is correct
Review survey feature report
Statistics
Review Appendices
Review Separates

Logs reviewed
Digital Acquisition & Processing Logs
Pydro Feature Log
Data Log
Feature Query reviewed, appropriate features were exported to Notebook
Check Statistics & Dates of Survey
DR, Cover Sht, Title Sht & Sm Tide Req should match raw
(PREPROCESS) data, including Trimble
Survey Log

2. Data Quality

MBES - CARIS HIPS & SIPS
HDCS data, fieldsheets, and base surfaces open in CARIS and are not outdated
BASE Surfaces contain least Depth, Uncertainty, and Standard Deviation attributes

Proper corrector files applied to data
Tide
SVP

Sound Velocity
Evaluate profiles
View positions

Tide files: If smooth tides have been applied:
Evaluate tide file in CARIS tide editor (no gaps or spikes in data)

Features
PYDRO
Verify PYDRO information matches DP form
Remarks/Recommendations are appropriate and not confusing
Verify S-57 attribution
Verify PYDRO flags
All features are resolved
Verify all AWOIS items have been addressed

CARIS Notebook
Verify all features have been addressed
Verify S-57attribution
Review features with BASE Surface

CARIS HIPS
Verify DPNE lines have the correct Tide file applied and are Merged
Verify DPES lines have SV applied, the correct Tide file applied and are Merged

DTONs
Verify DTONs
DTON Report in DR matches DTONs in PYDRO



3. Data Accuracy

Systematic Errors
BASE Surfaces reviewed for sound velocity, tide, roll bias or timing bias, etc.
Have errors been documented in the DR

Coverage and Object Detection
Coverage and accuracy requirements were met

BASE Surtaces
Verify CARIS BASE Surfaces are threshold by depth and are of appropriate resolution
Verify the Finalized/Combined CARIS BASE Surface
Verify all significant shoals, DTONs and designated soundings have been examined

Designated Soundings
Review all to ensure appropriate sounding selected (eg. not outerbeam or noise)

Subset Review
Review 10% of survey in subset mode (include looking at rejected data)

Quality Control
Required percentage of crosslines have been conducted
Crosslines represent a sample of the entire survey area
Examine 10% of crossline junctions
Areas that exceed allowable errors discussed in DR
Contours & Depths checked
Chart comparisons reviewed
Ensure chart edition and date corrected through included in DR

FINAL REVIEW Final reviewer: Completed:
TNTTTAC DATE
Final Review completed
Data and DR are approved
Descriptive Report & Appendices reviewed
Survey Feature Report reviewed
Pydro/Notebook Sessions reviewed
Data reviewed in Fledermaus
CO REVIEW Completed:
TNTTTAC DATE
Data review
DR review

Signed Approval Memo



FileVerifier++ SOP Version 1.0
Grant Froelich
Pacific Hydrographic Branch

Contents:

1|Background

2| Creation of Checksums

3| Verification of Checksums
4|Reporting Results

1| Background

A checksum or hash sum is a fixed-size datum computed from an arbitrary block of digital data for the
purpose of detecting accidental errors that may have been introduced during its transmission or
storage. The integrity of the data can be checked at any later time by recomputing the checksum and
comparing it with the stored one.

NOAA field units shall create MD5 checksums for all digital data submitted to the processing branches.
This SOP outlines the procedure for creating, verifying, and reporting the results of the verification
process using the program FileVerifier++.

This SOP is intended to be used with FileVerifier++ version 0.6.3.5830W or later.

2| Creation of Checksums

To create checksums, first copy all the digital data to be submitted to the processing branch to the
submission drive. Once all the data has been copied, create a MD5 checksum file with Windows Line
Endings, Unix Path Separator Characters and a custom MD?5 file comment using the following procedure:

1. Open FileVerifier++ by opening the fv.exe file from Windows Explorer
2. [If this is the first time you have run the program, go to Tools ->Settings->Preferences

B rileverifier++ - [UNTITLED]
File Edit oOperations Algerithms BOEN Window Help

0 ¢ 5 0 " T —

New Load Save Files Module Information... Default Encoding L4
Path Register File Associations... v Use relative paths when addingfiles | ]
Unregister File Associations... Calculate hashes upon adding

« Don't recaleulate known geod items

« Verify files automatically

Yalid Size (bytes)
Actual DOS Attributes
Valid DOS Attributes
Actual Modification Ti...
valid Modification Time
Actual Hash Value
Walid Hash Yalue
Algorithm Used
Encoding

Errar




a. Under General ->Compatibility change

i. Line Endings for Text Files to Windows (CRLF)

ii. Path Separator Character to Unix (/)

2 Preferences

= General
- AppBaTance

Line Endings For Test Files:
(%) Windows [CRLF)
) Uniis [LF)
() Macintosh [CR)

m Preserve Line Ending
Type For Existing Files.

Fath Separatar Character:
) Windows [4)
=) Unix [/]

n Preserve Path Separator Wwhen

tadifving Existing Files.

Compatibility Preferenc

Apply &

ok

b. Under General->File Comments change
i. Default File Comment to “Hexadecimal MD5 checksums created at {insert field
unit name here} on YYYY-MM-DD”
ii. Check Prompt For Comment Upon Save

P Preferences =)
= Gereral File Comments Preferences
Appearance
- Wiew Columnz
.. Campatibility Defailt File Comnmert
i+ Update Checking (") Uze Default duta Generated Comment

. File Comments

(#) Use The Following:

Hexadecimal MOS checksums created at Pacific Hydrographic Brar

[ Preserve Esisting Comments
Prampt Far Comment pon Save

Apply o Ok

c. Under Tools->Settings->Default Encoding-> Select “Hexadecimal”
d. Under Tools->Settings->Select “Use relative paths when adding files”



B FileVerifier++ - [UNTITLED]
File Edit Operations Algorithms BOMES Window Help
D ] ﬁ @l Settings ’ Preferences... |
N~ T 1
Hew Load Save Files Module Information... Default Encoding d v Hexadecimal
Path Register File Associations... v Use relative paths when adding files MIME Basedd
Unregister File Associations... Calculate hashes upon adding UUEncode
v Don't recalculate known good items X¥Encode
v Verify files automatically I
Valid Size (bytes)
Actual DOS Attributes
Valid DOS Attributes
Actual Modification Ti...
Valid Modification Time
Actual Hash Value
Valid Hash Value
Algorithm Used
Encoding
Errar
H “ ”
e. Under Algorithms-> Select “MD5

B FilaVerifier++- [UNTITLED]
File Edit Operations

0 =

Mew Save

FALGIGGIGE Tools
CRCle
CRC32
BZIP2 CRC
MPEG2 CRC
JamCRC
Posix CRC
ADLER32
MD4

EDONKEY2ZK

RMD124

RMDL1a0

RMD256

RMD320

SHAL

SHA224

SHA256

SHAZES

SHAS512

WHIRLPOOL

WHIRLPOOL-T

Load

Fath

<

Message Log

+=t=t=t=t=+=t=+ FileVerifier++

Window Help
R B H
et
e
Delete Clear Verify  Verify All Opt
Encoding

rdm-:l Mingw32) 4.3.3) +=+=+=t=t=4=t=+

Starting FileVerifier-+ [v1.6.3.5830]

3. Once you have all your settings correct, you can add the files to be checksumed

Select the “Dirs” button and browse to the
drive

a.

H12345 folder on the submission

b. Under Operations-> Select “Calculate Entries [ALL]...”



B FileVerifier++ - *[UNTITLED]

File Edit BeEHERGTIN Algorithms  Tools Window  Help
D . ProcessFiles... C-f % @
Y Process Directories... C-d
Mew Lo i erify  Verify All
Advanced Processing... C-p
Fath Process String.. C-5-5 )

[ T:/Fo0SE3) Hes
WRPIEEE 5 cyate Entries [ALL]L.. C-[F5] Hes
[ T:/Foosss) Calculate Entries [TAGGED F5 _=
[] T:/Foosas, alculate Entries | I [F5] Hes
L TYFO0SES, ey Entries [ALL]... C-5-q i
[ T:/Fo0sE3) ’ ) Hes
[] T:/Foosas Verify Entries [TAGGED]... C-q Hes
] 7:/Fo0sEs) o ) Hes
[] T/Foosss, Delete Entries [ALL]... 5-DEL] Hes
[] TyFocsze)  Delete Entries [TAGGED]... [DEL] Hes
[ T:/Fo0SE3] Hes
[] T/Foosse,  Strip Leading Directeries [TAGGED]... Hes
[ T/Fo0s38)  Replace Text [TAGGED]... HE
L TYFO0SE5, oo Algorithm [TAGGED]... He
[ T:/Fo0SE3] Hes
[ T/FO0533,  Rayert Verification Status TALL C-5-1 He:
I TIFO0S3, o ert Verification Status [TAGGED C e
[] T:/roosas, evert Verification Status [ ] -r Hes
M1 7-fenneEoa Haw
< Export To Clipboard As Text [TAGGED]... C-S-c
R e e e e e T g e e T R ey ey Kl

c. Enter the base path of the submission folder (ex. T:\H12345) in the Relative path names
entry dialog and click okay

Calculate /Recaleulate Entries %
Relative path namesz are relative to the folloving directony:
| TAFO058S [ Bowse.. |

Lze algonthm for entriez without algonthm info:

' MD5

[/ oK

4

] [x Cancel ]

d. The process will begin and you will get a status bar telling you how far along you are

11% - Calculating/Recalculating Entries

Processing File:

Processed Bytes:
Elapsed Time:

Progress: [llllllllllllllllllllllllllllll ]
Total Progress: [ll L 1L ]
Processed Files: 413 Total Files: 3129 Percent Complete: 119

T:[FO0S89/CARISHDCS _DatafFODSE9{NRT_S51212_EM3002/2010-200{FO0589008

583.5 M
00:00:03

Total Bytes: 5.2 GiE
0o:00:23

Processing Rate:  158.4 MiB/s

R.emainirg




e.

When it is finished, click on the “Save” button

Give the checksum file a name using the naming convention
HXXXXX_Checksums.MDS5 and place it in the base folder (ex T:\H12345)
Save as “MD5 Hashes (MD5SUM Style) (*.MD5)”

Sawe Results ]
Savein: | (- FO0SEI v O % Er
nY I CARIS
i 23 |5 Descriptive Report

My Recent | (PSS
Documents IC)Public Relations and Constituent Products

?‘[‘_‘

Desktop

9

My Documents

My Computer

File name: | FON589_Checksums hd | [ Save l

o

Ssvesstyps: | MDS Hashes MDESUM Stie) [*MDS) v| [ Canca |

by Wetwork,

Answer “Yes” to the question about relative path stripping

Since the program options are setto use relative paths for hash entries,
L would you like to automatically strip the common path betweean each entry and
the newly saved file?

| ves || o

Modify the date in the comments to the current date

Cormmment far file:
| at Pacific Hydrographic Branch on 200171-02-03

|/ ok | [¥€ Use Defaul

Save



3| Verification of Checksums

To verify checksumes, first copy all the submitted digital data to the network drive where it will be stored.
Then verify that the data has not been altered by loading the checksum file and comparing the
checksums of the files as they currently exists to how they existed on the ship using the following
procedure:

1. Open FileVerifier++ by opening the fv.exe file from Windows Explorer
2. |If this is the first time you have run the program, go to Tools ->Settings->Preferences

B rileverifier++ - [UNTITLED]
File Edit oOperations Algerithms BOEN Window Help

0 ¢« B 5 K

New Load Save Files Module Information... Default Encoding L4
Path Register File Associations... v Use relative paths when addingfiles | ]
Unregister File Associations... Calculate hashes upon adding

« Don't recaleulate known geod items
v Werify files automatically

Yalid Size (bytes)
Actual DOS Attributes
Valid DOS Attributes
Actual Modification Ti...
valid Modification Time
Actual Hash Value
Walid Hash Yalue
Algorithm Used

Encoding
Error
a. Under General ->Compatibility change
i. Line Endings for Text Files to Windows (CRLF)
ii. Path Separator Character to Unix (/)
B Preferences %)
= General |
Appearance
Wieww Columin
Compatibility Line Endings For Test Files: Fath Separatar Character:
Update Checking (%) Windows [CRLF) ) Windows [4)
File: t
1 emmers O Unix [LF] @) Unis /)
() Macintosh [CR)
n Preserve Line Ending n Preserve Path Separator Wwhen

Type For Existing Files. tadifving Existing Files.

7

b. Under Tools->Settings->Default Encoding-> Select “Hexadecimal”



B Fileverifier++ - [UNTITLED]
File Edit Operations Algorithms Window Help
2] Settings Preferences...
Z B @5
Hew Load Save Files Module Information... Default Encoding d v Hexadecimal
Path Register File Associations... v Use relative paths when adding files MIME Basedd
Unregister File Associations... Calculate hashes upon adding UUEncode
v Don't recalculate known good items X¥Encode
v Verify files automatically
Valid Size (bytes)
Actual DOS Attributes
Walid DOS Attributes
Actual Modification Ti...
Walid Modification Time
Actual Hash Value
Walid Hash Value
Algorithm Used
Encoding
Errar
c. Under Algorithms-> Select “MD5”
File Edit Operations BALEL Tools Window Help
Do RS RR PR
L . CRC32 B
MNew Load Save Delete Clear Verify  Verify All Opt
BZIP2 CRC
Fath MPEG2 CRC Encoding
lamCRC
Posix CRC
ADLER32
MD4
v MD5
EDOMNKEYZE
RMD128
RMD160
RMD256
RMD320
SHAL
SHAZ224
SHAZ256
SHA334
& SHAS12 | R
| irrool
WHIRLPOOL-T rdm-l MIingW32) 4.3.3) +=+=+=t=t=t=t=+

I+=+=+=+=+=+=+=+ FileVerifier+

Starting FileVerifiers= [w0.6.3.5830]

3. Open the MD5 Checksum file by clicking on the “Load” button

2]

S
N

Load



D

My Recent
Documents

?[":

Desktop

)

My Documents

My CampLter

>

My Metwork

Look in:

| ) Fonsa3

¥ O@F > Er

() CARIS

() Descriptive Report

PSS

() PublicRelations and Constituent Products

b4 F00589_Checksums. MD5

File name: |F00589_Checksums MD5 v

[ Open l

Files of type: | MDE Hashes (MDESUM Styl] (“.MDE) b |

[ Cancel ]

[10pen az read-only

a. If you have” Verify files automatically” selected in the Tools->Settings menu, the
comparison will begin automatically.
b. If not, under Operations-> Select “Verify Entries [ALL]...”

E’ FileVerifier++ - T:\F0O0589\F00589_Checksums.MD5

File Edit BOIIERLNEN Algorithms  Tools Window Help
D . ProcessFiles... Cf %
Process Directories... C-d
Mew L& erify  Werify All
Advanced Processing... C-p |.~_
File Informa
0 CF:F::;;B Process string... C-5-5 - !
a Attribute
E CARIS/Bat  calculate Entries [ALL... C-[F5] State
CARIS/Ba: .- - Filename
[ caris/Ba Calculate Entries [TAGGED]... F5] Actual Size (1
' " . Valid Size (b
E Ei;:z{ga Verify Entries [ALL]... C-5-q Actuzl DDS:A
S Bay
O] caris/Bay  Verify Entries [TAGGED]... c-q valid DOS At
D CARIS/Bal Actual Modif
O mms}sa. Delete Entries [ALL]... S-[DEL] Valid Modifi
Actual Hash
[] CARIS/Fie Delete Entries [TAGGED]... ‘DEL] valid Hash V
[] CARIS/Fie - Algarithm Us
[] caris/Fi¢  Strip Leading Directories [TAGGED]... Encoding
[ cArIs/Fid  Replace Text [TAGGED]... - Error
] IEi - =
A Set Algorithm [TAGGED]...
Revert Verification Status [ALL] C-5-r _
_____________ Revert Verification Status [TAGGED] Cr
Frocessing 312 . R
ProcessingS.2  Expert To Clipboard As Text [TAGGED]... C-S-c

Dperation cancel2dT
Operation result: 2046 good files, 0 bad files, 1083 files not processed.

Elmumm ol 48 e - PR AR EAT

c. The Relative path names entry dialog should already be pointing to the current root
folder but if not, point to it now and click OK.



Check Tree

Relative path names are relative to the following directony:

|I:'xNew_Inu:u:uming_Surveys'xFDDEEEﬁ |[ Browse. .. ]

Uze algorithm for entries without algarithnm info;

MD5 v/

[ 0K | [XEanceI ]

d. The process will begin and you will get a status bar telling you how far along you are

T:inew_Incoming_Surveys\FO0SE9,CARIS/HDCS _Data/FO0SS9/MRTS_S1212_EM30

|

Pracessing File:

Progress: [

Total Progress: [l

Total Files: 3129
Total Bytes: 5.2 GiE
00:04:23

Processed Files: 416
Processed Bytes: 6028 ME
Elapsed Time: 00:00:34

Percent Complete; 11%
Processing Rate: 17,2 MiB/s
Rernaining

4. When the verification process is complete, sort the columns by “Verification”. If any files have
been altered or deleted between the field unit and the processing branch network they will

show up as Invalid and be colored red. These files will need to be re-transmitted from the field
unit to the processing branch.

B FileVerifier++ - I:\New_Incoming_Surveys\FOO589\F00589_Checksums.MD5

File Edit Operations Algorithms Teols Window Help
O @B & 3% = P
\ e ~
Newr Load Save Files Dslste  Clear Verify VerfyAll | Options  About
Fath Hash Encoding Algorithm Verifica
Attribute value
[] €ARIS/Background_Files/charts/18453/184...  1932ace226cH296311 285fdaseabs3 Hexadeci 1MDS walid Fiiin
[] €ARIS/Background_Files/charts/18453/184. .. dod 7516538670207 a38a9 26728 Hexadeci 1MDS valid Filename
[] cARIS/Background_Files/charts/18453/184. .  561fE07805ff731cS cc5 d0b22a886812 Hexadeci 1MDS walid Actual Size (bytes)
[] cARIS/Background_Files/charts/18453/USE. 52a20aebs94 S e2bf76fded 555 ccof Hexadeci MDs valid Valid Size (bytes)
[] CARIS/Background_Files/charts/18474/184.. 875f0acddd4cSbl2efed660120852 24 Hexadeci MDS walid Actuzl DOS Attributes
[] CARIS/Background Files/charts/18474/BSE . 1274381250607 cFLa0180 2261578570 Hexadeci MDS valid X:;:‘Dgi:"“::t“";e:n
[] cARIS/Background_Files/charts/18474/E5E..  OffadeSesdfiiallEddISed2es B8 dh Hexadeci MDS walid T e
[] cARIS/Background_Files/charts/18474/BSE... 7 hcih224c47fd2584dh2a0baas? dSTh Hexadeci MDS valid Actual Hash Value
[ cARIS/Background_Files/charts/15474/B5E..  52a20acb6o4Sezhi7alded clS55 cf Hexadeci MDS walid Valid Hash Value
[ cARIS/Fieldsheets/FO0SE9/FOOSE_A/Im_..  464001df627 cL144884ak D6 5660 Haxadeci MDS valid Algorithm Used
[ cARIS/Fieldsheets/FI0SE3/FO0539_A/Lm 35k efdlE22f45 b6 262 A343048b6F Hexadeci MDS valid Encoding
[ CARIS/Fieldsheets/FO0SES/FOOSES_A/Im_.. 6f2573729802dofffdIboc2a34ame ot Haxadeci MDS valid Errar
[ €ARIS/Fieldshests/FO0SES/FOOSEE_A/Lm, a5Tcdfgl3adSa26acef2822716b284b1 Haxadeci MDS walid
[ CARIS/Fieldsheets/FO0SE8,/FOO5ES_ 58034232805 cdS74f2dle 20 dd ofh99S5 Haxadeci MDS valid
[] cARIS/Fieldshests/FO0SES/FOOSEE_A/Im_.. 9ee9229066413af01531319138007314 Haxaded MDS walid
[] €ARIS/Fieldshests/FO0SES,FOOSEE_A/Im_.. &772bScoT669h31123 00147395 M580 Haxadeci MDS valid
[ €ARIS/Fieldsheets/FO0SES/FO0SE_A/Im_.. 79027a1591a61b7093540c138aa203d Hexadeci 1MDS walid
[[] €ARIS/Fieldsheets/FO0SES/FO0SES_A/Zm_.. bo5afeS4475ddaf5a3613e6adi3123ec Hexadeci 1MDS valid
[ €ARIS/Fieldsheets/FO0SES/FO0SES_A/Zm_..  Ba7llbS465d25c25b684 d39ae2656817 Hexadeci 1MDS walid
[] €ARIS/Fieldsheets/FO0SES/FO0SES_A/Zm_.. 92af4341828178bE10065375bbds06e Hexadeci 1MDS valid
[] €ARIS/Fieldsheets/FO0SE9/FO0SEB9_A/2m_..  4cfd742c2bS714f50506blaldbe2e0 Hexadeci 1MDS walid
[] €ARIS/Fieldsheets/FO0SE9/FO0SES_A/2m_.. 111775bag915e2cldaB09a6 oS d3dad Hexadeci DS valid
[] €ARIS/Fieldsheets/FOOSE9/FO0SE9_A/2m_..  1fS54b39cddcs0ebEa0fe 7r2667bEEET Hexadeci 1MDS walid
[] CARIS/Fieldsheets/FO0SE9/FO0SES_A/Mdm_..  482247fc70Seadl81541e BiEde0dalc Hexadeci MDS valid
[] CARIS/Fieldsheets/FO0SES/FO0SES_A/Mm_..  0ada0d443cdaZaSa0shashonehibidan Hexadeci MDS walid
[] cARIS/Fieldsheets/FO0SES/FO0SES_A/Mm_..  137b3ho25d24acafIo7 1209227 7clas Hexadeci MDS valid
[ cARIS/Fieldsheets/FO0SE9/FO0SES_A/Mm_...  79e75a0=985122509622075 daatfe3h2 Hexadeci MDS walid
[ cARIS/Fieldsheets/FO0SES/FOOS3_A/M4m 96fcad2dbacdgl152al16 4344079930 Haxadeci MDS valid
[ cARIS/Fieldsheets/FO0SE/FO0SES_A/Mm_...  97384d300923f31ad00ffG2fbal27 Hexadeci MDS walid -
< | k3
[Messaetog
-~
Loading Results T
Loading file: I*\New_|ncoming_Surveys\FOOS82\ FOOSES_Che cksums.MDS
FOOSE9_Chedksums. MDS: Hexadecimal MDS checksums created at Pacific Hydrographic Branch on 2011-02-03
[Successfully load=d results from file




5. If all files have valid checksums then a report shall be created noting this

4| Reporting Results

If you have successfully verified all files in the submission, report the results of the verification using the
following procedure:
1. Select the Loading Results and Verifying Files text from the Message Log window

L e e o R e i 4t
[] cARIS/Fieldsheets/FO0SES/FOOSES_A/2m_.. bdiafeS4475ddaf5a3613e6adf3l23ec Hexadeci... MDS valid

[] carIS/Fieldsheets/FO0SE9/FOOSEI_A/2m_.. Ba7llb5465d2526b604dE9as2656817 Hexadeci... MDS Valid

[] cARIS/Fieldsheets/FO0SE9/FOOSE9_A/2m_.. 92af4341828178fbE100685375bhde06C Hexadeci... MDS valid

[[] CARIS/Fieldsheets/FOOSE9/FOOSE9_A/2m_.. 4dfd742c2bST14f5 506 blaldbeZel Hexadeci... MDs Valid

[[] CARIS/Fieldshests/FOOSE9/FOOSE9_A/2Zm_.. 111775bagelSelcldalildaccSdItded Hexadeci... MD5 Valid

[[] CARIS/Fieldshests/FOOS29/FOOS29_A/2m_.. 1fS4b38cddas0 ebfalfe Ti2667hE2T Hexadeci... MD5 Valid

[[] cARIS/Fieldsheets/FOO523/FOOS2I_A/Mm_.. 482247fT05eadlal54]l ecSfEdeldalc Hexadeci... MD5 Valid

[ cARIS/Fieldsheets/FO0S89/FOOSES_A/Mm_.. 0adé04443cda2aSa06has3bo0ehfh7dal Hexadeci... MDS Valid

[] cARIS/Fieldsheets/FO0SES,/FOOSES_A/dm_.. 137bEbS25d24acafia7f209e277fEa3 Hexadeci... MDS valid

[] carIS/Fieldsheets/FO0SE9/FOOSEI_A/Mm_.. 79e75a0e9852251962e975daarfe3b2 Hexadeci... MDS Valid

[] cARIS/Fieldsheets/FOOSE9/FOOSE9_A/4m_.. S6fca®2dbdcdSllSZalle ¢d344079930 Hexadedi... M0z Valid

[[] CARIS/Fieldsheets/FOOSE9/FO0S89_A/4m_..  97334d301f23fe3Lad00ffob2f4bala? Hexadeci... MD5 Valid

[] CARIS/Fieldsheets/FOOSE9/FOOSEI_A/FOO..  1451f303df095934d5 ca2i36adadlTe Hexadedi... MD5 Valid

[[] CARIS/Fieldsheets/FOOS23/FOOS29_A/FO0..  Sf028cdcchEBfl cadSfo09adaccldize Hexadeci... MD5 Valid

[] carIS/Fieldsheets/FO0S89/FOOSES_A/FOO... 1a95234018610bEdbEb3f0120dRT 48 Hexadeci... MDS valid

[] cARIS/Fieldsheets/FO0S89/FOOSES_A/FOO... 1d&fd379cedhESdddacediafeasladsd Hexadeci... MDS Valid I’
= oo oo o oo oo oo s oo ooe o oo o —— e bl
<) | ]
Loading module: C\Documents and Settings\ grant froelich\Desktop! Checksum\FileVerifiers+\f-0.6.3.5830W \Madules\whirlpoal.dll

Processing5.2 GiB total.
Operation result: 3129 good files, 0 bad files, 0 files not processed.
Elapsed time: 00417770
Average processing rate: 20.5 MiB/s |

|3129 Files 1Fileselectad DS

2. Copy the text to a new text file in the submission root folder which is named with the naming
convention HXXXXX_Checksum_Results.txt

I Foos589_checksum_|
File Edit Format View Help

============== |poading Results ==============

Loading file: I:Mew_Incoming_sSurveyssFOOS88%FO0588_Checksums.MDS

FOOS88_Checksums.MD5S: Hexadecimal MD5S checksums created at Pacific Hydrographic Branch on 2011-02-03
Successfully Toaded results from file.

============== Verifying Files ==============

Processing 3129 files.

Processing 5.2 GiE total.

operation result: 3129 good files, 0 had files, 0 files not processed.
Elapsed time: 0:04:17.770

Average processing rate: 20.5 MIESs.




U.S. Department of Commerce
Form Revised 26 February 2010

FIXED AIDS FOR USCG I-ATONIS

National Oceanic and Atmospheric Administration

US Coast Guard District State Locality Reporting Unit
OPR Project No. Survey Number Datum Make & Model of Positioning Equipment From Date [To Date
LATITUDE LONGITUDE HORIZONTAL HORIZONTAL LARGEST I-ATONIS
LIGHT LIST NUMBER AID NAME ACCURACY @ 95% | POSITION METHOD* J SCALE CHART 5
dd-mm-ss.sssN  |ddd-mm-ss.sssW | CONFIDENCE LEVEL (see footer) AFFECTED ate
12345 Example Purpose Only GPS 48-50-30.332 065-55-45.789 0.8 meter Post Process GPS 17345
New Example Purpose Only Photo 48-50-30.333 065-55-45.790 2.5 meter Photogrammetry 17345

Additional Comments: (This space is for additional narrative on problematic ATONs. Examples are: ATON is not serving its intended purpose, difficulties encountered

while positioning, or horizontal accuracy issues. For ATONSs positioned using Detached Positioning state whether or not the new position is better than what is
currently charted. Include light list number. This form DOES NOT replace requirements for DTON reports. )

* Horizontal Position Method: e.g. DGPS only, Post Processed GPS, Detached Position, photogrammetric
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